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Citrix Workspace app for Mac

May 24, 2024

Citrix Workspace app for Mac is an easy‑to‑install app that provides access to your applications and
desktops using Citrix Virtual Apps andDesktops andCitrix DaaS (formerly Citrix Virtual Apps andDesk‑
tops service) froma remote client device. CitrixWorkspace app forMac combines ease of deployment
and use, and offers quick, secure access to hosted applications and desktops.

Fordetailed informationabout the features, fixed issues, andknown issues, see theAbout this Release
page.

For information about deprecated items, see the Deprecation page.

You can use Citrix Workspace app on various devices running macOS. For information about the fea‑
tures available in Citrix Workspace app for Mac, see Citrix Workspace app Feature Matrix.

Language support

CitrixWorkspace app forMac is adapted for use in languagesother thanEnglish. For a list of languages
supported by Citrix Workspace app for Mac, see Language support.

Earlier versions

Citrix Workspace app 2311 for Mac (PDF Download)

Citrix Workspace app 2309 for Mac (PDF Download)

Citrix Workspace app 2308 for Mac (PDF Download)

Citrix Workspace app 2307 for Mac (PDF Download)

Citrix Workspace app 2306 for Mac (PDF Download)

Citrix Workspace app 2305 for Mac (PDF Download)

Citrix Workspace app 2304 for Mac (PDF Download)

Citrix Workspace app 2301.1 for Mac (PDF Download)

Citrix Workspace app 2301 for Mac (PDF Download)

Citrix Workspace app 2211 for Mac (PDF Download)

Citrix Workspace app 2210 for Mac (PDF Download)

Citrix Workspace app 2209 for Mac (PDF Download)
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Citrix Workspace app 2208.1 for Mac (PDF Download)

Citrix Workspace app 2206.1 for Mac (PDF Download)

Citrix Workspace app 2204 for Mac (PDF Download)

Citrix Workspace app 2203.1 for Mac (PDF Download)

Citrix Workspace app 2201 for Mac (PDF Download)

Citrix Workspace app 2112 for Mac (PDF Download)

Citrix Workspace app 2111 for Mac (PDF Download)

Citrix Workspace app 2110 for Mac (PDF Download)

Citrix Workspace app 2107 for Mac (PDF Download)

Citrix Workspace app 2104 for Mac (PDF Download)

Citrix Workspace app 2102 for Mac (PDF Download)

Citrix Workspace app 2101 for Mac (PDF Download)

Documentation for theseproduct versions isprovidedasPDFsbecause theyarenot the latest versions.
For themost recently updated content, see Citrix Workspace app for Mac current release documenta‑
tion. That documentation includes instructions for upgrading from earlier versions.

NOTE:

Links to external websites found in these PDFs take you to the correct pages, but links to other
sections within the PDF are no longer usable.

Reference articles

• Tech Brief: Citrix Workspace
• Citrix Licensing
• Developer Documentation
• Global App Configuration service

What’s new in related products

• Citrix Enterprise Browser: About this release
• Citrix Workspace: What’s new
• Citrix DaaS: What’s new
• StoreFront: What’s new
• Secure Private Access: What’s new
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Legacy documentation

For product releases that have reached End of Life (EOL), see Legacy documentation.

About this release

May 24, 2024

Learn about new features, enhancements, fixed issues, and known issues for CitrixWorkspace app for
Mac.

A list of features inTechnicalPreview ismaintained in theFeatures inTechnicalPreviewsection, soyou
can find them in one place. Explore our preview features and share your feedback using the attached
Podio form link.

Note:

The auto‑update service is supported on version 2304 or later. If you’re using Citrix Workspace
app for Mac versions 2301 or earlier, you can’t update to the latest versions through the auto‑
update service. Instead, you need tomanually install CitrixWorkspace app forMac versions 2304
or later by downloading the .dmg file available on the Downloads page. For more information,
see Manual install.

Native support for Mac with Apple Silicon (M1 andM2 Series) Universal architecture

With the releaseof theUniversal Architecturebuild, CitrixWorkspaceappnowprovidesnative support
for Macs with Apple silicon (M1 and M2 series). The Universal Architecture build can run on any Mac
device, irrespective of their processor architecture.

If you are using the x86_64 Intel‑based architecture build of Citrix Workspace app for Macs with Apple
Silicon, then youmust use Rosetta emulation to run the app.

You can download the latest version of Universal Architecture build and x86_64 Intel‑based Architec‑
ture build at Downloads.

Note:

Citrix continues to support Intel‑based Macs and Macs with Apple Silicon (M1 and M2 Series).
However, Citrix will soon deprecate the x86_64 Intel‑based Architecture build for Intel‑based
Macs. Citrix continues to support Universal Architecture build for both Intel‑based Macs and
Macs with Apple Silicon (M1 and M2 Series). Keep a look out for an announcement in the Depre‑
cation section.
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If you’re using Citrix Workspace app on a Mac running Mac with Apple silicon (M1 and M2 Series),
youmust upgrade the HDX RealTime Optimization Pack (RTOP). This upgrade ensures that the audio‑
video conferencing andVoice over Internet Protocol enterprise telephony throughMicrosoftSkype for
Business is optimized. You can install the HDX RealTime Media Engine 2.9.500 for Mac from the Citrix
website at Downloads.

If your organization uses any third‑party plug‑ins or virtual channels, youmust ensure that these plug‑
ins are compatible with Macs running Apple silicon. If the plug‑ins are developed in‑house then you
must rebuild these plug‑ins before installing the universal architecture build.

Formore information such as uninstalling the universal architecture build or using the CustomVirtual
Channel SDK (VCSDK), see Native support Apple silicon section.

What’s new in 2402

Improved loading experience of virtual apps and desktops for on‑premises deployments

Citrix Workspace app for Mac has improved the first‑time user experience for on‑premises deploy‑
ments. After successful authentication, the enumeration of virtual apps and desktops is faster than
before.

Support for H.265 video decoding

Startingwith the 2402 version, CitrixWorkspace app forMac supports theuseof theH.265 video codec
(HEVC) for hardware acceleration of remote graphics and videos. The h.265 video codec (HEVC) sup‑
ports YUV 4:2:0 color space by default. H.265 video codecmust be supported and enabled on both the
VDAandCitrixWorkspaceapp. If yourMacdevicedoesn’t supportH.265decodingusing theVideoTool‑
box interface, then the H.265 decoding for graphics policy setting is ignored and the session falls back
to the H.264 video codec. For more information, see Support for H.265 video decoding.

Support for system shortcuts on HDX desktop sessions

Previously, the system keyboard shortcuts such as Option‑Command‑ESC, Command‑Space bar,
Command‑Tab, Control‑Command‑Q, Shift‑Command‑Q, Control Up/Down/Left/Right took ef‑
fect only onmacOS locally since they were consumed bymacOS at first.

Starting with the 2402 version, Citrix Workspace app for Mac supports passing themacOS system key‑
board shortcuts to the VDA (HDX session) in windowmode and full‑screen mode. This feature allows
you to set preferences on how the system shortcutmust take effect onmacOS locally or the HDX desk‑
top session in window or full‑screenmode.

The following options in the keyboard settings allow you to control the system shortcuts:
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• Local device: The system shortcuts can take effect only onmacOS locally. It does not affect the
HDX session. The Local device option is the default option.

• Fullscreen HDX session only: The system shortcuts take effect on HDX sessions when the ses‑
sion is in full‑screenmode. If the session is inwindowmodeor there arenoactive sessions, then
the system shortcuts have no effect on HDX sessions.

• Active HDX session: The system shortcuts take effect on HDX sessions when the session is in
windowmode and full‑screenmode. If there is no active HDX session or the active session win‑
dow on the front, then the system shortcuts can take effect only on the macOS locally.

To enable the system shortcuts to take effect on the HDX session, open the HDX session. In the Citrix
Viewer menu bar, navigate to Devices > Keyboard > System shortcuts take effect on and select
Fullscreen HDX session only or Active HDX session.

Note:

When enabling system shortcuts for HDX sessions, you are prompted to provide accessibility ac‑
cess to Citrix Viewer to use this feature. To provide accessibility access to Citrix Viewer, click
Open System Settings in the dialog box and enable accessibility access to Citrix Viewer. For
more information, see Allow accessibility apps to access your Mac in the Apple support article.

Alternatively, you can enable the system shortcuts to take effect on HDX sessions in full‑screen or win‑
dowmode by navigating to Preferences > Keyboard. Select Fullscreen HDX session only or Active
HDX session options from the System shortcuts take effect on drop‑downmenu.
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For more information, see Support for system shortcuts on HDX desktop sessions.

Support for background blur for webcam

Starting with the 2402 version, Citrix Workspace app for Mac supports background blur when using
a webcam. You can enable the background blurring feature by navigating to Preferences > Mic &
Webcam and select Turn on blur when using webcam. For more information, see Support for back‑
ground blur for webcam.
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Support for audio volume synchronization

Previously, audio volume control is independent between the Virtual Delivery Agent (VDA) and your
device. You’ve to adjust the volume on both sides to maintain the desired volume. Also, if you’ve
muted the volume in your device, then it restricts to unmute the volume in the VDA.

Starting with the 2402 version, Citrix Workspace app for Mac supports synchronization of audio vol‑
ume between the VDA and your audio devices. You can now tune the volume using the VDA audio
volume slider and have the same volume on your device and the other way around. By default, this
feature is enabled. For more information, see Support for audio volume synchronization.

Loss tolerant mode for audio

Starting with the 2402 version, Citrix Workspace app supports loss tolerant mode (EDT lossy) for au‑
dio redirection. This feature improves the user experience for real‑time streaming when users are
connecting through networks with high latency and packet loss. By default, this feature is enabled.
For more information, see Loss tolerant mode for audio.

Upgraded HDX Reducer to Version 4

Previously, Citrix Workspace app for Mac supported HDX Reducer V3. Starting with the 2402 version,
Citrix Workspace app for Mac supports HDX Reducer V4. This feature reduces the network bandwidth
required for a typical session and improves response time. For more information, see Upgraded HDX
Reducer to Version 4.

Support for screen sharing when App Protection is enabled

Starting with the 2402 version, you can share content through Microsoft Teams with HDX optimiza‑
tion, even when App Protection is enabled. With this feature, you can share a screen in the virtual
desktop session to its full potential. For more information, see Compatibility with HDX optimization
for Microsoft Teams.

Enhanced Global App Configuration service

Starting with the 2402 version, the enhanced Global App Configuration service (GACS) for Citrix Work‑
space now supports the following features:

• Settings are secured with user authentication

• Enhanced the discovery workflow
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• Support for full StoreFront URL

For more information, see Global App Configuration service.

Citrix Enterprise Browser

This release includes Citrix Enterprise Browser version 121.1.1.26, based on Chromium version 121.
For more information, see the Citrix Enterprise Browser documentation.

Security indicator when visiting websites Citrix Enterprise Browser now displays a security indi‑
cator on the address bar when users visit any websites. The indicator aims to inform users about the
security aspects of the websites, such as whether it is an internal site or if there are any potential se‑
curity restrictions. The indicator provides more information when you click it. The indicator appears
on the Enterprise browser by default, and it enhances the user experience.
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Simplified single sign‑on forWebandSaaSapps through theGlobalAppConfiguration service

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 11
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NOTE:

For the Mac operating system, this feature was previously available only for StoreFront starting
with the release 119.1.1.115. Now, with the release of 121.1.1.26, it is also available for Work‑
space.

Previously, single sign‑on (SSO)wasconfigured inCitrix EnterpriseBrowserusing thePowerShellmod‑
ule. From this version, you can configure the simplified SSO feature in Citrix Enterprise Browser by us‑
ing a newly introduced setting in the Global App Configuration service (GACS). Administrators can use
this new setting to enable SSO for all web and SaaS apps in Citrix Enterprise Browser. This method
eliminates the need for the complex PowerShell module.

For more information on how to manage SSO through GACS, see Manage single sign‑on for Web and
SaaS apps through the Global App Configuration service.

Citrix EnterpriseBrowser introducesadditional settings in theGlobal AppConfiguration service
The following additional settings have been added into the Global App Configuration service (GACS)
for configuring Citrix Enterprise Browser:

• “Enable autofill address”‑ Allows administrators to enable or disable the autofill suggestions for
addresses.

• “Enable autofill credit card”‑ Allows administrators to enable or disable the autofill suggestions
for credit card information.

• “Auto launch protocols from origins”‑ Allows administrators to specify a list of protocols that
can launch an external app from the listed origins without prompting the user.

• “Enable command‑line flag security warnings”‑ Allows administrators to display or hide secu‑
rity warnings, which appear when potentially dangerous command‑line flags try to launch the
Enterprise Browser.

• “Manage default cookies setting”‑ Allows administrators to manage cookies for a website.
• “Manage default pop‑ups setting”‑ Allows administrators to manage pop‑ups from a website.
• “Extension install sources”‑ Allows administrators to specify valid sources for users to install
extensions, apps, and themes.

• “Disable lookalike warning pages”‑ Allows administrators to specify the preferred domains
where lookalike warning pages don’t display when the user visits pages on that domain.

• “Enable payment method query”‑ Allows administrators to enable websites to check whether
the users have saved payment methods.

• “Manage saving browser history”‑ Allows administrators to manage the saving of Enterprise
browser history.

• “Manage search suggestion”‑ Allows administrators to enable or disable search suggestions in
the Enterprise browser’s address bar.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 12
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• “Enable export bookmark”‑ Allows administrators to enable an option to export the bookmarks
in the Enterprise Browser.

• “Force ephemeral profiles”‑ Allows administrators to clear or persist user profile data when
users close the Enterprise Browser.

For more information, see Manage Citrix Enterprise Browser through Global App Configuration ser‑
vice.

Technical Preview

• Support for single sign‑on to Citrix Secure Access automatically through Citrix Workspace app
• Client App Management for Zoom VDI plug‑in
• Enhanced the Desktop Viewer toolbar
• Customize the Desktop Viewer toolbar
• Enable Packet Loss Concealment to improve audio performance
• Support for extending the desktop session to external monitors automatically
• Sustainability initiative from Citrix Workspace app

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• When connecting to Citrix Workspace app for Mac version 2311, you might get the following
error message:

Http/1.1 Internal Server Error 43524
[CVADHELP‑24631]

• You might notice that the Global App Configuration service policies are not applied on some
older Mac devices. [CVADHELP‑24863]

Known issues

• You might notice that the application screen is hidden at the notch when you enter full screen
in the virtual sessions for some Macs. As a workaround, adjust the app window to make it fit
below the screen notch. [HDX‑63035]

Earlier releases

This section lists features in previous releases alongwith their fixed and known issues. Releases reach
End of Life (EOL) 18 months after the release date. For details about lifecycle dates for the supported
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versions, see Lifecycle Milestones for Citrix Workspace app and Citrix Receiver.

2311

What’s new

Support for authentication using FIDO2 when connecting to on‑premises store Previously,
FIDO2 based password‑less authentication was supported for connecting to cloud stores. For more
information, see FIDO2 based authentication when connecting to cloud store.

With this version, users can also connect to on‑premises stores using FIDO2 authentication. FIDO2 se‑
curity keys provide a seamless way for enterprise employees to authenticate to apps or desktops that
support FIDO2without entering auser nameorpassword. This feature currently supports roamingau‑
thenticators (USB only) with PIN code and touchID. This feature is supported on macOS 12 and later
versions. For more information, see FIDO2‑based authentication when connecting to on‑premises
store.

EnhancedUniversal Architecture builds for virtual apps anddesktops session Startingwith the
2311 version, the Universal Architecture build can now automatically choose to run the virtual ses‑
sions in the native Apple Silicon mode or Intel mode on Macs with the Apple Silicon chipset. It uses
the Rosetta emulation to launch the virtual session in Intel mode. The virtual session launches in the
native Apple Silicon mode, if the virtual channel SDK is built based on the native Apple Silicon archi‑
tecture or there’s no virtual channel SDK. However, the virtual session launches in the Intel mode
using the Rosetta emulation, if the virtual channel SDK is built based on the x86_64 Intel‑based archi‑
tecture.

This enhancement to the Universal Architecture build improves the launch experience on Macs with
the Apple Silicon chipset. For users on Macs with the Intel‑based chipset, there is no change, and the
Universal Architecture build continues to run the virtual sessions natively.

For more information, see Enhanced Universal Architecture builds for virtual apps and desktops ses‑
sion.

Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only) The
opening experience of Citrix resources has been enhanced to bemore intuitive, informative, and user‑
friendly. From the 2311 version, this feature is supported for customweb stores and hybrid launch.
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The launch progress notification now appears at the lower‑right corner of your screen. A progress
status of the resources, which are in the process of being opened is shown. You cannot retrieve the
notification once you dismiss it. The notification stays for a few seconds from the time you start the
session. If the session fails to start, then the notification shows the failuremessage. Formore informa‑
tion, see Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only).
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Note:

This feature is available for both Workspace (cloud) and StoreFront sessions.

Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac Starting with the 2311
version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports writing server‑side
applications and client‑side drivers for more virtual channels using the ICA protocol. The server‑side
virtual channel applications are on Citrix Virtual Apps and Desktops servers. This version of the SDK
supports writing new virtual channels and screen sharing for Citrix Workspace app for Mac.

Formore information, seeCitrix Virtual Channel SDK forCitrixWorkspaceapp forMac in theDeveloper
documentation and Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac.

Support for TLS protocol version 1.3 Starting with the 2311 version, Citrix Workspace app for Mac
supports the latest Transport Layer Security (TLS) version 1.3. To enable the TLS version 1.3, navigate
toPreferences>Security andPrivacy>TLSand select theTLSv1.0, TLSv1.1, TLSv1.2andTLSv1.3
option from the TLS versions drop‑downmenu.

For more information, see TLS.
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Support for multiple audio devices Starting with the 2311 release, Citrix Workspace app for Mac
displays all available local audio devices in a session with their names. In addition, plug‑and‑play is
also supported. For more information, see Support for multiple audio devices.

Support for extendingmultiplemonitors in full‑screenmodeonup to fivemonitors Previously,
Citrix supported amaximum of three monitors in full‑screenmode, including the primary monitor.

Starting with the 2311 version, you can now use full‑screen mode on up to five monitors, including
the primary monitor, at the same time. For more information, see Support for extending multiple
monitors in full‑screenmode on up to five monitors.

Deprecation of International menu from the keyboard settings Previously, you can enable or
disable the Use Client IME, Use Composing Mark and Use Client keyboard layout features in the
Citrix viewer by navigating to Devices > Keyboard>International.

From the 2311 version, the Internationalmenu for the keyboard settings in the Citrix Viewer is dep‑
recated. From this version, the client‑side IME is enabled by default. For more information, see Dep‑
recation of International menu from the Keyboard settings.

Deprecation announcement of the SDP format (PlanB) fromWebRTC Citrix is planning to depre‑
cate the current SDP format (Plan B) support fromWebRTC in future releases. Youmust use a version
of Citrix Workspace app that supports the Unified Plan to continue using certain optimized Microsoft
Teams functionalities. Formore information, seeDeprecation announcement of the SDP format (Plan
B) fromWebRTC.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 119.1.1.115,
based on Chromium version 119. For more information, see the Citrix Enterprise Browser documen‑
tation.

Improved user experience Previously, Citrix Enterprise Browser displayed a reconnection modal
when you attempted to perform an action after your session expired. Starting with Citrix Workspace
app forMac version 2311 (which corresponds to the Chromiumversion 119.1.1.115), there is no longer
a reconnection modal. Instead, a loading icon now appears on the browser tab when you attempt to
perform any action after your session expires.

Improved watermark design Citrix Enterprise Browser now has a new watermark design that is
less intrusive and provides a better user experience.
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Support for custom browser extension Citrix Enterprise Browser has expanded its extension ca‑
pabilities. Previously, only extensions from the Chrome Web Store were permitted. Citrix Enterprise
Browser now allows you to add custom extensions securely. Administrators can configure custom
extensions as part of the mandatory list. End users can access and use these extensions either via
citrixbrowser://extensions or by clicking the Extensions option under More button as
needed. For more information on how to configure the custom extensions, see Mandatory custom
browser extension in the Citrix Enterprise Browser documentation.

Simplified SSO for Web and SaaS apps through the Global App Configuration service

Note:

This feature is available only for StoreFront.

Previously, SSO was configured in Citrix Enterprise Browser using the PowerShell module. From this
version, this simplified SSO feature allows you to configure SSO in Citrix Enterprise Browser by using
a newly introduced setting in the Global App Configuration service (GACS). Administrators can use
this new setting to enable SSO for all web and SaaS apps in Citrix Enterprise Browser. This method
eliminates the need for the complex PowerShell module. For more information on how to manage
SSO through GACS, see the Manage single sign‑on for Web and SaaS apps through the Global App
Configuration service.

Enhanced capabilities onmonitoring end user activities Previously, administrators were unable
to monitor end user activities such as App accessed and Traffic type. Starting with Citrix Workspace
app for Windows 2311 and Mac 2311 versions (corresponding to Chromium version 119.1.1.115), you
can nowmonitor these details as well.

• Appaccessed: Enterprise Browser provides information about all the apps accessed by the end
user, provided the app is listed in the policy document.

• Traffic type: Enterprise Browser provides information about whether data is sent directly or
through Secure Private Access authentication.

To monitor the end user activities from the Enterprise Browser, use the Citrix Analytics service using
your Citrix Cloud account. After signing in to Citrix Cloud, navigate to Analytics > Security > Search.
There, you can refer toApps andDesktops under the Self‑Service Search section. Formore informa‑
tion on Citrix Analytics, see Getting started.

App Protection

Support to configure App Protection for Authentication and Self‑Service plug‑in for on‑
premises stores Previously, Citrix Workspace app for Mac supported configuring App Protection
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for Authentication and Self‑Service plug‑in using the Global App Configuration service UI for
customers on cloud stores only.

Startingwith the 2311 release, this feature is supported for customers on both cloud and on‑premises
stores. For more information, see Configuration using the Global App Configuration service UI in the
App Protection documentation.

Technical Preview

• Loss Tolerant mode for Audio
• Support for Audio volume synchronization
• Support for H.265 video decoding
• Upgraded HDX Reducer to Version 4

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues in 2311

• When the first time users add the Store URL, they might not see the FIDO2 authentication
browser window. [RFMAC‑14518]

• When using Citrix Workspace app for Mac to access virtual sessions, the mouse scrolling speed
might be too fast or too slow in the virtual sessions. [CVADHELP‑23514]

• When using Citrix Workspace app for Mac, youmight not be able to switch between recent apps
inside the virtual app session by clicking Options + tab keys after upgrading to VDA 2212
or later. [CVADHELP‑23464]

• Youmight notice that the macOS dock is blocking the windows taskbar of the Remote Desktop
Protocol app session launched from Citrix Workspace app for Mac. [CVADHELP‑23681]

• WhenusingCitrixWorkspace app forMac, youmight experience issuewith authenticationwhen
persistent session is used for on‑premises store. [CVADHELP‑24062]

Known issues in 2311

• TheHTML5 Video redirection feature is disabled by default in CitrixWorkspace app forMac from
version 2311. [HDX‑53015]
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2309

What’s new

Support for macOS 14 Sonoma Citrix Workspace app for Mac is supported on macOS 14
Sonoma.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 115.1.1.103,
based on Chromium version 115. For more information, see Citrix Enterprise Browser documenta‑
tion.

Citrix will now release independent upgrades for Citrix Enterprise Browser. Starting with Citrix Work‑
space app 2309 for Mac, you can upgrade Citrix Enterprise Browser independently to compatible ver‑
sions through the auto‑update feature or install manually when the upgrades are available at Down‑
loads. The independentupgradesofCitrix EnterpriseBrowser are supportedonlyon the latest version
of Citrix Workspace app for Mac at any given time.

Technical Preview

• Support for Citrix Secure Private Access for On‑premises stores

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• In optimized Microsoft Teams, you might hear the ringtone sound randomly if you answer the
call before it rings. [HDX‑55799]

• The USB settings to connect devices automatically, which is available on the Devices tab of
the Preferences window, might not work as expected in Citrix Workspace app 2308 for Mac.
[RFMAC‑14658]

• OnmacOS Sonoma devices, when you copy an image (.jpeg/.png format) from your Mac to the
virtual session, the copied image in the virtual session might get corrupted. [HDX‑55307]

Known issues

• No new issues have been observed in this release.
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2308

What’s new

Citrix Workspace app for Mac on macOS Sonoma Beta Citrix Workspace app 2308 for Mac has
been tested onmacOS Sonoma Public Beta 7 Version 23A5337a. Use this setup in a test environment
and provide your feedback.

Improved graphics performance Starting with the 2308 version, the performance of graphics is
improved for seamless app sessions. This feature also optimizes the load on CPU usage. For more
information, see Improved graphics performance.

Improved network congestion control Startingwith the 2308 version, the Citrix‑proprietary trans‑
port protocol called Enlightened Data Transport (EDT) is improved to efficiently control network con‑
gestion. This feature improves data throughput and reduces latency. For more information, see Im‑
proved network congestion control.

Increase in the number of supported virtual channels Previously, Citrix Workspace app for Mac
supported up to 32 virtual channels. Starting with the 2308 version, you can use up to 64 virtual chan‑
nels in a session. For more information, see Increase in the number of supported virtual channels.

App Protection

Support for Policy tampering detection Policy tampering detection feature prevents the user
from accessing the virtual app or desktop session if the App Protection anti‑screen capture and
anti‑keylogging policies are tampered. If policy tampering is detected, then the virtual app or
desktop session is terminated. For more information about the policy tampering detection feature,
see Policy tampering detection.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 115.1.1.103,
based on Chromium version 115. For more information, see Citrix Enterprise Browser documenta‑
tion.

Technical Preview

• Enhanced the high DPI option
• Store‑based configuration of file access
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• Support for Activity Manager on cloud stores
• Support for screen sharing when App Protection is enabled
• Support for authentication using FIDO2 when connecting to on‑premises store

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• When using Citrix Workspace app for Mac to access the virtual desktop, the size of the mouse
pointer in the virtual desktopmight fluctuate irregularly. [CVADHELP‑23158]

• Youmight not see the icons of active apps in the activity manager. [WSUI‑8011]
• CitrixWorkspace appmight consumea lot of applicationmemories after a fewminutes of usage.
[CVADHELP‑23528]

Known issues

• After upgrading CitrixWorkspace app forMac to version 2308, the preferenceswindowmight be
unresponsive for any user actions. As aworkaround, force quit CitrixWorkspace app and restart
it. Formore information about forcing an app to close on aMac, see Force an app to close in the
Apple support article. [RFMAC‑14596]

2307

What’s new

Native support for Macs with M2 chips Starting with the 2307 version, Citrix Workspace app for
macOS supports M2 series (along with M1 series that was previously supported) of Apple silicon na‑
tively. For more information, see Native support Apple silicon.

Citrix Workspace app for Mac on macOS Sonoma Beta Citrix Workspace app 2307 for Mac has
been tested on macOS Sonoma Public Beta 1 Version 23A5286i. Use this setup in a test environment
and provide your feedback.

Caution:

Donot use CitrixWorkspace app forMac onmacOS SonomaBeta versions in production environ‑
ments.

Deprecating support for macOS version Catalina As announced in the 2304 version, support for
macOS version Catalina (10.15) is deprecated in the 2307 release and will be removed for future re‑
leases. For more information, see Deprecation.
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Support forauthenticationusingFIDO2whenconnecting toacloudstore Startingwith the2307
version, users can authenticate using FIDO2 based password‑less authentication when connecting to
a cloud store. FIDO2 security keys provide a seamlessway for enterprise employees to authenticate to
appsordesktops that support FIDO2withoutenteringausernameorpassword. This feature currently
supports roaming authenticators (USB only) with PIN code and touchID. This feature is supported on
macOS 12 and later versions. For more information, see FIDO2‑based authentication when connect‑
ing to cloud store.

Support for authentication using FIDO2 within an HDX session Starting with the 2307 version,
users canauthenticateusingFIDO2basedpassword‑less authenticationwithinanHDXsession. FIDO2
security keys provide a seamless way for enterprise employees to authenticate to apps or websites
that support FIDO2 without entering a user name or password. This feature currently supports roam‑
ing authenticators (USBonly)withPIN code. This feature is supportedonmacOS12and later versions.
For more information, see FIDO2‑based authentication within an HDX session.

Note:

This release supports only one passkey in a FIDO2 supported device. If your FIDO2 supported
device has multiple passkeys then the first passkey is used to authenticate the HDX session.

Auto‑update version control Administrators can now manage the auto‑updated version of Citrix
Workspace app for the devices in the organization.
Administrators can control the version by setting the range for maximumAllowedVersion and
minimumAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
7 ,
8 "settings": {
9

10 "name": "Version Control for Citrix Workspace",
11 "description": "Provides admin ability to Version Control for

Citrix Workspace",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "category": "AutoUpdate",
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19 "userOverride": false,
20 "assignedTo": [
21 "AllUsersNoAuthentication"
22 ],
23 "settings": [
24 {
25
26 "name": "Auto update plugins settings",
27 "value": [
28 {
29
30 "pluginName": "Citrix Workspace",
31 "pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
32 "pluginSettings": {
33
34 "deploymentMode": "Update",
35 "upgradeToLatest": false,
36 "minimumAllowedVersion": "23.07.0.63",
37 "maximumAllowedVersion": "23.07.0.63",
38 "delayGroup": "Medium",
39 "detectRule": ""
40 }
41
42 }
43
44 ]
45 }
46
47 ]
48 }
49
50 ]
51 }
52
53 }
54
55 }
56
57
58 <!--NeedCopy-->

When the range is set, CitrixWorkspace appon the user device is automatically updated to the highest
available version that falls between the mentioned range.

If you want to auto‑update Citrix Workspace app to a specific version, enter the same version in the
maximumAllowedVersion and minimumAllowedVersion properties in the Global App Configuration
service. For more information, see Auto‑update version control.

Note:

• To achieve auto‑update version control, set the upgradeToLatest setting to false in the
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Global App Configuration service. If the upgradeToLatest setting is true,maximumAllowed‑
Version andminimumAllowedVersion is ignored.

• Do not modify the pluginId. The pluginId is mapped to Citrix Workspace app.
• If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.

• You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.

• This feature is supported from release 2307 onwards.

Quickaccessmenu forStoreFront Startingwith the 2307 version, you cannavigate to your favorite
apps anddesktops quickly and easily using the quick access feature for on‑premises stores. To enable
quickaccess, right‑clickCitrixWorkspace in the toolbar, navigate toPreferences>General, and then
select Show Quick Access for Storefront experience. This feature allows you to see your favorite
data directly from the Macmenu bar.

You can enable the quick access feature by using Preferences.

Administrators canenable or disable thequick access featurebyusing theMobileDeviceManagement
(MDM) or Global App Configuration service (GACS) methods. For more information, see the Quick ac‑
cess menu for StoreFront.
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Enabling or disabling quick access using MDM To enable quick access through MDM, administra‑
tors must use the following settings:

<key>ShowQuickAccessForStoreFront</key>
<false/>

Enabling or disabling quick access using GACS To enable quick access through GACS, administra‑
tors must use the following settings:

enableQuickAccessForStoreFront

Store‑basedconfigurationofmicrophoneandwebcamaccess Startingwith the2307version, the
per‑store microphone and webcam access are included as part of the client‑selective trust feature.
This enhancement allows you to provide access to amicrophone and webcam on a per‑store basis.

To enablemicrophone andwebcamaccess for a store, youmust selectPreferences >Mic &Webcam.
In the Mic & Webcam tab, select the store and the type of access required for that store. For more
information, see Store‑based configuration of microphone and webcam access.

Send feedback on Citrix Workspace app The Send feedback option allows you to inform Citrix
about any issues you might encounter while using the Citrix Workspace app. You can also send sug‑
gestions to help us improve your Citrix Workspace app experience.

You must select Help > Send feedback to view and fill the issue details in the Send feedback form.
You can add details like the examples provided in the form.
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You can attach the existing log files or generate new log files. To generate log files, clickRecordmy is‑
sue >StartRecording and then reproduce the issue. After the issue is reproduced, clickStopRecord‑
ing. The log file is saved automatically and replaces the existing logs with the reproduced logs.

Note:

Citrix does not collect any Personally Identifiable Information (PII) from the logs.

You can attach screenshots or screen recordings describing the issue to help us understandwhat you’
re experiencing. ClickChoose filesandadd theattachments suchas screenshotsor screen recordings.
You can attach a maximum of four files.

Once you’ve entered thenecessary information, clickSend to haveanewemail automatically created
in your Mail app with the information you added. From there, click the Send button to share the
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feedback with Citrix. For more information, see Send feedback on Citrix Workspace app.

Note

If you aren’t using the default Mail app, then send feedback to cwa‑mac‑feedback@cloud.com
from your mail client. Add the issue details, log files, screenshots, or screen recordings to the
email manually.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 113.1.1.34, based
on Chromium version 113. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Split view support Citrix Enterprise Browser onmacOS supports split view for ease ofmultitasking.
With split view, you can use Citrix Enterprise Browser and anotherwindownext to each other, without
having to manually move and resize windows. For more information, see Apple’s support article.

Citrix Enterprise Browser shortcut Starting with Citrix Workspace app for Mac 2307 version, an
administrator can configure and control the presence of the Citrix Enterprise Browser shortcut on the
launch pad.

Note:

By default, this feature isn’t configured.

Configuration
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An IT administrator can configure the presence of the Citrix Enterprise Browser shortcut in one of the
following ways:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)
• web.config file.

Note:

• All the configuration methods have equal priority. Enabling any one of them enables the
shortcut.

• If youhaven’t configured the shortcut but have oneormoreWorkspace stores, the shortcut
gets automatically enabled.

• For end users, the Citrix Enterprise Browser shortcut appears if the user makes it as a fa‑
vorite app irrespective of the configuration.

• Todisable this feature forWorkspace stores, administratorsmust apply oneof the following
settings:

– Set the CEBShortcutEnabled attribute to false in the MDM or web.config file.
– Disable the Enable Citrix Enterprise Browser shortcut property in GACS.

Mobile Device Management (MDM)

Administrators can push the settings CEBShortcutEnabled set as true to the user’s device.

For more information on how to use MDM, see Mobile Device Management (MDM).

Note:

This way of configuration is applicable on Workspace and StoreFront.

Global App Configuration service (GACS)

Navigate toWorkspaceConfiguration>AppConfiguration>Citrix EnterpriseBrowser and enable
Enable Citrix Enterprise Browser shortcut property.
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For more information about how to use the GACS UI, see the User interface article in the Citrix Enter‑
prise Browser documentation.

Note:

This way of configuration is applicable on Workspace and StoreFront.

web.config file

Enable the attribute CEBShortcutEnabled under the properties.

1 <properties>
2 <property name="CEBShortcutEnabled" value="

True" />
3 </properties>
4
5 <!--NeedCopy-->

Note:

This way of configuration is applicable on StoreFront.

Using web.config

To enable the Citrix Enterprise Browser shortcut, do the following:

1. Use a text editor to open the web.config file, which is typically at C:\inetpub\wwwroot\
Citrix\Roaming directory.

2. Locate the user account element in the file (Store is the account name of your deployment).
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For example: <account id=... name="Store">

3. Before the </account> tag, navigate to theproperties of that user account andadd the following:

1 <properties>
2 <property name="CEBShortcutEnabled" value=

"True" />
3 </properties>
4
5 <!--NeedCopy-->

The following is an example of the web.config file:

1 <account>
2 <clear />
3 <account id="d1197d2c-ac82-4f13-9346-2ee14d4b0202" name="F84Store"
4 description="" published="true" updaterType="Citrix"

remoteAccessType="None">
5 <annotatedServices>
6 <clear />
7 <annotatedServiceRecord serviceRef="1__Citrix_F84Store">
8 <metadata>
9 <plugins>

10 <clear />
11 </plugins>
12 <trustSettings>
13 <clear />
14 </trustSettings>
15 <properties>
16 <property name="CEBShortcutEnabled" value="True" />
17 </properties>
18 </metadata>
19 </annotatedServiceRecord>
20 </annotatedServices>
21 <metadata>
22 <plugins>
23 <clear />
24 </plugins>
25 <trustSettings>
26 <clear />
27 </trustSettings>
28 <properties>
29 <clear />
30 </properties>
31 </metadata>
32 </account>
33
34 <!--NeedCopy-->

How to configure using web.config

1. Usea texteditor toopen theweb.config file,which is typicallyatC:\inetpub\wwwroot\Citrix\Roaming
directory.
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2. Locate the user account element in the file (Store is the account name of your deployment).

For example: <account id=... name="Store">

3. Before the </account> tag, navigate to theproperties of that user account andadd the following:

1 <properties>
2 <property name="CEBShortcutEnabled" value=

"True" />
3 </properties>
4
5 <!--NeedCopy-->

Technical Preview

• Keyboard accessibility support for the toolbar on the Virtual Desktop

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• While launching the published app through the browser, the app does not launch directly but
downloads an ICA file. The usermight have to open the downloaded ICA filemanually to launch
the app. [CVADHELP‑20835]

• Attempts tostart a sessionmight fail if theStoreFrontkeyword is set to“KEYWORDS:LogoffOnClose=true
PromptMessage=”Do you want to Log off?””. [CVADHELP‑23170]

• You might not be able to select the required gateway from the list of options provided when
using Citrix Workspace app for Mac. [CVADHELP‑22777]

Known issues

No new issues have been observed in this release.

2306

What’s new

Log traceability and user activity Starting with the 2306 version, when a user reports an issue,
the administrators can go through the log files to view the basic information such as macOS version,
Citrix Workspace app version, details about the previous upgrade, number of stores added, and other
details. Administrators can now view the following activities in Citrix Workspace app for Mac:
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• The app launched along with the macOS version, number of stores, and other metadata.
• The store addition and deletion operation and themetadata that is required to add an account.
• The session start time and launch status.
• Auto update activation and status.
• System events such as moving the app to the background, sleepmode, or quitting.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 112.1.1.23, based
on Chromium version 112. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Fixed issues

• After upgrading Citrix Workspace app for Mac to version 2305, certain third‑party virtual apps
that have pop‑up dialogs for entering username and password might become unresponsive
upon opening. [CVADHELP‑23032]

Known issues

No new issues have been observed in this release.

2305

What’s new

Support for horizontal scroll Previously, Citrix Workspace app for Mac supported only vertical
scroll on a trackpad. Starting with the 2305 version, a horizontal scroll is also supported. For more
information, see Support for horizontal scroll.

Improved audio echo cancellation support CitrixWorkspace app now supports echo cancellation
in adaptive audio and legacy audio codecs. This feature is designed for real‑time audio use cases, and
it improves the user experience. Citrix recommends using adaptive audio. For more information, see
Improved audio echo cancellation support.

Improved graphics performance [Technical Preview] Starting with the 2305 version, the perfor‑
mance of graphics is improved for seamless sessions. This feature also reduces the load on CPU us‑
age.
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Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Support for Certificate‑based authentication Startingwith the 2305 version,Workspace adminis‑
trators can configure and enforce Azure Active Directory conditional access policies for users authen‑
ticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

For more information, see Support for Certificate‑based authentication.

Channel support for Global App Configuration service The Global App Configuration service for
Citrix Workspace allows a Citrix administrator to deliver Workspace service URLs andWorkspace App
settings through a centrally managed service. Global App Configuration service now allows adminis‑
trators to test the settings before rolling it out to all users. This feature allows to resolve any issues
before applying the global app configurations to the entire user base. Formore information, seeChan‑
nel support for Global App Configuration service.

Improved auto‑update experience The auto‑update feature automatically updates the Citrix
Workspace app to the latest version without the need for any user intervention.

Citrix Workspace app periodically checks and downloads the latest available version of the app. Cit‑
rix Workspace app determines the best time to install based on user activity not to cause any disrup‑
tions.

For more information, see Improved auto‑update experience.

Opened apps appear in the dock with native app icons Previously, clicking virtual apps in the
Citrix Workspace app triggered the Citrix Viewer where these apps would be available. If you open
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many apps, the apps or its instances are opened in the Citrix Viewer. You can view the open apps by
right‑clicking the Citrix Viewer icon.

Starting with the 2305 version, when you open virtual apps, they appear in the Dock (bottom‑right
corner of the screen) with their respective icons and are easily identifiable. You can then access the
virtual app from the dock itself. If you open multiple instances of an app, these instances aren’t du‑
plicates in the Dock but are grouped within one instance in the Dock.

For more information, see the Opened apps appear in the dock with native app icons page.

Improved Mission Control and App Expose experience Previously, using theMission Control or
App Expose feature in a virtual app session resulted in the overlapping of many windows that were
opened.
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Starting with the 2305 version, when you use theMission Control or App Expose feature in a virtual
app session and open many windows, the windows do not overlap, and you can easily choose from
among them.
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For more information, see Improved Mission Control and App Expose experience.

Enhancement to sleep mode for optimized Microsoft Teams call Previously, when using the op‑
timized Microsoft Teams meeting, if there’s no mouse or keyboard interaction, Citrix Workspace app
or the optimized Microsoft Teams screenmight go to sleepmode.

Starting with the 2305 version, Citrix Workspace app or the optimized Microsoft Teams screen doesn’
t go to sleep mode even if there’s no mouse or keyboard interaction during an optimized Microsoft
Teamsmeeting.

For more information, see Enhancement to sleepmode for optimized Microsoft Teams call.

Support for continuity camera With the Continuity Camera, you can now use the iPhone as your
webcam. For a seamless connection, mount your iPhone such that its camera is available to the Mac
device. You must selectWebcam > Automatic Camera Selection for the iPhone to appear automat‑
ically on the Mac device as an external camera. You can switch to any other camera manually, for
example by selectingWebcam > FaceTime HD Camera. The Continuity Camera works wired or wire‑
lessly and provides a high‑quality image. Formore information, see Support for continuity camera.
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Increase in the number of supported virtual channels [Technical Preview] In earlier versions of
the client, sessions supported up to 32 virtual channels. Starting with the 2305 version, you can use
up to 64 virtual channels in a session.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Store‑based configuration ofmicrophone andwebcamaccess levels [Technical Preview] Start‑
ing with the 2305 version, the per‑storemicrophone and webcam access are included as a part of the
client‑selective trust feature. This enhancement allows you to change the settings based on a per‑
store basis. You can click a store to enable the required microphone or camera access. The selected
setting for microphone or camera access is applied on a per‑store basis.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Support for authentication using FIDO2 when connecting to cloud stores [Technical Preview]
Starting with the 2305 version, users can authenticate using passwordless FIDO2 security keys when
connecting to Citrix Workspace app for Mac. Users can sign into the cloud stores using the FIDO2
security keys. The security keys support different types of security inputs such as security pins, bio‑
metrics, card swipe, smart card, Public Key Certificates. This feature is supported on macOS 12 and
later versions. For more information about FIDO2 see FIDO2 Authentication.

Citrix Workspace app uses the user’s default browser for FIDO2 authentication (Webauthn). Admin‑
istrators can configure the type of browser to authenticate to Citrix Workspace app. The configured
setting can be pushed using the Mobile Device Management (MDM), Global App Configuration service
(GACS), or the command line interface methods. The FIDO2 feature is not supported for on‑premises
stores. For more information on the web browser settings, see Global App Configuration service doc‑
umentation.

The following settings allow you to select the type of browser used for authenticating an end user into
Citrix Workspace app:
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Embedded: Allows you to authenticate within Citrix Workspace app. Citrix Workspace app saves the
session data or cookies for single sign‑on (for example, SaaS apps) when the enhanced single sign‑on
feature is enabled. This authenticationmethod does not support passwordless authentications such
as FIDO2.

EmbeddedWithPrivateSession: This setting is similar to the Embedded setting. Single sign‑on isn’
t supported as session data or cookies aren’t present in Citrix Workspace app.

System: Allows you to use the user’s default browser for authentication (for example, Safari
or Chrome). Authentication occurs outside Citrix Workspace app. Use this setting to support
passwordless authentication. This setting tries to use the existing user session from the user’s
browser.

SystemWithPrivateSession: This setting is like the System setting. Citrix Workspace app uses a pri‑
vate session in the browser for authentication. The browser doesn’t save authentication cookies or
data. Single sign‑on isn’t supported in this option.

Enabling authentication usingMDM To enable authentication throughMDM, administratorsmust
use the following settings:

<key>WebBrowserForAuthentication</key>
<string>System</string>

EnablingauthenticationusingGACS Toenableauthentication throughGACS, administratorsmust
use the following settings:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
7 ,
8 "settings": {
9

10 "name": "Productivity Apps",
11 "description": "Provides access to MS Office and other basic apps

",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "assignedTo": [
19 "AllUsersNoAuthentication"
20 ],
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21 "category": "authentication",
22 "settings": [
23 {
24
25 "name": "web browser for authentication",
26 "value": "SystemWithPrivateSession"
27 }
28
29 ],
30 "userOverride": false
31 }
32
33 ]
34 }
35
36 }
37
38 }
39
40
41 <!--NeedCopy-->

Enabling authentication using the command‑line interface To enable authentication using the
command‑line interface, administrators must run the following command:

defaults write com.citrix.receiver.nomas WebBrowserForAuthentication
System

This feature is a request‑only preview. To get it enabled in your environment, fill out the Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Keyboard input mode enhancements Citrix Workspace app for Mac provides UI to configure the
keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top‑right cor‑
ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear

2. Select from one of the following options:
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• Scancode –Sends thekeyposition fromtheclient‑sidekeyboard toVDAandVDAgenerates
the corresponding character. Applies server‑side keyboard layout.

• Unicode ‑ Sends the key from the client‑side keyboard to VDA and VDAgenerates the same
character in VDA. Applies client‑side keyboard layout.

This enhancement is enabled by default.

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
is using theRussian keyboard layout. When you chooseScancode and type the key next toCaps Lock,
the scancode “1E”is sent to theVDA. TheVDA thenuses “1E”todisplay the character “ф”. If youchoose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op‑
tions:

• Scancodemode for Don’t Sync option.

• Unicodemode for Allow dynamic sync and Sync only once ‑ when session starts

Note:

The keyboard configuration changes take effect once you reconnect to the application.

You can change the configuration of Keyboard input mode in the Citrix Workspace app UI. However,
for best performance, use the Citrix‑recommendedmodes for different scenarios, physical keyboards,
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and client devices.

For more information on configuration details and limitations, see Keyboard input mode enhance‑
ments.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 112.1.1.23, based
on Chromium version 112. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Modification in SPA policy implementation on internal Web and SaaS apps This feature
enhances the security policies implementation onWeb and SaaS apps. When awebpage and iframes
within the webpage have different policies, we now have a stricter policy implementation where a
union of all policies is applied on the entire webpage, including the iframes. However, the watermark
is applied to the webpage only.

Support for browser extensions You can add extensions that are provided by your administrator
to theCitrix EnterpriseBrowser in a secureway. Anadministrator candeploy,manage, andcontrol the
extensions. End users can view and use the extension under citrixbrowser://extensions as required.
For more settings, see Global App Configuration service.

For information on how to configure, see the Support for browser extensions documentation.

Use GACS to manage Citrix Enterprise Browser The administrator can use the Global App Con‑
figuration service (GACS) for Citrix Workspace to deliver Citrix Enterprise Browser settings through a
centrally managed service.

The GACS is designed for administrators to easily configure Citrix Workspace and manage the Citrix
Workspace app settings. This feature allows admins to use GACS to apply various settings or system
policies to the Citrix Enterprise Browser on a particular store. The administrator can now configure
andmanage the following Citrix Enterprise Browser settings using APIs or the GACS Admin UI:

• “Enable CEB for all apps”‑ Makes the Citrix Enterprise Browser the default browser for opening
web and SaaS apps from the Citrix Workspace app.

• “Enable save passwords”‑ Allow or deny end users the ability to save passwords.
• “Enable incognito mode”‑ Enable or disable incognito mode.
• “Managed Bookmarks”‑ Allow the administrator to push bookmarks to the Citrix Enterprise
Browser.

• “Enable developer tools”‑ Enable or disable developer tools within the Enterprise Browser.
• “Delete browsing data on exit”‑ Allow the administrator to configure what data the Citrix Enter‑
prise Browser deletes on exit.
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• “Extension Install Force list”‑ Allow theadministrator to install extensions in theCitrix Enterprise
Browser.

• “Extension Install Allow list”‑ Allow the administrator to configure an allowed list of extensions
that users can add to the Citrix Enterprise Browser. This list uses the ChromeWeb Store.

For more information, see Use Global App Configuration service to manage Citrix Enterprise
Browser.

Notes:

• The name and value pair are case‑sensitive.
• All the browser settings in Global App Configuration service are under the following cate‑
gory:

1 {
2
3 "category": "browser",
4 "userOverride": false,
5 "assignedTo": [
6 "AllUsersNoAuthentication"
7 ]
8 }
9

10
11 <!--NeedCopy-->

• The administrator can apply the settings to unmanaged devices as well. For more informa‑
tion, see Global App Configuration service documentation.

User interface

To configure Citrix Enterprise Browser through the GACS Admin UI, do the following:

1. Sign in to citrix.cloud.comwith your credentials.

Note:

• Refer to the Sign Up for Citrix Cloud article for step‑by‑step instructions to create a
Citrix Cloud account.

2. Upon authentication, click the menu button in the top left corner and selectWorkspace Con‑
figuration.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 43

https://docs.citrix.com/en-us/citrix-enterprise-browser/gacs.html
https://docs.citrix.com/en-us/citrix-enterprise-browser/gacs.html
https://developer-docs.citrix.com/en-us/server-integration/global-app-configuration-service/overview
https://developer-docs.citrix.com/en-us/server-integration/global-app-configuration-service/overview
https://citrix.cloud.com
https://docs.citrix.com/en-us/citrix-cloud/overview/signing-up-for-citrix-cloud/signing-up-for-citrix-cloud.html#step-1-visit-the-citrix-cloud-web-site


Citrix Workspace app for Mac

TheWorkspace Configuration screen appears.

3. Click App Configuration > Citrix Enterprise Browser.

You can now configure, modify, and publish Citrix Enterprise Browser feature settings.

For more information, see Use Global App Configuration service to manage Citrix Enterprise
Browser.

Technical Preview

• Client APP Management

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• With this enhancement, the location data can be collected and sent to Microsoft Teams to sup‑
port the dynamic emergency calling feature. [CVADHELP‑21117]

• When you scroll in a MacBook using a touchpad in a user session that is opened through Citrix
Workspace app for Mac, the scroll experience might not be smooth. [CVADHELP‑21427]

• When using Citrix Workspace app for Mac, external users might get disconnected from the ses‑
sions intermittently. [CVADHELP‑22191]

• Attempts to add a store URL that contains a query parameter might fail in Citrix Workspace app
for Mac with this error message:
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This store doesn’t exist. Please retry or contact support.

[CVADHELP‑22445]

• On an on‑premises store, when you attempt to open Citrix Workspace app from theMenu bar,
youmight experience an indefinite wait time. [CVADHELP‑22688]

2304

What’s new

Enhanced auto start experience Previously, Citrix Workspace app for Mac used to start automati‑
callywhenever a computerwas turnedon. Startingwith the2304version, youcanchoose todisableor
enable the auto start feature on CitrixWorkspace app forMac by navigating toPreferences >General
> Start Workspace on system startup. The auto start setting is enabled by default.

For more information, see Enhanced auto start experience.

Improved experience for optimized Microsoft Teams video conference calls Starting with the
2304 version, by default simulcast support is enabled for optimized Microsoft Teams video confer‑
ence calls. With this support, the quality and experience of video conference calls across different
endpoints are improved. It is achieved by adapting to the proper resolution for the best call experi‑
ence for all callers.
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With this improvedexperience, eachusermight delivermultiple video streams indifferent resolutions
(for example, 720p, 360p, and so on) depending on several factors including endpoint capability, net‑
work conditions, and so on. The receiving endpoint then requests the maximum quality resolution
that it can handle thus giving all users the optimum video experience.

Note:

This feature is available only after the roll‑out of an update from Microsoft Teams. For informa‑
tion on ETA, go to https://www.microsoft.com/ and search for theMicrosoft 365 roadmap. When
the update is rolled‑out by Microsoft, you can check CTX253754 for the documentation update
and the announcement.

For more information see,
Improved experience for optimized Microsoft Teams video conference calls.

Support for Certificate‑based authentication [Technical Preview] Starting with the 2304 ver‑
sion, Workspace administrators can configure and enforce Azure Active Directory conditional access
policies for users authenticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

For more information, see Support for Certificate‑based authentication.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Force login prompt for Federated identity provider Citrix Workspace app now honors the Fed‑
erated Identity Provider Sessions setting. For more information, see Citrix Knowledge Center article
CTX253779.

You no longer need to use the Store authentication tokens policy to force the login prompt. For more
information, see Force login prompt for Federated identity provider.
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Support for non‑English‑language Input Method Editors (IME) keyboard layouts Support for
non‑English language IME keyboard layouts continues to work uninterrupted after the Carbon APIs
are deprecated with the Cocoa APIs. For more information, see Support for non‑English‑language
Input Method Editors (IME) keyboard layouts.

Log collection Log collection simplifies the process of collecting logs for Citrix Workspace app. The
logs help Citrix to troubleshoot, and, in cases of complicated issues, facilitate support. Users can now
collect logs quickly by using the new option provided in the Help menu by navigating to Help and
selecting the Logging… or Email Log Files option. This feature improves the user experience during
the log collection process.

• Logging… ‑ clicking this option directs you to Preferences > Advanced > Logging
• Email Log Files –clicking this option allows collecting the latest logs.

For more information, see Log collection.

Support synchronization for more keyboard layouts Starting with the 2304 version, Citrix Work‑
spaceapp forMacsupports keyboard layout synchronization for the following layoutsor InputMethod
Editors (IMEs):

• English ABC
• English ABC ‑ India
• Chinese, Traditional: Zhuyin ‑ Traditional
• Chinese, Traditional: Sucheng ‑ Traditional
• Google Japanese IME
• Sougou Chinese IME

For more information, see Support synchronization for more keyboard layouts.

Microsoft Teams enhancement

Configuring a preferred network interface You can now configure a preferred network interface
for media traffic. Run the following command in a terminal:
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defaults write com.citrix.HdxRtcEngine NetworkPreference -int <value>

Select one of the following values as required:

• 1: Ethernet
• 2: Wi‑Fi
• 3: Cellular
• 4: VPN
• 5: Loopback
• 6: Any

By default and if no value is set, the WebRTCmedia engine chooses the best available route.

For more information, see Configuring a preferred network interface.

Limiting video resolutions Administrators with users on lower‑performance client endpoints can
limit incoming or outgoing video resolutions to reduce the impact of video encoding and decoding
on those endpoints. Starting from Citrix Workspace app 2304 for Mac, you can limit these resolutions
using client configuration options.

For more information, see Limiting video resolutions.

Support for horizontal scroll [Technical Preview] Previously, Citrix Workspace app for Mac sup‑
ported only vertical scroll on a trackpad. Starting with the 2304 version, a horizontal scroll is also
supported.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Keyboard input mode enhancements Citrix Workspace app for Mac provides UI to configure the
keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top‑right cor‑
ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear
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2. Select from one of the following options:

• Scancode –Sends thekeyposition fromtheclient‑sidekeyboard toVDAandVDAgenerates
the corresponding character. Applies server‑side keyboard layout.

• Unicode ‑ Sends the key from the client‑side keyboard to VDA and VDAgenerates the same
character in VDA. Applies client‑side keyboard layout.

This enhancement is enabled by default.

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
is using theRussian keyboard layout. When you chooseScancode and type the key next toCaps Lock,
the scancode “1E”is sent to theVDA. TheVDA thenuses “1E”todisplay the character “ф”. If youchoose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op‑
tions:

• Scancodemode for Don’t Sync option.

• Unicodemode for Allow dynamic sync and Sync only once ‑ when session starts

Note:

The keyboard configuration changes take effect once you reconnect to the application.
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You can change the configuration of Keyboard input mode in the Citrix Workspace app UI. However,
for best performance, use the Citrix‑recommendedmodes for different scenarios, physical keyboards,
and client devices.

For more information on configuration details and limitations, see Keyboard input mode enhance‑
ments.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 109.1.1.31, based
on Chromium version 109. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Technical Preview

• Rapid Scan
• Enhanced virtual apps and desktops launch experience
• Support for multiple audio devices

For a complete list of Technical Preview features, see the Features in Technical Preview page.

Fixed issues

• When you create two XML files on a Mac local client, the VDA might open the incorrect XML file.
For example, the VDA opens the Snapshot.xml file instead of opening the SnapshotPopup.xml
file. [HDX‑45326]

• When you change the active audio devices in the sound settings on the endpoint, Microsoft
Teamsmight not receive any notification about the change. As a result, Microsoft Teams fails to
pick the changes. [HDX‑47080]

• The Citrix Viewer might quit occasionally when you close a VDA session. [HDX‑45668, HDX‑
47138]

• The responder policy configured using Citrix ADC might fail to work with Citrix Workspace app
for Mac. The issue occurs when the policy configured checks if the user agent has sent CWAWE‑
BVIEW, Citrix Receiver, or CitrixWorkspace as a substring, which does notmatch. As a result,
users might be redirected to a different Citrix Gateway URL. [CVADHELP‑20519]

• When you connect to Citrix Gateway Store and attempt to sign in to Citrix Workspace app for
Mac, the sign‑in might get stuck or take time with a spinning wheel. [CVADHELP‑21323]

• Citrix Workspace app for Mac might fail to start a session if the File Type Association is set for
an app under Application Settings in Citrix Studio. [CVADHELP‑21371]
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• A sign‑in windowmight appear automatically in Citrix Workspace app for Mac when you power
on or restart your system. [CVADHELP‑21484]

• Citrix Workspace app for Mac might quit unexpectedly when the Universal Windows Platform
(UWP) appswithin the VDI attempt to authenticate using the FIDO2 authentication. [CVADHELP‑
21576]

• Attempts to open the web resources might fail with this error message:

Switch to another storewith thenecessarypermissions. If the issuepersists, contact your
admin with error details.

[CVADHELP‑21787]

• CitrixWorkspace app forMacmight use an incorrect user agentCitrixReceiver instead of Citrix
Workspace as a substring. As a result, the authorization policies aren’t honored. [CVADHELP‑
21969]

• When using the notch screen feature, a part of the text might be cut. [CVADHELP‑22134]

• When you open Citrix Enterprise Browser from the dock, instead of a new tab, it shows that
the page is loading. As a workaround, enter the URL in the address bar or open another tab to
continue browsing. [CTXBR‑4706]

• When using the Citrix Secure Private Access enabled store, an infinite loading spinner might
appearwhile launching the published content. The issue occurswhenCitrix Enterprise Browser
isn’t runningon theuserdevice. Asa result, youcan’t viewthepublishedcontent. [CTXBR‑4813]

2301.1

What’s new

This 2301.1 release addresses a few issues that help to improve overall performance and stability.

Fixed issues

• You might face issues when you add or authenticate a store, or start a resource (apps or desk‑
tops) using the native Citrix Workspace app. [CVADHELP‑22372]

• The incoming video and screen sharingmight notwork duringMicrosoftTeamsoptimized video
calls. [HDX‑50059]
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Known issues in 2301.1

• You can’t update to Citrix Workspace app for Mac version 2301.1 using the auto‑update service.
As a workaround, youmustmanually install the Citrix Workspace app for Mac version 2301.1 by
downloading the .dmg file available on the Downloads page.

2301

What’s new

Background blurring and replacement for Citrix Optimized Microsoft Teams Citrix Optimized
Microsoft Teams in Citrix Workspace app for Mac now supports background blurring and background
replacement. You can use this by selecting More > Apply Background Effects when you are in a
meeting or a P2P call.

Auto‑update version control [Technical Preview] Administrators can now manage the auto‑
updated version of Citrix Workspace app for the devices in the organization.
Administrators can control the version by setting the range in the maximumAllowedVersion and
minimumAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
7 ,
8 "settings": {
9

10 "name": "Version Control for Citrix Workspace",
11 "description": "Provides admin ability to Version Control for

Citrix Workspace",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "category": "AutoUpdate",
19 "userOverride": false,
20 "assignedTo": [
21 "AllUsersNoAuthentication"
22 ],
23 "settings": [
24 {
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25
26 "name": "Auto update plugins settings",
27 "value": [
28 {
29
30 "pluginName": "Citrix Workspace",
31 "pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
32 "pluginSettings": {
33
34 "deploymentMode": "Update",
35 "upgradeToLatest": false,
36 "minimumAllowedVersion": "23.04.0.36",
37 "maximumAllowedVersion": "23.04.0.36",
38 "delayGroup": "Medium",
39 "detectRule": ""
40 }
41
42 }
43
44 ]
45 }
46
47 ]
48 }
49
50 ]
51 }
52
53 }
54
55 }
56
57
58 <!--NeedCopy-->

When the range is set, Citrix Workspace app on the user’s device is automatically updated to the high‑
est available version that falls between the mentioned range.

If you want to auto‑update Citrix Workspace app to a specific version, enter the same version in the
maximumAllowedVersion and minimumAllowedVersion properties in the Global App Con‑
figuration service.

Note:

• To enable auto‑update version control, the upgradeToLatest setting in the Global
App Configuration service must be set to false. If the upgradeToLatest setting is true, the
maximumAllowedVersion and minimumAllowedVersion is ignored.

• Do not modify the pluginId. The pluginId is mapped to Citrix Workspace app.
• If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.
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• You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.

• This feature is supported from release 2301 onwards.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Improved auto‑update experience [Technical Preview] The automatic update feature automat‑
ically updates the Citrix Workspace app to the latest version, without any user intervention. Citrix
Workspace app periodically checks for any latest updates and downloads the latest available version
of the app. By default, automatic updates are enabled, unless your admin disable the automatic up‑
dates.

Installation starts when the Citrix Workspace app or the sessions are idle.

Note:

Citrix Workspace app cannot be accessed during the installation.

When you start the Citrix Workspace app, a notification appears to indicate the status of the installa‑
tion.

You can disable the auto‑update feature by navigating to Preferences > Advanced > Updates and
unselecting the Automatically keepWorkspace app up to date option.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 54

https://podio.com/webforms/28115929/2218699
https://podio.com/webforms/28115930/2218700


Citrix Workspace app for Mac

Enhanced notch screen support Starting with the 2301 version, Citrix Workspace app for Mac sup‑
ports Macs with a notch display. Macs support a native notch screen in full screen mode for retina
and multi‑monitor displays. The area of the session in the notch screen is nowmuch bigger and pro‑
vides the customers with more screen space. This enhancement also supports high DPI scaling. The
mouse position also appears accurate in all the external monitors connected. For more information,
see Enhanced notch screen support.

Note:

Ensure not to select the Scale to fit below built‑in camera option in the Citrix Viewer. This
option isn’t selected by default and can be found only on Macs with notch display.

App Protection enhancement Starting with the 2301 version, App Protection is enhanced to pro‑
tect the Citrix Workspace app. This enhancement includes protecting the authentication screen and
the screen that you see after signing into the Workspace app. For more information, see App Protec‑
tion.

Global App Configuration service channel support [Technical Preview] The Global App Config‑
uration service for Citrix Workspace allows a Citrix administrator to deliver Workspace service URLs
and Workspace App settings through a centrally managed service. For more information, see Global
App Configuration service documentation.

Administrators can now use the Global App Configuration service to define settings, which are applic‑
able to specific user‑groups. This feature ensures that some features or functionalities can be made
available to only certain users as required, and not to others.

You can provide feedback for this technical preview by using the
Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Enhancedmenu bar support Starting with the 2301 version, the CWA fully supports the Automat‑
ically hide and show themenu bar in full screen option in MacOS. For versions earlier thanmacOS
13, youmust navigate to System Preferences > Dock &Menu Bar and clear the Automatically hide
and show themenubar in full screen option. FormacOS 13 and later versions, youmust navigate to
SystemPreferences>Desktop&Dockand clear theAutomaticallyhideand showthemenubar in
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full screen option. You have the provision to either enable or disable this option. This enhancement
also supports high DPI scaling. Themouse position also appears accurate in all the external monitors
connected. For more information, see Enhancedmenu bar support.

The figure below illustrates a windowwhere the menu bar is hidden

The figure below illustrates a windowwhere the menu bar appears

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 107.1.1.13, based
on Chromium version 107. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Set Citrix Enterprise Browser as the work browser You can now configure Citrix Enterprise
Browser as a work browser to open all work links. You can select an alternate browser to open
non‑work links.

A work link is a link that is associated with the web or SaaS apps that the administrator configures for
the end user. When a user clicks any link within a native application, if it’s a work link, it’s opened
through the Enterprise Browser. If not, it’s opened through any other browser that the end‑user se‑
lects.

For more information, see Set Citrix Enterprise Browser as the work browser.

Fixed issues

• HTTP Live Streaming (HLS) protocol with High‑Efficiency Advanced Audio Coding (AAC‑HE)
stream fails to play back audio on Citrix Enterprise Browser. [CTXBR‑3899]

• When you click a hyperlink in the custom portal, an error message appears before opening the
link. Later, the link opens in a system browser, for example, Google Chrome instead of Citrix
Enterprise Browser. [CTXBR‑4051]
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• When using CitrixWorkspace app forMacwith a customweb store URL, the versions of the oper‑
ating systemandCitrixWorkspace appmight not be shown in the user agent string. [CVADHELP‑
21377]

• With this fix, certain third‑party apps such as Epic or Kronos might not freeze when you start
them. [HDX‑46140]

• When you attempt to start a session using an ICA file from Citrix Workspace app 2301 for Mac
Beta build for the first time, the session might quit unexpectedly. [HDX‑47361]

• Whenyouadd thecustomportal site toCitrixWorkspaceapp forMac, ablankpagemight appear.
[RFMAC‑12857]

2211.1

What’s new

This release addresses a few issues that help to improve overall performance and stability.

Fixed issues

• You might face issues when you add or authenticate a store, or start a resource (apps or desk‑
tops) using the native Citrix Workspace app. [CVADHELP‑22372]

• The incoming video and screen sharingmight notwork duringMicrosoftTeamsoptimized video
calls. [HDX‑50059]

2211

What’s new

Workspace apps appear in the Dock with native app icons when opened [Technical Preview]
Starting with the 2211 version, this feature is disabled by default.

This feature is a request‑only preview. To get it enabled in your environment, fill out the Podio form.

Improved Mission Control and App Expose experience [Technical preview] Starting with the
2211 version, this feature is disabled by default.

This feature is a request‑only preview. To get it enabled in your environment, fill out the Podio form.
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Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 105.2.1.40, based
on Chromium version 105. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Fixed issues

This release also addresses several issues that help to improve overall performance and stability.

2210

What’s new

macOS 13 Ventura Support Citrix Workspace app for Mac is supported on macOS 13 Ventura
(13.0).

Improvedautomatic update experienceonMacwithApple Silicon (M1Series) Startingwith this
version, when you download the Universal Architecture build, you can choose between the Apple
Silicon and Intel builds to support both the Apple Silicon and Intel based Macmachines.

On Apple Silicon machines, the users have the option to automatically update the Intel build even
after having downloaded the Apple Silicon build. The option is provided in the Preferences tab.

Advanced configuration for automatic updates You can configure CitrixWorkspace automatic up‑
dates on Mac with Apple silicon (M1 Series) using the following methods:
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• Graphical user interface
• Global App Configuration service (GACS)
• Mobile Device Management (MDM)
• StoreFront

For more information, see Advanced configuration for automatic updates.

Workspace apps appear in the Dock with native app icons when opened [Technical Preview]
Previously, clicking virtual apps in the Citrix Workspace app triggered the Citrix Viewer where these
apps would be available. If you openmany apps, the apps or its instances opened in the Citrix Viewer.
You can view the open apps by right‑clicking the Citrix Viewer icon.

Starting with this version, when you open virtual apps, they appear in the Dock with their respective
icons and are easily identifiable. You can then access the virtual app from the dock itself. If you open
multiple instances of an app, these instances aren’t duplicates in theDockbut are groupedwithin one
instance in the Dock.
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Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

ImprovedMissionControl andAppExposeexperience [Technical preview] Previously, using the
Mission Control or App Expose feature in a virtual app session resulted in the overlapping of many
windows that were opened.
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Starting with this version, when you use theMission Control or App Expose feature in a virtual app
sessionandopenmanywindows, thewindowsdonot overlap, and youcaneasily choose fromamong
them.
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Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Improved graphics performance [Technical preview] With this version, the performance of
graphics is improved for desktop sessions.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Support for high DPI Citrix Workspace app for Mac is now compatible with one high DPI monitor
with 4K or 5K resolution. With this feature, the text, images, and other graphical elements on virtual
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desktop or app sessions appear in a size that can be viewed comfortably on these high‑resolution
monitors. For more information, see Support for high DPI.

To enable this feature, navigate to Preferences > General > High DPI.

Note:

The number of external monitors you can use with yourmac is always limited by the Macmodel,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see
Connect one or more external displays with your Mac in the Apple support article.

Support for admin configuration of user devices through MDM tool Admins can now configure
the following settings while deploying Citrix Workspace app through any MDM deployment tool such
as Citrix Endpoint Management:

• StoreURLs –Configure store details so it’s automatically added when the user opens the Citrix
Workspace app, simplifying the sign‑on experience.
To add a store, provide the details for the StoreURLs setting. For example, <string>https
://myorg.com/?storename</string>.

• BlockStoreAddition –Prevent the user from adding stores.

To block the user from adding a store, set the value of the BlockStoreAddition setting to True.

For more information, see Support for store configuration of user devices through MDM tool.

Support for certificate‑based authentication [Technical Preview] You can now authenticate to
Citrix Workspace app (cloud stores) by using a client certificate.

Previously, Certificate based authenticationwas supported on on‑premises setups and customers on
cloud setups were unable to sign in to Citrix Workspace app. This feature is disabled by default and
admins must contact the Citrix help desk to enable this feature by filling this request form.
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If your organization has configured Conditional Access with Azure Active Directory, then the user is
prompted to select a Client Certificate for authentication while signing in. Certificate‑based authenti‑
cation adds another layer of security, ensuring that your device is compliant.

Once you add a store and enter valid credentials for that store, Citrix Workspace app displays a list of
valid certificates available in your keychain for Client Authentication. If there’s only one valid certifi‑
cate in your keychain, it’s selected by default.

Once you choose a certificate, the identity provider validates it and theWorkspace app store appears
on successful validation.

Note:

• If there are no valid certificates in your keychain, the Citrix Workspace app performs the
default handling for the certificate authentication request from the server.
This might prevent the user from logging in.

• If your organizationhas configuredConditional AccesswithAzureActiveDirectory andvalid
certificates aren’t found in your keychain, you can’t log in to Citrix Workspace app.

If a previously selected certificate is no longer valid, an error message appears, prompting you to se‑
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lect a valid certificate or to contact your admin in the absence of one.

This feature is a request‑only preview. To get it enabled in your environment, fill out the Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Rebranding CitrixWorkspace Browser Citrix Workspace Browser is nowCitrix Enterprise Browser.
The custom scheme is now changed from citrixworkspace:// to citrixbrowser://.

Implementing this transition in our products and their documentation is an ongoing process. Your
patience during this transition is appreciated.

• The product UI, in‑product content, and the images and instructions in product documentation
will be updated in the coming weeks.

• It’s possible that some items (such as commands and MSIs) might continue to retain their for‑
mer names to prevent breaking existing customer scripts.

• Related product documentation

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 105.1.1.19, based
on Chromium version 105. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
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prise Browser documentation. and other resources (such as videos and blog posts) that are linked
from this product documentation might still contain former names.

Make Citrix Enterprise Browser the work browser [Technical Preview] You can now configure
Citrix Enterprise Browser to open all work or enterprise links and apps configured by your administra‑
tor in the Citrix Workspace app. This feature provides a way for you to open only work links or web
and SaaS apps in the Citrix Enterprise Browser.
You can select an alternate browser to open any other non‑work links or apps.

Open all web and SaaS apps through the Citrix Enterprise Browser From this version, all inter‑
nal web apps and external SaaS apps available in the Citrix Workspace app open in Citrix Enterprise
Browser.

Support for browser extensions [Technical Preview] You can add extensions that are provided
by your administrator to the Citrix Enterprise Browser in a secure way. An administrator can
deploy, manage, and control the extensions. End users can view and use the extension under
citrixbrowser://extensions as required. For more settings, see Global App Configuration service.

Note:

This feature is a request‑only preview. To get it enabled in your environment, fill out the Podio
form.

For information on how to configure, see the Citrix Enterprise Browser documentation.

Use Global App Configuration service to manage Citrix Enterprise Browser [Technical Preview]
The administrator can use the Global App Configuration service for Citrix Workspace to deliver Citrix
Enterprise Browser settings through a centrally managed service.

The Global App Configuration service is designed for administrators to easily configure Citrix Work‑
space and manage the Citrix Workspace app settings. This feature allows admins to use the Global
App Configuration service to apply various settings or system policies to the Citrix Enterprise Browser
on aparticular store. The administrator cannowconfigure andmanage the followingCitrix Enterprise
Browser settings using the Global App Configuration service:

• “Enable CEB for all apps”‑ Makes the Citrix Enterprise Browser the default browser for opening
web and SaaS apps from the Citrix Workspace app.

• “Enable save passwords”‑ Allow or deny end users the ability to save passwords.
• “Enable incognito mode”‑ Enable or disable incognito mode.
• “Managed Bookmarks”‑ Allow the administrator to push bookmarks to the Citrix Enterprise
Browser.
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• “Enable developer tools”‑ Enable or disable developer tools within the Enterprise Browser.
• “Delete browsing data on exit”‑ Allow the administrator to configure what data the Citrix Enter‑
prise Browser deletes on exit.

• “Extension Install Force list”‑ Allow theadministrator to install extensions in theCitrix Enterprise
Browser.

• “Extension Install Allow list”‑ Allow the administrator to configure an allowed list of extensions
that users can add to the Citrix Enterprise Browser. This list uses the ChromeWeb Store.

Notes:

• This feature is a request‑only preview. To get it enabled in your environment, fill out the
Podio form.

• Technical previews are available for customers to test in their non‑production or limited
production environments, and to give customers an opportunity to share feedback. Citrix
does not accept support cases for feature previews but welcomes feedback for improving
them. Citrixmight ormight not act on feedback based on its severity, criticality, and impor‑
tance. It’s advised that Beta builds aren’t deployed in production environments.

• The name and value pair are case‑sensitive.
• All the browser settings in Global App Configuration service are under the following cate‑
gory:

1 {
2
3 "category": "browser",
4 "userOverride": false,
5 "assignedTo": [
6 "AllUsersNoAuthentication"
7 ]
8 }
9

10
11 <!--NeedCopy-->

• The administrator can apply the settings to unmanaged devices as well. For more informa‑
tion, see Global App Configuration service documentation.

Technical Preview

• Upgraded version of WebRTC for the optimized Microsoft Teams

For a complete list of Technical Preview features, see the Features in Technical Preview page.
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Fixed issues

• Citrix Workspace app might interrupt the restart or shutdown power action of a Mac device.
[RFMAC‑12530]

• The shift key might not work as expected in Citrix Workspace app for Mac version 2206.
[CVADHELP‑20674]

2209

What’s new

Sign out of the customweb store when you close Citrix Workspace app When the signoutCus‑
tomWebstoreOnExit setting is set to True, closing the Citrix Workspace appwindow signs you out of
the customweb store. When you reopen the Citrix Workspace app, the web store URL is loaded again.
You can configure the signoutCustomWebstoreOnExit setting in the Global App Configuration ser‑
vice. For more information, see Sign out of the custom web store when you close Citrix Workspace
app

Citrix Enterprise Browser This release includes Citrix Enterprise Browser (formerly Citrix Work‑
space Browser) version 103.2.1.10, based on Chromium version 103. For more information about the
Citrix Enterprise Browser, see Citrix Enterprise Browser documentation.

Fixed issues

• Citrix Workspace app for Mac might start automatically when you restart Citrix Workspace app
for Mac or install Citrix Workspace app. [RFMAC‑12392]

• The screen sharing feature in Optimized Microsoft Teams for certain third‑party apps might fail
on Citrix Workspace app for Mac. The issue occurs when the Thinwire codec policy is set to For
entire screen. As a result, the app sharing feature is disabled and no options are available in
the sharing panel. [CVADHELP‑20853]

2208.1

What’s new

View apps, desktops, and Citrix Enterprise Browser from the menu bar through a quick access
menu You can now view your most recently used or favorite apps and desktops or open a Citrix En‑
terprise Browser window by clicking the Citrix Workspace icon in themenu bar. This feature provides
easy access to some of your resources without having to open the Citrix Workspace app.
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Note:

This feature isn’t available on on‑premises setups.
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If you’ve not configured any accounts, a sign‑in prompt appears.

A maximum of 5 of your recently used or favorite apps or desktops appear in the options under the
RecentandFavorites tabs respectively. Toview theotherapps in theCitrixWorkspaceapp, clickView
all applications. To view the other desktops in the Citrix Workspace app, click View all desktops.
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You can open the Citrix Workspace UI by clicking the Citrix Workspace app icon.

You can open the Citrix Enterprise Browser, without opening a web or SaaS app by clicking the Citrix
Enterprise Browser icon.

Note:

TheCitrix Enterprise Browser isn’t available if the configured store doesn’t have anywebor SaaS
apps. Further, it’s available only if your admin has configured Citrix Secure Private Access.
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You can view the following options when you click the Account icon in the top‑right corner:

• Preferences
• Check for updates
• About
• Quit
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For more information, see View apps, desktops, and Citrix Enterprise Browser from the menu bar
through a quick access menu.

Support for authentication using FIDO2 [Technical Preview] With this version, users can authen‑
ticate within an HDX session using password‑less FIDO2 security keys. FIDO2 security keys provide a
seamless way for enterprise employees to authenticate to apps or desktops that support FIDO2 with‑
out entering a user name or password. For more information about FIDO2 see FIDO2 Authentication.
This feature currently supports roaming authenticators (USB only) with PIN code and touch capabili‑
ties. You can configure FIDO2 Security Keys based authentication. For information about the prereq‑
uisites and using this feature, see Local authorization and virtual authentication using FIDO2.
When you access an app or a website that supports FIDO2, a prompt appears, requesting access to
the security key. If you’ve previously registered your security key with a PIN (a minimum of 4 and a
maximum of 64 characters), then youmust enter the PIN while signing in.
If you’ve registered your security key previously without a PIN, simply touch the security key to sign
in.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Battery status indicator The battery status of the device now appears in the notification area of a
Citrix Desktop session. To view the battery status within the desktop session, click the Show hidden
icons arrow in the taskbar.
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Note:

The battery status indicator does not appear for server VDAs.

For more information, see Battery status indicator.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 103.1.1.14, based
on Chromium version 103. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Citrix Enterprise Browser Profiles Profiles help you keep personal information such as history,
bookmarks, passwords, andother settings separate for eachof yourCitrixWorkspaceaccounts. Based
your Workspace store, a profile is created, allowing you to have a unique and personalized browsing
experience.

Note:

After you upgrade to version 103.1.1.14 and sign in to the device for the first time, only your pre‑
viously saved passwords are removed. When you sign in to the device using a different store for
the first time, all your previously saved data is lost.

Open all web and SaaS apps through the Citrix Enterprise Browser [Technical Preview] From
this version, all internal web apps and external SaaS apps available in the Citrix Workspace app open
in Citrix Enterprise Browser. You can register for this technical preview by using this Podio form.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tion environments, and to give customers an opportunity to share feedback. Citrix does not ac‑
cept support cases for feature previews butwelcomes feedback for improving them. Citrixmight
or might not act on feedback based on its severity, criticality, and importance. It’s advised that
Beta builds aren’t deployed in production environments.

Fixed issues

• When the Citrix Workspace login prompt appears, clicking the Cancel button doesn’t close the
popup and it appears repeatedly. [CVADHELP‑19919]

• If you’re using Direct Workload Connection in Citrix Cloud to connect to VDAs directly, a black
screen appears and you’re disconnected from the VDA. This issue occurs when Network Loca‑
tion Service (NLS) is enabled. [HDX‑40588]
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• When you use a multi‑touch gesture to swipe between full‑screen apps, the Citrix Workspace
desktop session window turns black for a moment. This issue occurs on Macs with a notch
display. [HDX‑42314]

2206.1

What’s new

Uninstall the app by dragging the CitrixWorkspace app icon to the bin You can now simply drag
or move the Citrix Workspace app icon into the bin to completely uninstall the app.

Previously, dragging the Workspace app icon into the bin would remove the app but leave behind
certain system files on your Mac. With this version, the Citrix Workspace app and all its associated
files are removed from your device when you drag the icon to the bin.

To uninstall the Citrix Workspace app by dragging it to the bin, do the following:

1. Close the Citrix Workspace app, if it’s running.
2. Drag the Citrix Workspace app to the bin.

Alternatively, you can right‑click on the Citrix Workspace app and selectOptions >Move to Bin.
3. Provide your system credentials when prompted.
4. Close all running apps (Citrix Workspace) and click Continue to confirm.

The Citrix Workspace app and all its system files are deleted from your device.

For more information, see Uninstall

Support for service continuity in the Safari browser The Citrix Workspace service continuity fea‑
ture is now supported for the Safari browser. Users must install Citrix Workspace app for Mac and the
Citrix Workspace web extension. Service continuity removes (or minimizes) the dependency on the
availability of the components involved in the connection process. It allows you to connect to your
virtual apps and desktops regardless of the cloud services’health status. Formore information about
the service continuity feature, see section Service continuity.

Improved audio echo cancellation support [Technical Preview] Citrix Workspace app now sup‑
ports echo cancellation in adaptive audio and legacy audio codecs. This feature is designed for real‑
time audio use cases, and it improves the user experience.
Citrix recommends using adaptive audio.

Note:

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
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but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It’s advised that Beta builds must not be deployed in
production environments.

Enhancements toOptimizedMicrosoftTeams In optimizedMicrosoft Teams, you can nowuse the
video functionwhenmore thanone virtual desktopor app session is in use. Formore information, see
Enhancements to Optimized Microsoft Teams

Battery status indicator [Technical Preview] The battery status of the device now appears in the
notification area of a Citrix Desktop session.

Note:

The battery status indicator does not appear for server VDAs.

Technical previews are available for customers to test in their non‑production or limited produc‑
tionenvironments, andshare feedback. Citrixdoesnotaccept support cases for featurepreviews
but welcomes feedback for improving them. Citrix might or might not act on feedback based on
its severity, criticality, and importance. It is advised that Beta builds are not deployed in produc‑
tion environments.

Citrix EnterpriseBrowser This release includesCitrix EnterpriseBrowser version 101.1.1.14, based
on Chromium version 101. Formore information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Fixed issues

• The mouse pointer is misaligned on Macs with a notch display. [CVADHELP‑19337]
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• You’re not signed out of theWorkspace appwhen the inactivity timeout value lapses. This issue
occurs intermittently. [CVADHELP‑19812]

• Youmight get an error when you try to uninstall Citrix Workspace app. [CVADHELP‑19121]

• In optimized Microsoft Teams, the video function might not work if you start another virtual
desktop or app session. [HDX‑40451]

• While sharing the screen or an app during the Microsoft Teams call, your peers might see visual
artifacts. This issue occurs due to unstable frame rates, such as incorrect video playback (frozen
or transient black frames). This release includes improved frame rates or sampling rates that
help to reduce visual artifacts. [HDX‑38032]

2204

What’s new

Global App Configuration service settings for allowedWebStoreURLs Admins can now use
Global App Configuration service to configure settings of Custom Web Stores. Admins can config‑
ure the Custom Web Stores by using the allowedWebStoreURLs property. For more information
about the Global App Configuration service, see Getting Started.

Support toopenCitrixWorkspaceapp inmaximizedmode Admins can configure themaximise
workspace window property in the Global App Configuration service to enable the Citrix Work‑

space app to open in the maximized mode by default. For more information about the Global App
Configuration service, see Getting Started.

Support for high DPImonitors [Technical preview] Citrix Workspace app for Mac is now compati‑
ble with one high DPI monitor with 4K or 5K resolution. With this feature, the text, images, and graph‑
ical elements on virtual desktop or app sessions appear in a size that can be viewed comfortably on
these high‑resolution monitors.

To enable this feature, navigate to Preferences > General > High DPI.
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Administrators can edit the Displaymemory limit policy, which specifies themaximum video buffer
size in kilobytes for a desktop session, to suit the display resolution. The default value for theDisplay
memory Limit policy is 65536 KB and is sufficient for one high DPI monitor with 4K resolution.

For virtual app sessions, the default value of Display memory Limit is sufficient as the app session
doesn’t support more than one display.

For virtual desktop sessions, administratorsmustnavigate toCitrixStudio>Policies>Displaymem‑
ory limit and use a higher value, for example 393216 KB to use High DPI features for more than one
external monitor or 5K resolution monitor.

For more information about the Display memory limit policy, see Display memory limit.

Admins can edit the Display memory limit policy, which specifies the maximum video buffer size
in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient for up to 2x4Kmonitors (2x32400KB). Admins must
edit this value by navigating to Citrix Studio > Policies > Display memory limit and use a value of
393216 KB to use this feature.

For more information about the Display memory limit policy, see Display memory limit.

Note:

This feature works with a maximum of two connectedmonitors.

Technical previews are available for customers to test in their non‑production or limited produc‑
tion environments, and to give customers an opportunity to share feedback. Citrix does not ac‑
cept support cases for feature previews butwelcomes feedback for improving them. Citrixmight
or might not act on feedback based on its severity, criticality, and importance. It’s advised that
Beta builds aren’t deployed in production environments.

Enhancement toPermanent Client Access License (CAL) for RemoteDesktopSessions With this
version, if you’re running CAL in your environment to access remote desktops, when the client ID is
greater than 15 characters, you can launch the remote desktop session with a permanent license.

To enable this feature, admins must configure the default.ica file by doing the following:

1. In the StoreFront server, navigate to C:\inetpub\wwwroot\Citrix<StoreName>\App_Data and
open the default.ica file with any editor.

2. Add the following lines in the [WFClient] section:

isRDSLicensingEnabled=On

Restore default keyboard settings You can now restore the default keyboard settings if you have
modified the settings in the keyboard preferences of Citrix Workspace app. To restore the keyboard
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settings to its default values, open theCitrixWorkspace app, navigate toPreferences >Keyboard and
click Restore Defaults. Click Yes to confirm.

App Protection compatibility with HDX optimization for Microsoft Teams With this version, full
monitor or desktop sharing is disabled when App Protection is enabled for the delivery group. When
you click Share content in Microsoft Teams, the screen picker removes the Desktop option. You can
only select theWindow option to share any open app, if the VDA is 2109 or higher. If you’re connected
to VDA older than 2019, no content is selectable.

Citrix Enterprise Browser This release includes Citrix Enterprise Browser version 99.1.1.8, based
on Chromium version 99. For more information about the Citrix Enterprise Browser, see Citrix Enter‑
prise Browser documentation.

Make Citrix Enterprise Browser your default browser You can now make Citrix Enterprise
Browser your default browser. Once you have made the Citrix Enterprise Browser your default
browser, all links and Web and SaaS apps open in the Citrix Enterprise Browser by default.
To make Citrix Enterprise Browser your default browser onmacOS, do the following:

1. Open the Citrix Enterprise Browser and click the ellipsis icon and open the Settingsmenu.

2. Click the Default Browser option on the left pane.

3. In the Default browser page, clickMake default. When prompted, click Use Citrix Enterprise
Browser to confirm your choice and apply the changes.

Fixed issues

• The mouse pointer is misaligned on Macs with a notch display. [CVADHELP‑19337]

• You’re not signed out of theWorkspace appwhen the inactivity timeout value lapses. This issue
occurs intermittently. [CVADHELP‑19812]

• Youmight get an error when you try to uninstall Citrix Workspace app. [CVADHELP‑19121]

• In optimized Microsoft Teams, the video function might not work if you start another virtual
desktop or app session. [HDX‑40451]

• While sharing the screen or an app during the Microsoft Teams call, your peers might see visual
artifacts. This issue occurs due to unstable frame rates, such as incorrect video playback (frozen
or transient black frames). This release includes improved frame rates or sampling rates that
help to reduce visual artifacts. [HDX‑38032]
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Known issues

Known issues in 2308

• After upgrading CitrixWorkspace app forMac to version 2308, the preferenceswindowmight be
unresponsive for any user actions. As aworkaround, force quit CitrixWorkspace app and restart
it. Formore information about forcing an app to close on aMac, see Force an app to close in the
Apple support article. [RFMAC‑14596]

Known issue in 2307

No new issues have been observed in this release.

Known issue in 2306

No new issues have been observed in this release.

Known issues in 2305

• After upgrading Citrix Workspace app for Mac to version 2305, certain third‑party virtual apps
that have pop‑up dialogs for entering user name and password might become unresponsive
upon opening. [CVADHELP‑23032]

Known issues in 2304

• A userwithmultiple accountsmight see the CitrixWorkspace app loading screen for a long time.
As a workaround, youmust quit Citrix Workspace app and restart it. [RFMAC‑13432]

Known issues in 2301.1

• You can’t update to Citrix Workspace app for Mac version 2301.1 using the auto‑update service.
As a workaround, youmustmanually install the Citrix Workspace app for Mac version 2301.1 by
downloading the .dmg file available on the Downloads page.

Known issues in 2301

• On macOS Ventura devices, progressive web apps (PWA) fail to open. The following error mes‑
sage appears:

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 82

https://support.apple.com/en-in/HT201276
https://www.citrix.com/downloads/workspace-app/


Citrix Workspace app for Mac

App Name is damaged and can’t be opened. You shouldmove it to the Bin.

As aworkaround, right‑click on the app and select Open. If you’re using the keyboard, press the
Ctrl key and click the app. Select Open. [CTXBR‑3885]

• An infinite loading spinnermight appearwhen users sign in to CitrixWorkspace associatedwith
Global App Configuration service. This issue doesn’t impact StoreFront and customweb stores.
[RFMAC‑13086]

Known issue in 2211.1

No new issues have been observed in this release.

Known issues in 2211

• When using Citrix Workspace app for Mac 2209 and later versions, the user sign‑in page might
not be displayed while using the custom web portal. As a workaround, quit Citrix Workspace
app by using theQuit option from Citrix Workspace icon in the menu bar. [CVADHELP‑21377]

Known issues in 2210

• OnmacOS 13 Ventura, the seamless app interactionmight run into issueswhen you change the
All at Once default option to theOne at a Time option in the StageManager preference under
the Stage Manager feature. [HDX‑44567]

• Attempts to start a desktop session in offline mode might fail. As a workaround, resize the ses‑
sion window. [HDX‑45081]

• When resizing a session to full‑screen mode on a MacBook, the focal point of a cursor might
appear slightly above the actual cursor position. As a workaround, navigate to System Prefer‑
ences > Dock &Menu Bar and enable the Automatically hide and show themenu bar in full
screen option. [HDX‑45585]

• With the 2210 version, using Mission Control or App Expose features in an app session might
cause Citrix Workspace app to close unexpectedly. [HDX‑46130]

• When launching certain third‑party apps such as Epic or Kronos, the sign‑inwindowof the apps
might covered by another window. As a result, the entire session freezes. As a workaround,
perform one of the following actions:

– Drag the window that is blocking the sign‑in window away from it.
– Locate the sign‑in window using the Mission Control feature.
– Use the keyboard shortcut Command+~ to switch windows.
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[HDX‑46140]

Known issues in 2209

No new issues have been observed in this release.

Known issue in 2208.1

No new issues have been observed in this release.

Known issue in 2206.1

No new issues have been observed in this release.

Known issue in 2204

• When traffic is tunneled through NGS, Citrix Workspace app might fail to upload or download
files that are greater than 64 MB. [CTXBR‑3354]

Known issues in 2203.1

• You can’t click the Create button in the Jira app if the browser window is minimized. [CTXBR‑
1976]

• Web socket connections aren’t tunneled through Citrix Secure Private Access. [CTXBR‑2439]

• After upgrading the Citrix Workspace app to version 2203, a question mark icon appears on the
Citrix Enterprise Browser icon. This issue occurs if the Citrix Enterprise Browser was pinned to
the dock before the upgrade. [CTXBR‑2864]

• When you click the Reset settings option on the Advanced settings section of the Citrix En‑
terprise Browser, the log settings do not reset to default. As a workaround, click the Reset to
default log settings option available on the Logs page. [CTXBR‑2929]

• After upgrading Citrix Enterprise Browser from version 2201 to version 2203, you are unable to
save new passwords and already saved passwords are lost. [CTXBR‑3063]

• Full screenmode isn’t available on Macs with a notch. [CVADHELP‑19337]

• When you launch a desktop or app session using the browser, the session window launches in
the background, behind the browser window. [RFMAC‑11362]
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Known issues in 2201

• The client name appears with random characters in the Citrix Broker Service and the Citrix Di‑
rector if you’re using the Citrix Workspace app in the offline (intranet) mode. [RFMAC‑10842]

Known issues in 2112

• In Citrix Workspace app, youmight experience intermittent failures when answering or making
a Microsoft Teams call. The following error message appears:
“Call could not be established.”[HDX‑38819]

Known issues in 2111

No new issues have been observed in this release.

Known issues in 2109.1

No new issues have been observed in this release.

Known issues in 2109

• If you’ve configured the Citrix Workspace app using the .cr file, and signed in with your cre‑
dentials, the home page appears after a delay. [RFMAC‑9990]

• If aProgressiveWebApp (PWA) that isprotected isopenedonmacOS, theAppProtectionpolicies
aren’t enforced. [RFMAC‑10128]

• After you add stores in the CitrixWorkspace app and change theCurrent ReauthenticationPe‑
riod inReauthenticationPeriod forWorkspaceAppandswitch fromon‑premises to the cloud
store after a fewminutes, you’re signed out of the cloud store and an authentication prompt ap‑
pears. Once you sign in to the Citrix Workspace app, the spinner appears indefinitely and you’
re unable to sign in. [RFMAC‑10140]

Known issues in 2108.1

No new issues have been observed in this release.
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Known issues in 2108

• When you start a subscribed SaaS app after changing the authentication domain in the server
console, the session does not start and the following error message appears:

“AuthDomain has changed. Please sign in again after some time”

[RFMAC‑9616]

Known issues in 2107

• When you change the authentication domain in the server console and sign inwith your creden‑
tials, the following error message appears:

Cannot connect to the server

You can access the store once you click OK.

[RFMAC‑9494]

Known issues in 2106

• A black window appears when you share your screen. [HDX‑30083]

Known issues in 2104

No new issues have been observed in this release.

Known issues in 2102

No new issues have been observed in this release.

Known issues in 2101

• Attempts to access files under Network Shares fromwithin Citrix Workspace app for Mac might
fail even when the option is enabled. [RFMAC‑7272]

• On macOS Big Sur, attempts to launch the web SAML single sign‑on app on Citrix Workspace
app for Mac might fail, displaying the following error message.

Page could not load. Please try again later or contact your
administrator for assistance. Incident ID:-202

[RFMAC‑7282]
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Known issues in 2012

• When you start a video call, MicrosoftTeamsmight becomeunresponsive, displaying aCitrix
HDX not connected error. As a workaround, restart Microsoft Teams or the VDA. [RFMAC‑

6727]
• Video calls on Microsoft Skype for Business aren’t supported onmacOS Big Sur (11.0.1).
• On macOS Big Sur (11.0.1), attempts to connect USB devices might fail, causing the session to
exit unexpectedly. As a workaround, reconnect the USB device. [RFMAC‑7079]

Deprecation

For information about deprecated items, see the Deprecation page.

Legacy documentation

For product releases that have reached End of Life (EOL), see Legacy documentation.

Third‑party notices

Citrix Workspace app might include third‑party software licensed under the terms defined in the fol‑
lowing document:

Citrix Workspace app for Mac Third‑Party Notices

Features in Technical Preview

May 3, 2024

Features in Technical Preview are available to use in non‑production or limited production environ‑
ments, and to give customers an opportunity to share feedback. Citrix does not accept support cases
for features in technical preview butwelcomes feedback for improving them. Citrixmight act on feed‑
back based on its severity, criticality, and importance.

List of features in Technical Preview

The following table lists the features in technical preview. These features are request‑only preview
features. To enable and provide feedback for any of these features, fill out the respective forms.
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Title Available from version
Enablement form
(Click the icon)

Feedback form (Click
the icon)

Support for single
sign‑on to Citrix
Secure Access
automatically through
Citrix Workspace app

2402

Client App
Management for Zoom
VDI plug‑in

2402

Enhanced the Desktop
Viewer toolbar

2402

Customize the Desktop
Viewer toolbar

2402

Enable Packet Loss
Concealment to
improve audio
performance

2402

Support for extending
the desktop session to
external monitors
automatically

2402

Sustainability initiative
from Citrix Workspace
app

2402

Support for Citrix
Secure Private Access
for on‑premises
deployments

2309

Enhanced the High DPI
option

2308
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Title Available from version
Enablement form
(Click the icon)

Feedback form (Click
the icon)

Support for Activity
Manager on cloud
stores

2308

Store‑based
configuration of file
access

2308

Keyboard accessibility
support for the toolbar
on the Virtual Desktop

2307

Client App
Management

2305

Rapid Scan 2304

Upgraded version of
WebRTC for the
optimized Microsoft
Teams

2210

Support for an
enhanced Single
sign‑on (SSO)
experience for web
and SaaS apps

2203.1

Support for single sign‑on to Citrix Secure Access automatically through Citrix Workspace app

Technical Preview from 2402
version

Enablement form Feedback form

Citrix Workspace app for Mac now automatically supports single sign‑on (SSO) to Citrix Secure Ac‑
cess once your login to Citrix Workspace app. If you have both Citrix Secure Access agent and the
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Citrix Workspace app installed on your device, this feature allows you to automatically sign in to Cit‑
rix Secure Access through SSO when you login to Citrix Workspace app. For more information, see
Automatic single sign‑on (SSO) to Citrix Secure Access through Citrix Workspace app ‑ Preview in the
NetScaler documentation.

To enable this feature through MDM, administrator must use the following settings:

<key>EnableSecureAccessAutoLogin</key><true/>

Note:

• You need to use Citrix Secure Access version 24.03.1 or later to enable this feature.
• This feature is supported only on cloud stores and not for on‑premises stores.

Client App Management for Zoom VDI plug‑in

Technical Preview from 2402
version

Enablement form Feedback form

Starting with the 2402 version, you can nowmanage the Zoom VDI plug‑in using the Client App Man‑
agement capability. With this feature, you can download, install, and auto‑update the ZoomVDI plug‑
in from Citrix Workspace app.

Enhanced the Desktop Viewer toolbar

Technical Preview from 2402
version

Enablement form Feedback form

Starting with the 2402 version, the virtual desktop viewer toolbar is enhanced to be more intuitive,
modern, and user‑friendly.

The new toolbar provides the following options:

• Show or hide toolbar ‑ Click this button to show or hide the Desktop Viewer toolbar. A notch
appears when the toolbar is hidden.

• Shortcuts ‑ Click this button to access the shortcuts.
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• Devices ‑ Click this button to access the options in the Devices section.
• Preferences ‑ Click this button to access the options in the Preferences section.
• Minimize ‑ Click this button to minimize the virtual session. This option is hidden in the full‑
screenmode.

• Fullscreen ‑ Click this button to access the virtual session in full screen.
• Restore –Click this button to restore the virtual session from the full‑screenmode.
• Disconnect ‑ Click this button to sign out or to disconnect from a virtual session.

You can drag the toolbar across all screens in the virtual session. When you drag the toolbar, it can ro‑
tate automatically based on its placement on the screen. Once you release the drag, it gets positioned
to the nearest edge of the screen.

Customize the Desktop Viewer toolbar

Technical Preview from 2402
version

Enablement form Feedback form

Previously, you can completely disable the Desktop Viewer toolbar. However, you cann’t enable or
disable a few options on the toolbar. With this release, you can customize the Citrix Workspace app
for Mac toolbar by adding and removing options on the toolbar. For more information, see Hide or
show the desktop tool bar in the virtual desktop session.

You can configure the toolbar through the Mobile Device Management (MDM) settings. The following
settings can hide the Device, Preferences, Minimize, and Full screen button:

1 <key>HiddenToolbarButtons</key>
2 <array>
3 <string>device</string>
4 <string>preferences</string>
5 <string>minimize</string>
6 <string>fullscreen</string>
7 </array>
8
9 <!--NeedCopy-->

Note:

You cannot hide the Pin button from the toolbar.

Enable Packet Loss Concealment to improve audio performance
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Technical Preview from 2402
version

Enablement form Feedback form

Starting with the 2402 version, the jitter buffer mechanism is improved, and the Packet Loss Conceal‑
ment (PLC) is added for the Adaptive audio codec. PLC helps to reconstruct the lost data packets. This
enhancement helps to improve the packet loss tolerance and jitter tolerance and thus improves audio
performance for loss tolerant mode (EDT lossy) for audio.

To enable this feature, you also need to enable the Loss tolerant mode for the audio feature.

Support for extending the desktop session to external monitors automatically

Technical Preview from 2402
version

Enablement form Feedback form

Startingwith the 2402 version, CitrixWorkspace app supports the extension of desktop sessions to ex‑
ternal monitors automatically. When you launch the desktop session on the endpoint, if the external
monitors are already connected to the endpoint, then the session is extended to external monitors
automatically. When you disconnect the external monitor, the session can automatically adjust to
extend only to the connectedmonitors.

To enable this feature, go to the View menu in the Citrix Viewer menu bar and select the Use All
Displays in Full Screen option.

Sustainability initiative from Citrix Workspace app

Technical Preview from 2402
version

Enablement form Feedback form

Starting with the 2402 version, Citrix Workspace app for Mac supports the Sign out option for the
virtual desktop session. This featuremight help conserve energy if you sign out fromvirtualmachines
when not in use.
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When the user clicks Disconnect or Sign out, or closes a virtual desktop, then the following prompt
is displayed, recommending the user to use the Sign out option to save energy.

Support for Citrix Secure Private Access for on‑premises deployments

Technical Preview from 2309
version

Enablement form Feedback form

Starting with the 2309 version, Citrix Workspace app for Mac supports Citrix Secure Private Access for
on‑premises deployments. For more information, see Secure Private Access for on‑premises ‑ Pre‑
view.

Enhanced the High DPI option

Technical Preview from 2308
version

Enablement form Feedback form

Previously, Citrix Workspace app supported theHigh DPI option for virtual desktop sessions only.

Starting with the 2308 release, enabling the High DPI option can also support for seamless app ses‑
sions. Also, you cannowenable theHighDPI optionon three 4kmonitors. These features aredisabled
by default.
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To enable the High DPI option, you must select Preferences > General. On the General tab, select
Enable and match the client DPI scale settings. Restart the application for the changes to take
effect.

Support for Activity Manager on cloud stores

Technical Preview from 2308
version

Enablement form Feedback form

Citrix Workspace app for Mac supports the Activity Manager feature. This feature lets end users view
and interact with all their active apps and desktop sessions at one place. You can disconnect or ter‑
minate the active sessions directly from the Activity Manager.

To view active sessions in the Activity Manager, select the Citrix Workspace app icon from themenu
bar and then click Activity Manager. To disconnect active desktop sessions, select the respective
ellipsis (…)menu and click Disconnect. Click the “X”button to terminate the active app session. For
more information, see Activity manager.
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Store‑based configuration of file access

Technical Preview from 2308
version

Enablement form Feedback form

Starting with the 2308 release, the per‑store file access is included as part of the client‑selective trust
feature. This enhancement allows you to provide access to files on a per store basis.

To enable file access for a store, you must select Preferences > File Access. On the File Access tab,
select the store and the type of access required for that store. You can choose any of the following
types of access for files and drives on your computer:

• Read andwrite: Provides read and write access to files and drives for the selected store.
• Read only: Provides read only access to files and drives for the selected store.
• No access: Restrict access to files and drives for the selected store.
• Askme each time: Request permission to access files and drives each time when read or write
access is required for the selected store.
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Keyboard accessibility support for the toolbar on the Virtual Desktop

Technical Preview from 2307
version

Enablement form Feedback form

With the 2307 release, you can use the keyboard shortcut to access the Virtual Desktop Infrastructure
(VDI) toolbar. From the Citrix Viewer, go to View in themenu bar and selectUse Toolbar shortcut to
use the keyboard shortcut. By default, the Use Toolbar shortcut option is enabled.

You can use the following keyboard shortcuts to access the VDI toolbar using the keyboard:

• Shift + Command + T: To activate the VDI toolbar.
• Tab: To navigate across the VDI Toolbar in the clockwise direction.
• Shift + Tab: To navigate across the VDI toolbar in the anti‑clockwise direction.
• Space: To select an option on the VDI Toolbar.
• Escape: To close a modal in focus.

The toolbar andCWApreferencewindownow supportKeyboardnavigation, which helps to navigate
between the UI elements and highlights the element that is in focus.
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Client App Management

Technical Preview from 2305
version

Enablement form Feedback form

CitrixWorkspace app 2305 forMac nowoffers Client AppManagement capability thatmakes the Citrix
Workspace app a single client app required on the end point to install andmanage agents such as End
Point Analysis (EPA) plug‑in.
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With this capability, administrators can easily deploy andmanage required agents from a singleman‑
agement console.

Note:

• This feature is applicable to Workspace (cloud) sessions only.
• Global App Configuration service is a prerequisite for this feature.

Client App Management includes the following steps:

• Administratorsmust specify the agents required on end users’devices in the Global App Config‑
uration service. With this technical preview, administrators can specify an Endpoint Analysis
(EPA) agent.

• Citrix Workspace app fetches the list of agents from Global App Configuration service.
• Based on the list fetched from Global App Configuration service, Citrix Workspace app down‑
loads theagentpackages through theauto‑update service. If theagent isn’t previously installed
on the end point, Citrix Workspace app triggers the installation of the agent. If the agent is al‑
ready installed, CitrixWorkspace app triggers an update to the agent (if the version of the down‑
loaded agent is higher than the installed version.)

Citrix Workspace app ensures to automatically update the agents whenever an update is available in
the future.

The following diagram illustrates the workflow:

Example JSON file in Global App Configuration service:
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1 {
2
3     "serviceURL": {
4
5         "url": "https://serviceURL:443"
6     }
7 ,
8     "settings": {
9

10         "name": "Client App management",
11         "description": "Client App management",
12         "useForAppConfig": true,
13         "appSettings": {
14
15             "macos": [
16                 {
17
18                     "category": "AutoUpdate",
19                     "userOverride": false,
20                     "assignedTo": [
21                         "AllUsersNoAuthentication"
22                     ],
23                     "settings": [
24                         {
25
26                             "name": "Auto update plugins settings",
27                             "value": [
28                                 {
29
30                                     "pluginName": "Citrix Endpoint

Analysis",
31                                     "pluginId": "7303CB73-42EE-42BB-

A908-9E6575912106",
32                                     "pluginSettings": {
33
34                                         "deploymentMode": "

InstallAndUpdate",
35                                         "upgradeToLatest": true,
36                                         "minimumAllowedVersion": "1.0",
37                                         "maximumAllowedVersion": "24.0"

,
38                                         "delayGroup": "Medium",
39                                         "stream": "",
40                                         "isFTU": true,
41                                         "isBlocking": true,
42                                         "detectRule": ""
43                                     }
44
45                                 }
46
47                             ]
48                         }
49
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50                     ]
51                 }
52
53             ]
54         }
55
56     }
57
58 }
59
60
61 <!--NeedCopy-->

The following table lists the Client App Management settings schema, values, and description.

Schema setting Value Description

isBlocking True or False When the isBlocking parameter
is set to true, the plug‑in is
consideredmandatory. The
sign‑in page appears only when
the required plug‑in is installed.
Citrix recommends you set EPA
as the mandatory plug‑in.

pluginName Friendly name for the plug‑in.
The pluginName can be
modified.

pluginId ID of the plug‑in andmust not
be modified.

deploymentMode InstallAndUpdate/Update

maximumAllowedVersion Maximum allowed version of
the plug‑in.

minimumAllowedVersion Minimum allowed version of
the plug‑in.

upgradeToLatest True or False

Starting with the 2301 release, administrators can manage auto‑update of EPA Clients for macOS
through the CitrixWorkspace app and single sign‑on to Citrix Secure Access if you have already signed
in to Citrix Workspace app.
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Auto‑update of Endpoint Analysis (EPA)

You can now manage auto‑update of EPA Clients for macOS through the Citrix Workspace app. Ad‑
ministrators must specify the agents required on end users’devices in the Global App Configuration
service. If the agent is already installed and a new version of the agent is available, then the Citrix
Workspace app updates the agent to the next higher version. Citrix Workspace app ensures to auto‑
matically update the agents whenever a new update is available in the future.

Example JSON file in Global App Configuration service:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
7 ,
8 "settings": {
9

10 "name": "Client App management",
11 "description": "Client App management",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "category": "AutoUpdate",
19 "userOverride": false,
20 "assignedTo": [
21 "AllUsersNoAuthentication"
22 ],
23 "settings": [
24 {
25
26 "name": "Auto update plugins settings",
27 "value": [
28 {
29
30 "pluginName": "Citrix Endpoint

Analysis",
31 "pluginId": "7303CB73-42EE-42BB-

A908-9E6575912106",
32 "pluginSettings": {
33
34 "deploymentMode": "

InstallAndUpdate",
35 "upgradeToLatest": true,
36 "minimumAllowedVersion": "1.0",
37 "maximumAllowedVersion": "7.0",
38 "delayGroup": "Medium",
39 "stream": "",
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40 "isFTU": false,
41 "isBlocking": false,
42 "detectRule": ""
43 }
44
45 }
46
47 ]
48 }
49
50 ]
51 }
52
53 ]
54 }
55
56 }
57
58 }
59
60
61 <!--NeedCopy-->

Themeaningof theproperties and their possible values for thedeploymentModekey are as follows:

• “InstallAndUpdate”: The plug‑in can be freshly installed and updated with a new version.
• “Update”: Only update is allowed, no fresh install.
• “None”: No action needed for this plug‑in.

Single sign‑on to Citrix Secure Access using Citrix Workspace app

You can single sign‑on to Citrix Secure Access if you have already signed in to Citrix Workspace app.
When you sign in to Citrix Workspace app and open Citrix Secure Access, you are not asked to authen‑
ticate by entering the credentials. It automatically proceeds with the authentication. This feature
provides users with a seamless experience by allowing single sign‑on to different Citrix applications.
This feature is availableonly for customerson cloud stores. Alongwith the latest versionof CitrixWork‑
space app, youmust have a compatible version of Citrix Secure Access (22.12.2 and later versions).

Rapid Scan

Technical Preview from 2304
version

Enablement form Feedback form

If you’re logged into Citrix Workspace app onmultiple devices, you can use the Rapid Scan feature to
scan multiple documents with an iOS device, and then transfer those scanned documents to a Mac
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device.

For instructions on how to use the Rapid Scan feature to scan documents, follow these steps:

1. On your Mac device, right‑click on the Citrix Workspace app icon in your desktop session and
then click Rapid Scan to display a QR code.

2. On your iOS device, click Settings > Rapid Scan.

3. Scan the QR code displayed on your Mac device to establish the connection between your Mac
and iOS devices.

4. Scan any document and send it to your Mac device.

5. In your desktop session on your Mac device, you can locate the documents you scanned in the
Finder.
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Prerequisites

• Client drive mapping (CDM) must be enabled for the store.

• Youmust be signed into the same account in the Citrix Workspace app on both your iOS device
and Mac device.

• Youmust be connected to the sameWi‑Fi.

• The minimum version required of Citrix Workspace app for Mac is 2304.

• This feature is supported on Citrix Workspace app for iOS version 23.3.5 onwards.

• Rapid Scan requires read andwrite access on your device. To enable access, follow these steps:

1. From your profile, click Application Settings > Store Settings.

2. Click your current store.

3. Click Device Storage and select Read andwrite access.

Upgraded version of WebRTC for the optimized Microsoft Teams
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Technical Preview from 2210
version

Enablement form Feedback form

Starting with the 2210 version, the version of WebRTC that is used for the optimized Microsoft Teams
is upgraded to version M98.

Support for an enhanced Single sign‑on (SSO) experience for web and SaaS apps

Technical Preview from 2203.1
version

Enablement form Feedback form

This feature simplifies the configuration of SSO for internal web apps and SaaS appswhile using third
party identity providers (IdPs). The enhanced SSO experience reduces the entire process to a few
commands. It eliminates the mandatory prerequisite to configure Citrix Secure Private Access in the
IdP chain to set up SSO. It also improves the user experience, provided the same IdP is used for au‑
thenticating the Citrix Workspace app and the particular web or SaaS app that is launched fromCitrix
Workspace app.

Technical Preview to General Availability (GA)

Service or feature General availabity version

Support for H.265 video decoding 2402

Upgraded HDX Reducer to Version 4 2402

Loss tolerant mode for audio 2402

Support for Audio volume synchronization 2402

Support for background blur for webcam 2402

Support for screen sharing when App protection
is enabled

2402

Support for authentication using FIDO2 when
connecting to on‑premises store

2311

Enhanced virtual apps and desktops launch
experience for Workspace (Cloud users only)

2311

Improved graphics performance 2308
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Service or feature General availabity version

Increase in the number of supported virtual
channels

2308

Native support for Mac with Apple Silicon (M1 andM2 series)

January 25, 2024

Native support for Mac with Apple Silicon (M1 andM2 series) ‑ Universal architecture

With the releaseof theUniversal Architecturebuild, CitrixWorkspaceappnowprovidesnative support
for Macs with Apple silicon (M1 and M2 series). The Universal Architecture build can run on any Mac
device, irrespective of their processor architecture.

If you are using the x86_64 Intel‑based architecture build of Citrix Workspace app for Macs with Apple
Silicon (M1 and M2 series), then youmust use Rosetta emulation to run the app.

You can download the latest version of Universal Architecture build and x86_64 Intel‑based Architec‑
ture build at Downloads.

Note:

Citrix will soon deprecate the x86_64 Intel‑based Architecture build of Citrix Workspace app. Cit‑
rix continue to support Universal Architecture build for both Intel‑based Macs and Macs with
Apple Silicon (M1 and M2 Series). Keep a look out for an announcement in the Deprecation sec‑
tion.

If you’re using Citrix Workspace app on a Mac running Apple silicon (M1 and M2 series), you must
upgrade theHDXRealTimeOptimizationPack (RTOP). You canupgradeby installing theHDXRealTime
Media Engine 2.9.500 for Mac from the Citrix website at Downloads.

To determine if the Citrix Workspace app is running natively on Apple silicon, open Activity monitor
on your Mac. The column title Kind in the CPU tab indicates whether the Workspace app is running
on an Apple Silicon or Intel processor.
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Migrating between different builds of Citrix Workspace app

You canmigrate Citrix Workspace app from the x86_64 Intel‑based Architecture build to the universal
architecture build and the other way around.

Tomigrate between builds, download the latest version of the build at Downloads and do themanual
installation. For more information, see Manual install.

Alternatively, you canmigratebetweenbuilds using theGUI. This option is applicable only for users on
Mac with Apple silicon (M1 and M2 series). For more information about migration using the graphical
user interface, seeConfigureCitrixWorkspace automatic updates using the graphical user interface.

Note:

Uninstalling the app isn’t required for migrating between builds.

Citrix Virtual Channel SDK

TheCitrix Virtual Channel softwaredevelopmentkit (VCSDK) supportswriting server‑sideapplications
and client‑side drivers for more virtual channels using the ICA protocol. The server‑side virtual chan‑
nel applications are on Citrix Virtual Apps and Desktops servers. If youwant towrite virtual drivers for
other client platforms, contact Citrix Technical support.

The Virtual Channel SDK provides:

• TheCitrix Virtual Driver ApplicationProgramming Interface (VDAPI) is usedwith the virtual chan‑
nel functions in theCitrix Server API SDK (WFAPI SDK) to createnewvirtual channels. The virtual
channel support provided by VDAPI makes it easy to write your own virtual channels.

• TheWindowsMonitoring API, which enhances the visual experience and support for third‑party
applications integrated with ICA.

• Working source code for virtual channel sample programs to demonstrate programming tech‑
niques.

The Virtual Channel SDK requires the WFAPI SDK to write the server side of the virtual channel.
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Load Custom Virtual Channels on Macs with Apple Silicon (M1 andM2 series)

As an end‑user, you can load the Custom Virtual Channel SDK (VCSDK) successfully on a Mac with the
M1andM2chipset. With universal architecture, youmust load the VCSDKby recompiling yourCustom
Virtual Channels using the latest VCSDK on the M1 and M2 chipset device. You can download the uni‑
versal architecture build from the Virtual Channel SDK 2204 for macOS (Apple silicon) ‑ Universal
Architecture section at Downloads.

To load the VCSDK, do the following:

1. Download Virtual Channel SDK 2204 for macOS from Downloads.
2. Open your Custom Virtual Channel project in Xcode.
3. Change your code.
4. Compile your Custom Virtual Channel to generate the virtual channel bundle.

Test your Virtual Channel Software Development Kit (VCSDK)

If you’re using the Citrix Virtual Channel Software Development Kit (VCSDK), you must customize so
your customized virtual channels run correctly. To test your VCSDKs, do the following:

1. Ensure that all the linked libraries of your customized virtual channels are compiled for Univer‑
sal Binary.

2. Change the Project file to support Universal Binary:

• Open Project > Build Settings.
• Set Architectures to Standard Architectures.

Examples for the VCSDK can be found inside VCSDK.dmg. These examples support Apple’s Universal
macOS Binary that runs natively on both Apple silicon and Intel‑based Mac computers. Because it
contains executable code for both architectures. You can use these examples as a reference.
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Modernized Citrix Virtual Channel SDK for Citrix Workspace app for Mac

Startingwith the 2311 version, the Citrix Virtual Channel Software Development Kit (VCSDK) supports
writing server‑side applications and client‑side drivers for more virtual channels using the ICA proto‑
col. The server‑side virtual channel applications are on Citrix Virtual Apps and Desktops servers. This
version of the SDK supports writing new virtual channels and screen sharing for Citrix Workspace app
for Mac.

Formore information, seeCitrix Virtual Channel SDK forCitrixWorkspaceapp forMac in theDeveloper
documentation.

Increase in the number of supported virtual channels

Previously, Citrix Workspace app for Mac supported up to 32 virtual channels. Starting with the 2308
version, you can use up to 64 virtual channels in a session.

Citrix Workspace app for Mac ‑ Preview

April 11, 2024

Citrix Workspace app for 2405 Mac ‑ Preview is coming soon. Look forward to the new features and
resolved issues in the upcoming release.

The generally available version of Citrix Workspace app for Mac is 2402. For more information on the
current release, see About this release.
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System requirements and compatibility

May 3, 2024

Supported operating systems

Citrix Workspace app for Mac supports the following operating systems:

• macOS Sonoma 14.4.1
• macOS Ventura 13
• macOS Monterey 12
• macOS Big Sur 11

At any point in time, Citrix supports only the latest and the previous twomacOS operating systems (N,
N‑1, and N‑2) only.

Compatible Citrix products

CitrixWorkspace app is compatiblewith all the currently supported versions of Citrix Virtual Apps and
Desktops, Citrix DaaS (formerly Citrix Virtual Apps and Desktops service), and Citrix Gateway as listed
in the Citrix Product Lifecycle Matrix.

Compatible browsers

Citrix Workspace app for Mac is compatible with the following browsers:

• Google Chrome
• Microsoft Edge
• Safari

Hardware requirements

• 1 GB of free disk space
• A working network or Internet connection to connect to servers
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Connections, Certificates, and Authentication

Connections

Citrix Workspace app for Mac supports the following connections to Citrix Virtual Apps and Desktops
and Citrix DaaS (formerly Citrix Virtual Apps and Desktops service):

• HTTPS
• ICA‑over‑TLS
• ICA‑over‑DTLS

Citrix Workspace app for Mac supports the following configurations:

For LAN connections For secure remote or local connections

StoreFront using StoreFront services or Citrix
Receiver for website;

Citrix Gateway 12.x‑13.x, including VPX

Certificates

Important:

If you’re runningmacOS 10.15, ensure that your system is compliant with Apple’s requirements
for trusted certificates in macOS 10.15. Perform this check before you upgrade to Citrix Work‑
space app for Mac version 2106.

Private (Self‑signed) certificates If a private certificate is installed on the remote gateway, you
must install the root certificate for the organization’s certificate authority on the user device. Then,
you can successfully access Citrix resources using Citrix Workspace app for Mac.

Note:

When the remote gateway’s certificate can’t be verified upon connection, an untrusted certifi‑
cate warning appears, as the root certificate isn’t included in the local keystore. When a user
continues to add a store, the store addition fails. However, on the web browser, the user might
be able to authenticate to the store but connections to sessions fail.

Importing root certificates for devices

Obtain the certificate issuer’s root certificate and email it to an account configured on your device.
When clicking the attachment, you’re asked to import the root certificate.
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Wildcard certificates Wildcard certificates are used in place of individual server certificates for any
server within the same domain. Citrix Workspace app for Mac supports wildcard certificates.

Intermediate certificates with Citrix Gateway If your certificate chain includes an intermediate
certificate, the intermediate certificate must be mapped to the Citrix Gateway server certificate. For
information on this task, see Citrix Gateway documentation. For more information about installing,
linking, and updating certificates, see How to Install and Link Intermediate Certificate with Primary
CA on Citrix Gateway.

Server Certificate Validation Policy Citrix Workspace app for Mac has a stricter validation policy
for server certificates.

Important

Before installing this version of Citrix Workspace app for Mac, confirm that the server or gateway
certificates are correctly configured as described here. Connections can fail if:

• the server or gateway configuration includes a wrong root certificate
• the server or gateway configuration does not include all intermediate certificates
• the server or gateway configuration includes an expired or otherwise invalid intermediate
certificate

• the server or gateway configuration includes a cross‑signed intermediate certificate

When validating a server certificate, Citrix Workspace app for Mac uses all the certificates supplied by
the server (or gateway). CitrixWorkspace app forMac then checkswhether the certificates are trusted.
If none of the certificates are trusted, the connection fails.

This policy is stricter than the certificate policy in web browsers. Many web browsers include a large
set of root certificates that they trust.

The server (or gateway) must be configured with the correct set of certificates. An incorrect set of
certificates might cause Citrix Workspace app for Mac’s connection to fail.

Suppose that agateway is configuredwith these valid certificates. This configuration is recommended
for customers who require stricter validation, by determining exactly which root certificate is used by
Citrix Workspace app for Mac.

Then, Citrix Workspace app for Mac checks that all these certificates are valid. Citrix Workspace app
for Mac also checks that it already trusts the “Root Certificate”. If Citrix Workspace app for Mac does
not trust the “Root Certificate”, the connection fails.

Important

Some certificate authorities have more than one root certificate. If you require this stricter vali‑
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dation, ensure that your configuration uses the appropriate root certificate. For example, there
are currently two certificates (“DigiCert/GTE CyberTrust Global Root”, and “DigiCert Baltimore
Root/Baltimore CyberTrust Root”) that can validate the same server certificates. On some user
devices, both root certificates are available. On other devices, only one is available (“DigiCert
Baltimore Root/Baltimore CyberTrust Root”). If you configure “GTE CyberTrust Global Root”at
the gateway, Citrix Workspace app for Mac connections on those user devices fail. Consult the
certificate authority’s documentation to determine which root certificate must be used. Root
certificates eventually expire, as do all certificates.

Note:

Some servers andgateways never send the root certificate, even if configured. Stricter validation
is then not possible.

Now suppose that a gateway is configured with these valid certificates. This configuration, omitting
the root certificate, is normally recommended:

• “Example Server Certificate”
• “Example Intermediate Certificate”

Then, Citrix Workspace app for Mac uses these two certificates. It then searches for a root certificate
on the user device. If it finds a trusted certificate that validates correctly, such as “Example Root Cer‑
tificate”, the connection succeeds. Otherwise, the connection fails. This configuration supplies the
intermediate certificate thatCitrixWorkspaceapp forMacneeds, but also allowsCitrixWorkspaceapp
for Mac to choose any valid, trusted, root certificate.

Now suppose that a gateway is configured with these certificates:

• “Example Server Certificate”
• “Example Intermediate Certificate”
• “Wrong Root Certificate”

A web browser might ignore the wrong root certificate. However, Citrix Workspace app for Mac does
not ignore the wrong root certificate, and the connection fails.

Some certificate authorities use more than one intermediate certificate. In this case, the gateway is
normally configured with all the intermediate certificates (but not the root certificate) such as:

• “Example Server Certificate”
• “Example Intermediate Certificate 1”
• “Example Intermediate Certificate 2”

Important

Some certificate authorities use a cross‑signed intermediate certificate, intended for situations
when there’s more than one root certificate. An earlier root certificate is still in use at the same
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time as a later root certificate. In this case, there are at least two intermediate certificates. For
example, the earlier root certificate “Class 3 Public Primary Certification Authority”has the cor‑
responding cross‑signed intermediate certificate “Verisign Class 3 Public Primary Certification
Authority ‑ G5.”However, a corresponding later root certificate “Verisign Class 3 Public Primary
Certification Authority ‑ G5”is also available, which replaces “Class 3 Public Primary Certification
Authority.”The later root certificate does not use a cross‑signed intermediate certificate.

Note

The cross‑signed intermediate certificate and the root certificate have the same Subject name
(Issued To), but the cross‑signed intermediate certificate has a different Issuer name (Issued By).
This difference in name distinguishes the cross‑signed intermediate certificate from an ordinary
intermediate certificate (such “Example Intermediate Certificate 2”).

This configuration, omitting the root certificate and the cross‑signed intermediate certificate, is nor‑
mally recommended:

• “Example Server Certificate”
• “Example Intermediate Certificate”

Avoid configuring the gateway to use the cross‑signed intermediate certificate, as it selects the earlier
root certificate:

• “Example Server Certificate”
• “Example Intermediate Certificate”
• “Example Cross‑signed Intermediate Certificate”[not recommended]

It isn’t recommended to configure the gateway with only the server certificate:

• “Example Server Certificate”

In this case, if Citrix Workspace app for Mac can’t locate all the intermediate certificates, the connec‑
tion fails.

Authentication

For connections to StoreFront, Citrix Workspace app for Mac supports the following authentication
methods:
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Authentication
method

Workspace for
Web using
browsers

StoreFront
Services site
(native)

Citrix Gateway
to Workspace
for Web
(browser)

Citrix Gateway
to StoreFront
Services site
(native)

Anonymous Yes Yes

Domain Yes Yes Yes* Yes*

Domain
pass‑through
Security token Yes* Yes*

Two‑factor au‑
thentication
(domain with
security
token)

Yes* Yes*

SMS Yes* Yes*

Smart card Yes Yes Yes* Yes

User
certificate

Yes Yes (Citrix
Gateway
Plug‑in)

*Available only for deployments that include Citrix Gateway, with or without installing the associated
plug‑in on the device.

Connectivity requirements

Feature flagmanagement

If an issue occurs with Citrix Workspace app in production, we can disable an affected feature dynam‑
ically in Citrix Workspace app even after the feature is shipped. To do so, we use feature flags and a
third‑party service called LaunchDarkly.

Youdonot need tomake any configurations to enable traffic to LaunchDarkly, exceptwhen youhave a
firewall or proxyblockingoutbound traffic. In that case, youenable traffic to LaunchDarkly via specific
URLs or IP addresses, depending on your policy requirements.

You can enable traffic and communication to LaunchDarkly in the following ways:

Enable traffic to the following URLs
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• events.launchdarkly.com
• stream.launchdarkly.com
• clientstream.launchdarkly.com
• Firehose.launchdarkly.com
• mobile.launchdarkly.com

List IP addresses in an allow list If youmust list IP addresses in an allow list, for a list of all current
IP address ranges, see LaunchDarkly public IP list. You canuse this list to ensure that your firewall con‑
figurations are updated automatically in keeping with the infrastructure updates. For details about
the status of the infrastructure changes, see LaunchDarkly Statuspage page.

LaunchDarkly system requirements Ensure that the apps can communicate with the following
services if you have split tunneling on Citrix ADC set toOFF for the following services:

• LaunchDarkly service.
• APNs listener service

Provision todisable LaunchDarkly service throughMDMtool Startingwith version 2210, you can
disable the LaunchDarkly service on Citrix Workspace app, irrespective of whether their users are in‑
side or outside the organization’s firewall. To disable the LaunchDarkly service, set the value for the
DisableFeatureFlag setting to True.

This service is available for admins whomanage Mac devices using the MDM tool.

Note:

Disabling the FeatureFlag requires the admin to restart the device for this setting to take effect.

For more information on how to use MDM, see Mobile Device Management.

Install, uninstall, and upgrade

May 23, 2024

Citrix Workspace app for Mac contains a single installation package and supports remote access
through Citrix Gateway, and Secure Web Gateway.

You can install Citrix Workspace app for Mac in any of the following ways:

• From the Citrix website
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• Automatically fromWorkspace for Web

• Using an Electronic Software Distribution (ESD) tool.

By default, the Citrix Workspace app is installed in the Applications directory. The installation paths
are as follows:

• Full install ‑ "/Applications/Citrix\ Workspace.app/"
• Citrix Workspace app for Mac executable ‑ "/Applications/Citrix\ Workspace.app
/Contents/MacOS/Citrix\ Workspace"

Manual install

By a user from Citrix.com

Asa first‑timeuser, you candownloadCitrixWorkspaceapp forMac fromCitrix.comor yourowndown‑
load site. You can then set up an account by entering an email address instead of a server URL. Citrix
Workspace app for Mac determines the Citrix Gateway or StoreFront server associated with the email
address. Then it prompts the user to log on and continue the installation. This feature is referred to
as email‑based account discovery.

Note:

A first‑time user is a user who does not have Citrix Workspace app for Mac installed on their user
device.

Email‑based account discovery for a first‑time user does not apply if you have downloaded from a
location other than Citrix.com (such as a Citrix Receiver for website).

If your site requires the configuration of Citrix Workspace app for Mac, use an alternate deployment
method.

Using an Electronic Software Distribution (ESD) tool

A first‑time Citrix Workspace app for Mac user must enter a server URL to set up an account.

From Citrix Downloads page

You can install Citrix Workspace app for Mac from a network share, or directly on to the user device.
You can install the app by downloading the file from the Citrix website at Downloads.

To install Citrix Workspace app for Mac:
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1. Download the .dmg file for the version of Citrix Workspace app for Mac that you want to install
from the Citrix website.

2. Open the downloaded file.
3. On the Introduction page, click Continue.
4. On the License page, click Continue.
5. Click Agree to accept the terms of the License Agreement.
6. On the Installation Type page, click Install.
7. On the Add Account page, select Add Account and then click Continue.
8. Enter the user name and password of an administrator on the local device.

Using the terminal command

You can install Citrix Workspace app for Mac using the terminal commands.

To install Citrix Workspace app for Mac:

1. Download the .dmg file for the version of Citrix Workspace app for Mac that you want to install
from the Downloads page.

2. Open the downloaded CitrixWorkspaceApp.dmg file.

3. Drag the Install Citrix Workspace.pkg file into the folder.

4. Open the terminal app.

5. Run the following command in the terminal:

1 sudo installer -pkg <path_to_package>/<package_name>.pkg -target /
2 <!--NeedCopy-->

6. Enter the Administrator password, if prompted.

7. After running the command, Citrix Workspace app is successfully installed.

Uninstall

Using the bin

You can now simply drag or move the Citrix Workspace app icon into the bin to completely uninstall
the Citrix Workspace app for Mac.

To uninstall the Citrix Workspace app, do the following:

1. Close the Citrix Workspace app, if it’s running.
To close the Citrix Workspace app, use one of the following methods:
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• From themenu bar, click Citrix Workspace and thenQuit Citrix Workspace,
• From the dock, right click on the Citrix Workspace app and selectQuit from the options,
• Press the Command‑Q keys, or
• From the Quick Access menu, click the Account icon and thenQuit.

Note:

If you don’t close the Citrix Workspace app as per the preceding steps, you might get the
following error message after performing the next step:

The item “Citrix Workspace”can’t be moved to the Trash because it’s open.

2. Drag the Citrix Workspace app from the Application folder to the bin.
Alternatively, you can right‑click the Citrix Workspace app and selectOptions >Move to Bin.

3. Provide your system credentials when prompted.

4. Close all running apps (Citrix Workspace) and click Continue to confirm.
The Citrix Workspace app and all its system files are deleted from your device.

Enhancements on quit menu of Citrix Workspace app Starting with the 2402.10 version, Citrix
Workspace app improves quit functionality andmatcheswith Apple’s Quitmenu behavior. When you
exit the Citrix Workspace app using the quit option, the app no longer runs in the background. With
this feature, you can conserve battery life and optimize system performance.

You can quit Citrix Workspace app by using any of the following methods:

• Quit from themenu bar,
• Quit from the dock,
• Quit from the Quick Access menu, or
• Press the Command‑Q keys.

Using the .dmg file

You can also uninstall Citrix Workspace app for Mac manually by opening the .dmg file. Select Unin‑
stall Citrix Workspace App and follow the on‑screen instructions. The .dmg file is the file that is
downloaded from Citrix when installing Citrix Workspace app for Mac for the first time. If the file is
no longer on your computer, download the file again from Citrix Downloads to uninstall the applica‑
tion.

Using the terminal command

You can uninstall Citrix Workspace app for Mac using the terminal commands.
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To uninstall Citrix Workspace app for Mac:

1. Open the terminal app.

2. Run the following command in the terminal:

1 sudo /Library/Application\ Support/Citrix\ Receiver/Uninstall\
Citrix\ Workspace.app/Contents/MacOS/Uninstall\ Citrix\
Workspace --nogui

2 <!--NeedCopy-->

3. After running the command, Citrix Workspace app and all its system files are deleted from your
device.

Upgrade

Citrix Workspace app for Mac sends you notifications when there is an update available for an exist‑
ing version or an upgrade to a newer version. For more information about automatic updates, see
Automatic update.

You can upgrade Citrix Workspace app for Mac from any of the previous versions of Citrix Workspace
app for Mac. For more information about updating the appmanually, see Manual update.

When you upgrade to a newer version of Citrix Workspace app for Mac, the previous version is unin‑
stalled automatically. You don’t need to restart your machine.

Update

March 21, 2024

Manual update

To manually update the Citrix Workspace app for Mac, download and install the latest version of the
app from the Citrix Downloads page.

Automatic update

When a new version of the Citrix Workspace app releases, Citrix pushes the update on the system that
has the Citrix Workspace app installed. You’re notified of the available update.
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Note:

• If you’ve configured an SSL intercepting outbound proxy, add an exception to the Work‑
space auto‑update serverhttps://downloadplugins.citrix.com/ to receive up‑
dates from Citrix.

• Auto‑update isn’t available for Citrix Workspace app versions earlier than 2301.1. Formore
information, see Knowledge Center article CTX491310.

• Your systemmust have an internet connection to receive updates.
• Workspace for web users can’t download the StoreFront policy automatically.
• Citrix HDX RTME for macOS is included in Citrix Workspace Updates. You’re notified of the
available HDX RTME update on the Citrix Workspace app.

• Starting with Version 2111, Citrix Workspace updates log paths are modified. The Work‑
space updates logs are present at /Library/Logs/Citrix Workspace Updater.
For information about collecting logs, see the Log collection section.

Installing Citrix Workspace app Beta program

You receive anupdate notificationwhen theCitrixWorkspace app is configured for automatic updates.
To install the Beta build on your system, perform the following steps:

1. Open Citrix Workspace app.

2. Right‑click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Beta from the drop‑down list, when the Beta build is available.
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To switch from a Beta build to a Release build, perform the following steps:

1. Open Citrix Workspace app.

2. Right‑click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Release from the Select the update channel drop‑down list.

Note:

Beta builds are available for customers to test in their non‑production or limited production en‑
vironments, and to share feedback. Citrix does not accept support cases for beta builds but wel‑
comes feedback for improving them. Citrixmight ormight not act on feedbackbasedon its sever‑
ity, criticality, and importance. It’s advised that you do not deploy Beta builds in production
environments.

Auto‑update version control

Administrators can nowmanage the auto‑updated version of Citrix Workspace app for the devices in
the organization.
Administrators can control the version by setting the range formaximumAllowedVersion andminimu‑
mAllowedVersion properties in the Global App Configuration service.

Example JSON file in Global App Configuration service:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
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7 ,
8 "settings": {
9

10 "name": "Version Control for Citrix Workspace",
11 "description": "Provides admin ability to Version Control for

Citrix Workspace",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "category": "AutoUpdate",
19 "userOverride": false,
20 "assignedTo": [
21 "AllUsersNoAuthentication"
22 ],
23 "settings": [
24 {
25
26 "name": "Auto update plugins settings",
27 "value": [
28 {
29
30 "pluginName": "Citrix Workspace",
31 "pluginId": "D99C3E77-FBF5-4B97-8EDA-4E381A1E0826",
32 "pluginSettings": {
33
34 "deploymentMode": "Update",
35 "upgradeToLatest": false,
36 "minimumAllowedVersion": "23.07.0.63",
37 "maximumAllowedVersion": "23.07.0.63",
38 "delayGroup": "Medium",
39 "detectRule": ""
40 }
41
42 }
43
44 ]
45 }
46
47 ]
48 }
49
50 ]
51 }
52
53 }
54
55 }
56
57
58 <!--NeedCopy-->
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When the range is set, Citrix Workspace app on the user’s device is automatically updated to the high‑
est available version that falls between the mentioned range.

If you want to auto‑update Citrix Workspace app to a specific version, enter the same version in the
maximumAllowedVersion and minimumAllowedVersion properties in the Global App Configuration
service.

Note:

• To enable auto‑update version control, set the upgradeToLatest setting to false in the
Global App Configuration service. If the upgradeToLatest setting is true, maximumAl‑
lowedVersion andminimumAllowedVersion is ignored.

• Do not modify the pluginId. The pluginID is mapped to Citrix Workspace app.
• If the administrator hasn’t configured the version in the Global App Configuration service,
Citrix Workspace app is updated to the latest available version by default.

• You can only use the version ranges that are set to update Citrix Workspace app. However,
a downgrade isn’t supported.

• This feature is supported from release 2307 onwards.

Improved auto‑update experience

The auto‑update feature automatically updates the CitrixWorkspace app to the latest versionwithout
the need for any user intervention.

Citrix Workspace app periodically checks and downloads the latest available version of the app. Cit‑
rix Workspace app determines the best time to install based on user activity not to cause any disrup‑
tions.

Advanced configuration for automatic updates (Citrix Workspace Updates)

You can configure Citrix Workspace updates using the following methods:

• Graphical user interface (GUI)
• Global App Configuration service (GACS)
• Mobile Device Management (MDM)
• StoreFront

Configure Citrix Workspace automatic updates using the graphical user interface

Individual users can override the Citrix Workspace updates setting using the Advanced preferences
dialog box, which is a per‑user configuration and the settings apply only to the current user. To con‑
figure the update using the GUI, perform the following steps:
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1. Select the Citrix Workspace app helper icon on your Mac.
2. From the drop‑down list, select Preferences > Advanced > Updates.
3. Select the build for which you want to install the automatic updates. It can be either the Apple

Silicon or Intel build (only applicable for users on Mac with Apple silicon (M1 Series).

Configure Citrix Workspace automatic updates using StoreFront

1. Use a text editor to open the web.config file, which is typically in the C:\inetpub\
wwwroot\Citrix\Roaming directory.

2. Locate the user account element in the file (Store is the account name of your deployment).

For example: <account id=... name="Store">

Before the </account> tag, navigate to the properties of that user account:

1 <properties>
2 <clear/>
3 </properties>
4 <!--NeedCopy-->

3. Add the auto‑update tag after the <clear /> tag.

1 <account>
2
3 <clear />
4
5 <account id="d1197d2c-ac82-4f13-9346-2ee14d4b0202" name="

F84Store"
6
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7 description="" published="true" updaterType="Citrix"
remoteAccessType="None">

8
9 <annotatedServices>

10
11 <clear />
12
13 <annotatedServiceRecord serviceRef="1__Citrix_F84Store">
14
15 <metadata>
16
17 <plugins>
18
19 <clear />
20
21 </plugins>
22
23 <trustSettings>
24
25 <clear />
26
27 </trustSettings>
28
29 <properties>
30
31 <property name="Auto-Update-Check" value="Disabled"

/>
32
33 <property name="Auto-Update-DeferUpdate-Count" value

="1" />
34
35 <property name="Auto-Update-Rollout-Priority" value=

"fast" />
36
37 <property name="Auto-Update-Architecture" value="

Universal" or "Intel" />
38
39 </properties>
40
41 </metadata>
42
43 </annotatedServiceRecord>
44
45 </annotatedServices>
46
47 <metadata>
48
49 <plugins>
50
51 <clear />
52
53 </plugins>
54
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55 <trustSettings>
56
57 <clear />
58
59 </trustSettings>
60
61 <properties>
62
63 <clear />
64
65 </properties>
66
67 </metadata>
68
69 </account>
70
71 <!--NeedCopy-->

Themeaning of the properties and their possible values are detailed as follows:

• Auto‑Update‑Check: Indicates that Citrix Workspace app detects an update automatically
when available.

– Auto (default) –Checks and performs updates automatically
– Manual –updates are only fetched when the user makes a check request from the Citrix
Workspace app system tray menu,

– Disabled –Updates checks aren’t performed.

• Auto‑Update‑Rollout‑Priority: Indicates the delivery period in which you can receive the up‑
date.

– Fast –updates are rolled‑out to the users towards the beginning of the delivery period.
– Medium –updates are rolled‑out towards the middle of the delivery period.
– Slow–updates are rolled‑out towards the end of the delivery period.

• Auto‑Update‑DeferUpdate‑Count: Indicates the number of counts that you can defer the no‑
tifications for the updates.

Note:

This configuration is applicable only for interactive updates and not when the silent auto‑
update feature is enabled, as the user doesn’t get any option to defer the updates.

– ‑1: The user can defer the auto‑update any number of times.
– 0: The user can’t view the remindme later option.
– number: The user can view remind later options with the given count.
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Configure Citrix Workspace automatic updates using the GACS

Administrators can use GACS to configure the automatic updates to either Apple Silicon or Intel builds
by using the following settings:

“name”:“autoUpdateArchitecture”

“value”:“Universal”or “Intel”

Configure Citrix Workspace automatic updates using the MDM

Administrators can useMDM to configure the automatic updates to either Apple Silicon or Intel builds
by using the following settings:

<key>AutoUpdateArchitecture</key>

<string>Universal</string> or <string>Intel</string>

<key>AutoUpdateState</key>

<string>Auto</string> or <string>Manual</string> or <string>Disabled
</string>

For more information on how to use MDM, see Mobile Device Management.

Log collection

Log collection simplifies the process of collecting logs for Citrix Workspace app. The logs help Citrix
to troubleshoot, and, in cases of complicated issues, provide support.

You can collect logs using the GUI.

Collecting logs:

1. Open Citrix Workspace app.

2. Right‑click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Logging.
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4. Select one of the following session log levels:

• Disabled (Default): Minimum logs are collected for basic troubleshooting.
• Connection Diagnostics: Identifies errors while connecting. All logging is enabled up un‑
til the point when the session is deemed successful.

• Full: Captures everything including the connection diagnostics. Once enabled, the Citrix
Workspace appwill store up to 10 session logs afterwhich they’re deleted startingwith the
oldest to maintain 10 logs.

Note:

Selecting the Full logging option can impact performance and must be used only while
troubleshooting an issue because of the amount of data. Do not enable full logging during
normal use. Enabling this level of logging triggers a warning dialog that must be acknowl‑
edged for you to continue.

5. Select one of the following store log levels:

• Disabled (Default): Minimum logs are collected for basic troubleshooting.
• Normal: Only store communication logs are collected.
• Verbose: Detailed authentication and store communication logs are collected.

6. Click Email Log Files to collect and share logs as a .zip file.

Enhanced Universal Architecture builds for virtual apps and desktops session

From the 2311 version, the Universal Architecture build can now automatically choose to run the vir‑
tual sessions in the native Apple Silicon mode or Intel mode. It uses the Rosetta emulation to launch
the virtual session in Intel mode. The virtual session launches in the native Apple Siliconmode, if the
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virtual channel SDK is built based on the native Apple Silicon architecture or there’s no virtual chan‑
nel SDK. However, the virtual session launches in the Intel mode using the Rosetta emulation, if the
virtual channel SDK is built based on the x86_64 Intel‑based architecture.

This enhancement to the Universal Architecture build improves the launch experience on Macs with
the Apple Silicon chipset. For users on Macs with the Intel‑based chipset, there is no change, and the
Universal Architecture build continues to run the virtual sessions natively.

Configure Citrix Workspace app

April 10, 2024

You can configure Citrix Workspace app for Mac using Global App Configuration service User Interface
(UI) andMobileDeviceManagement. Settings canbe configured for both cloud (CitrixWorkspace) and
on‑premises (Citrix StoreFront) environments.

For more information, see the following:

• Global App Configuration service

– Configure settings for cloud stores
– Configure settings for on‑premises stores

• Mobile Device Management

USB redirection

HDX USB device redirection enables redirection of USB devices to and from a user device. A user can
connect a flash drive to a local computer and access it remotely from a virtual desktop or a desktop
hosted application. For more information, see USB.

Keyboard layout synchronization

Keyboard layout synchronization enables you to switch between the preferred keyboard layouts on
the client device. This feature is disabled by default. After you enable this feature, the client keyboard
layout automatically synchronizes to the virtual apps and desktops. For more information, see Key‑
board layout synchronization.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 130

https://docs.citrix.com/en-us/citrix-workspace/overview-global-app
https://docs.citrix.com/en-us/citrix-workspace/global-app-config-service/configure-gacs-cloud
https://docs.citrix.com/en-us/citrix-workspace/global-app-config-service/configure-gacs-storefront
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/mobile-device-management.html
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/usb.html
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/keyboard#keyboard-layout-synchronization
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/devices/keyboard#keyboard-layout-synchronization


Citrix Workspace app for Mac

Channel support for Global App Configuration service

TheGlobal AppConfiguration service forCitrixWorkspaceallowsaCitrix administrator todeliverWork‑
space serviceURLs andWorkspaceApp settings througha centrallymanaged service. Global AppCon‑
figuration service now allows administrators to test the settings before rolling it out to all users. This
feature allows to resolve any issues before applying the global app configurations to the entire user
base.

You can achieve the channel support by mapping the settings that you want to test to a channel and
then add the channel in the payload. For more information, see Global App Configuration service
documentation.

Mobile Device Management

March 22, 2024

CitrixWorkspace app now supportsMobile DeviceManagement (MDM) that allows the administrators
to configure, secure, and support CitrixWorkspaceapp forMacbyenforcingpolicies throughanyMDM
tool.

Install and uninstall Citrix Workspace app through the MDM

You can use terminal commands to install and uninstall the Citrix Workspace app through the MDM.
For more information about using the terminal commands to install and uninstall, see the Manual
install and Uninstall section.

To install Citrix Workspace app for Mac:

1. Download the .dmg file for the version of Citrix Workspace app for Mac that you want to install
from the Downloads page.

2. Open the downloaded CitrixWorkspaceApp.dmg file.

3. Drag the Install Citrix Workspace.pkg file into the folder.

4. Use the following terminal command to install the package through MDM:

1 sudo installer -pkg /Volumes/Citrix\ Workspace/Install\ Citrix\
Workspace.pkg -target /

2 <!--NeedCopy-->

To uninstall Citrix Workspace app:

You can use the following terminal command to uninstall the Citrix Workspace app through MDM:
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1 sudo /Library/Application\ Support/Citrix\ Receiver/Uninstall\ Citrix
\ Workspace.app/Contents/MacOS/Uninstall\ Citrix\ Workspace --
nogui

2 <!--NeedCopy-->

Settings supported on MDM

Setting Description Key Value Value type
Default
Value

Supported
version

Select
browser for
FIDO2 web
Authentica‑
tion

Allows
administra‑
tors to
select the
type of
browser
used for
authenticat‑
ing an end
user into
Citrix
Workspace
app. For
more
information
about the
description
of values,
see FIDO2
based
authentica‑
tion when
connecting
to cloud
and on‑
premises
store

WebBrowserForAuthenticationSystem/SystemWithPrivateSession/Embedded/EmbeddedWithPrivateSessionString EmbeddedWithPrivateSession2307
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Setting Description Key Value Value type
Default
Value

Supported
version

Enable/disable
FIDO2
authentica‑
tion for HDX
session

Allows
administra‑
tors to
enable or
disable
FIDO2
authentica‑
tion within
an HDX
session.

Fido2Enabled true/false Boolean true 2307

Quick
access
menu for
StoreFront

Allows
administra‑
tors to
enable or
disable the
Quick
access
menu for
On‑prem
stores.

ShowQuickAccessForStoreFronttrue/false Boolean false 2307

Auto
update –
AutoUpdat‑
eState

Updates
Citrix
Workspace
app to the
latest
version
without any
user inter‑
vention
automati‑
cally.

AutoUpdateStateAuto/Manual/DisabledString Auto 2305
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Setting Description Key Value Value type
Default
Value

Supported
version

Enable
Azure
Active
Directory

Allows
administra‑
tors to
configure
and enforce
Azure
Active
Directory
conditional
access
policies for
users
authenticat‑
ing to Citrix
Workspace
app.

enableAAD true/false Boolean False 2305

Auto start
of Citrix
Workspace
app

Controls
Citrix
Workspace
app for Mac
to start au‑
tomatically
whenever a
computer is
turned on
by an end
user.

AutoLaunchAppOnRestarttrue/false Boolean True 2304
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Setting Description Key Value Value type
Default
Value

Supported
version

Pre‑
configuration
of Store
URL

Allows
administra‑
tors to
preconfig‑
ure and add
the store
details to
the
Workspace
app so that
the end
users don’t
have to do
it.

StoreURLs <Store
URL>

String NA 2210

Block new
Store
addition by
end‑user

Prevents
the end
user from
adding a
store in the
Workspace
app on
their
endpoint
devices.

BlockStoreAdditiontrue/false Boolean False 2210

Show/Hide
menu bar

Shows or
hides the
Citrix
Workspace
menu on
the Mac
menu bar.

ShowHelperInMenuBartrue/false Boolean True 2208.1
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Setting Description Key Value Value type
Default
Value

Supported
version

Auto
update ‑
AutoUpdat‑
eChannel

Allows
administra‑
tors to
ensure
whether a
Citrix
Workspace
app
receives GA
updates or
Beta
updates
when the
auto‑
update is
enabled.

AutoUpdateChannelPROD/EAR String PROD 2201

Schema for reference

1 <array>
2 <dict>
3 <key>ShowHelperInMenuBar</key>
4 <true/>
5 <key>AutoLaunchAppOnRestart</key>
6 <true/>
7 <key>StoreURLs</key>
8 <array>
9 <string>PROVIDE STORE URL HERE</string>

10 </array>
11 <key>BlockStoreAddition</key>
12 <false/>
13 <key>CEIPEnabled</key>
14 <true/>
15 <key>AutoUpdateArchitecture</key>`
16 <string>Universal</string>
17 <key>AutoUpdateState</key>
18 <string>Enable</string>
19 <key>AutoUpdateChannel</key>
20 <string>PROD</string>
21 <key>PayloadDisplayName</key>
22 <string>Citrix Workspace</string>
23 <key>PayloadIdentifier</key>
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24 <string>com.citrix.receiver.nomas</string>
25 <key>PayloadType</key>
26 <string>com.citrix.receiver.nomas</string>
27 <key>PayloadUUID</key>
28 <string>3BE38AD3-7D95-423F-BD7B-8A4D1F5208EF</string>
29 <key>PayloadVersion</key>
30 <integer>1</integer>
31 <key>WebBrowserForAuthentication</key>
32 <string>System</string>
33 <key>Fido2Enabled</key>
34 <false/>
35 <key>ShowQuickAccessForStoreFront</key>
36 <true/>
37 </dict>
38 </array>
39
40 <!--NeedCopy-->

Store configuration

May 6, 2024

Support for store configuration of user devices through MDM tool

Admins can now configure the following settings while deploying Citrix Workspace app through any
MDM deployment tool such as Citrix Endpoint Management:

• StoreURLs –Configure store details so it’s automatically added when the user opens the Citrix
Workspace app, simplifying the sign‑on experience.
To add a store, provide the details for the StoreURLs setting. For example:

<array>

<string>https://myorg.com/?storename</string>

</array>

You can also addmultiple stores as follows:

<array>

<string>https://myorg.com/?storename1</string>

<string>https://myorg.com/?storename2</string>

</array>
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To add the StoreURLs to Citrix Workspace app, the user must quit and relaunch Citrix Workspace
app.

• BlockStoreAddition –Prevent the user from adding stores.

To block the user from adding a store, set the value of the BlockStoreAddition setting to True.

For more information, see Mobile Device Management.

StoreFront to Workspacemigration

As your organization transitions from on‑premises StoreFront to Workspace, users are required to
manually add the new Workspace URL to the Citrix Workspace app. This feature enables admins
to seamlessly migrate users from a StoreFront store to a Workspace store with minimal user inter‑
action.

Consider, all your end users have a StoreFront store storefront.com added to their Workspace
app. As an administrator, you can configure a StoreFront URL to Workspace URL Mapping {‘store‑
front.com’:’xyz.cloud.com’} in the Global App Configuration service. The Global App Configuration
service pushes the setting to all Citrix Workspace app instances, on both managed and unmanaged
devices that have the StoreFront URL storefront.com added.

Once the setting is detected, Citrix Workspace app adds the mapped Workspace URL xyz.cloud.
com as another store. When the end user launches the Citrix Workspace app, the Citrix Workspace
store opens. The previously added StoreFront store storefront.com remains added to the Citrix
Workspace app. Users can always switch back to the StoreFront store storefront.com using the
Switch Accounts option in the Citrix Workspace app. Admins can control the removal of the Store‑
Front store storefront.com from the Citrix Workspace app at the users’end points. The removal
can be done through the global app config service.

To enable the feature, do the following steps:

1. Configure StoreFront to Workspace mapping using the Global App Configuration service. For
more information on the Global App config service, see Global App Configuration service.

2. Edit the payload in the app config service:

1 {
2 "serviceURL": Unknown macro: \{
3 "url" }
4
5 ,
6 "settings":{
7
8 "name":"Productivity Apps", [New Store Name]
9 "description":"Provides access StoreFront to Workspace Migration",

10 "useForAppConfig":true,

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 138

https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/mobile-device-management
https://developer-docs.citrix.com/en-us/server-integration/global-app-configuration-service/getting-started


Citrix Workspace app for Mac

11 "appSettings":
12 {
13 "macos":[ Unknown macro: \{
14 "category" }
15
16 ]
17 }
18
19 }
20
21 }
22
23 <!--NeedCopy-->

Note:

If you’re configuring the payload for the first time, use POST.
If you’re editing the existing payload configuration, use PUT and check that you have the
payload that consists of all the supported settings.

3. Specify the StoreFront URLstorefront.com as the value forURL in the serviceURL section.

4. Configure the Workspace URL xyz.cloud.com inside the sectionmigrationUrl.

5. Use storeFrontValidUntil to set the timeline for the removal of the StoreFront store from the
Citrix Workspace app. This field is optional. You can set the following value based on your re‑
quirement:

• Valid date in the format (YYYY‑MM‑DD)

Note:

If you’ve provided a past date, then the StoreFront store is removed immediately
upon URL migration. If you’ve provided a future date, then the StoreFront store is
removed on the set date.

Once the app config service settings are pushed, the following screen appears:
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When the user clicks Switch to Citrix Workspace now, the Workspace URL is added to Citrix Work‑
space app and the authentication prompt appears. Users have a limited option to delay the transition
up to three times.

Customweb store

Support for customweb stores

Starting with the 2112 version, you can access your organization’s custom web store from the Citrix
Workspace app for Mac. Previously, you accessed all customized stores through the browser only.
To use this feature, the admin must add the custom web store to the list of allowed URLs in the
allowedWebStoreURLs property in the Global App Configuration service.

CitrixWorkspace app forMac loads the customweb storeswith a browser‑like experience and extends
AppProtectioncapabilities to customwebstores. Making thecustomportal accessible fromthenative
Citrix Workspace App provides comprehensive capabilities and user experience for this feature. For
more information about Global App Configuration service, see Getting Started.

To add a customweb store URL, perform the following steps:

1. Open the Citrix Workspace app and navigate to Accounts.
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2. In the Accountswindow, click the + icon and type the URL.

To delete a customweb store URL, perform the following steps:

1. Open the Citrix Workspace app and navigate to Accounts.

2. In the Accountswindow, select the account you want to delete and click the ‑ icon.

Support for customized URLs through 301 redirects

Starting with the 2106 version, you can add URLs that redirect to Citrix Workspace from StoreFront or
Citrix Gateway through HTTP 301 redirects.

If you’remigrating fromStoreFront to CitrixWorkspace, you can redirect the StoreFrontURL to a Citrix
Workspace URL through an HTTP 301 redirect. As a result, when adding an old StoreFront URL, you’
re automatically redirected to Citrix Workspace.

Example of a redirect:

TheStoreFrontURLhttps://< Citrix Storefront url>/Citrix/Roaming/Accounts
can be redirected to a Citrix Workspace URL: https://<Citrix Workspace url>/Citrix/
Roaming/Accounts.

Note:

• Citrix Workspace app for Mac does not support Dual Tone Multi Frequency (DTMF) with Mi‑
crosoft Teams due to pending changes fromMicrosoft.

• From the 2106 release onward, theCitrix Viewer’s versionnumber and theCitrixWorkspace
app’s version number might not match. This change does not affect your experience.

Email‑based auto‑discovery of store

Starting with the 2109 version, You can provide your email address in Citrix Workspace app for Mac
to automatically discover the store associated with the email address. If there are multiple stores
associated with a domain, by default the first store returned by the Global App Configuration service
is added as the store of choice. Users can always switch to another store if necessary.

Sign out of the customweb store when you close Citrix Workspace app

When the signoutCustomWebstoreOnExit setting is set to True, closing the Citrix Workspace app
window signs you out of the custom web store. When you reopen the Citrix Workspace app, the
web store URL is loaded again. You can configure the signoutCustomWebstoreOnExit setting in the
Global App Configuration service.
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Security and Authentication

January 2, 2024

This section describes about the security features and authentication details for CitrixWorkspace app
for Mac.

• Authentication
• Security
• Secure communications

Authenticate

January 19, 2024

Smart card

Citrix Workspace app for Mac supports smart card authentication in the following configurations:

• Smart card authentication to Workspace for Web or StoreFront 3.12 and later.

• Citrix Virtual Apps and Desktops 7 2203 and later.

• XenApp and XenDesktop 7.15 and later.

• Smart card‑enabled applications, such as Microsoft Outlook and Microsoft Office that allow
users to digitally sign or encrypt documents available in virtual desktop or application sessions.

• Citrix Workspace app for Mac supports using multiple certificates with a single smart card or
with multiple smart cards. When your user inserts a smart card into a card reader, the certifi‑
cates are available to all applications running on the device, including Citrix Workspace app for
Mac.

• For double‑hop sessions, a further connection is established between Citrix Workspace app for
Mac and your user’s virtual desktop.

About smart card authentication to Citrix Gateway

There are multiple usable certificates when you use a smart card to authenticate a connection. Citrix
Workspace app for Mac prompts you to select a certificate. After you select a certificate, Citrix Work‑
space app for Mac prompts you to enter the smart card password. Once authenticated, the session
launches.
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If there’s only one suitable certificate on the smart card, Citrix Workspace app for Mac uses that cer‑
tificate and does not prompt you to select it. However, you must still enter the password associated
with the smart card to authenticate the connection and to start the session.

Specifying a PKCS#11module for smart card authentication

Note:

Installing the PKCS#11 module isn’t mandatory. This section only applies to ICA sessions. It
does not apply to Citrix Workspace access to Citrix Gateway or StoreFront where a smart card is
required.

To specify the PKCS#11module for smart card authentication:

1. In Citrix Workspace app for Mac, select Preferences.
2. Click Security & Privacy.
3. In the Security & Privacy section, click Smart Card.
4. In the PKCS#11 field, select the appropriate module. Click Other to browse to the location of

the PKCS#11module if the module you wanted isn’t listed.
5. After selecting the appropriate module, click Add.

Supported readers, middleware, and smart card profiles

CitrixWorkspaceapp forMacsupportsmostmacOS‑compatible smart card readersandcryptographic
middleware. Citrix has validated the operation with the following.

Supported readers:

• Common USB connect smart card readers

Supportedmiddleware:

• Clarify
• ActivIdentity client version
• Charismathics client version

Supported smart cards:

• PIV cards
• Common Access Card (CAC)
• Gemalto .NET cards

Follow the instructions provided by your vendor’s macOS‑compatible smart card reader and crypto‑
graphic middleware for configuring user devices.
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Restrictions

• Certificates must be stored on a smart card, not on the user device.
• Citrix Workspace app for Mac does not save the user certificate choice.
• Citrix Workspace app for Mac does not store or save the user’s smart card PIN. OS handles the
PIN acquisitions, which might have its own caching mechanism.

• Citrix Workspace app for Mac does not reconnect sessions when a smart card is inserted.
• To use VPN tunnels with smart card authentication, you must install the Citrix Gateway Plug‑in
and log on through a webpage. Use your smart cards and PINs to authenticate at each step.
Pass‑through authentication to StoreFront with the Citrix Gateway Plug‑in isn’t available for
smart card users.

Conditional Access with Azure Active Directory

This authentication method is currently not supported on Citrix Workspace app for Mac.

User‑Agent

Citrix Workspace app sends a user agent in network requests that can be used to configure authenti‑
cation policies including redirection of authentication to other Identity Providers (IdPs).

Note:

Don’t mention the version numbers while configuring the policies.

Scenario Description User‑Agent

Regular HTTP Requests
In general, a network request
made by Citrix Workspace app
contains a general User‑Agent.

For example, the following
network requests contain a
general User‑Agent
GET /Citrix/Roaming/Accounts
GET / AGServices/discover

CitrixReceiver
/23.05.0.36 MacOSX
/13.4.0 com.citrix.
receiver.nomas
X1Class CWACapable

Cloud Store When users add a cloud store to
Citrix Workspace app, the
network requests made by
Citrix Workspace app contains
a specific User‑Agent.

For example, network requests
with path
/core/connect/authorize
contains a specific User‑Agent.

Mozilla/5.0 (
Macintosh; Intel Mac
OS X 10_15_7)
AppleWebKit/605.1.15
(KHTML, like Gecko)
Citrix Workspace
/23.05.0.36 MacOSX
/13.4.0 com.citrix.
receiver.nomas
X1Class CWACapable

OnPrem Store with Gateway
Advanced Auth

When users add an
on‑premises store with
Advanced Auth configured on
Gateway to Citrix Workspace
app, the network requests
made by Citrix Workspace app
contains a specific User‑Agent.

For example, network requests
with requests containing
GET /nf/auth/doWebview.do
GET /logon/LogonPoint/tmin‑
dex.html

Mozilla/5.0 (
Macintosh; Intel Mac
OS X 10_15_7)
AppleWebKit/605.1.15
(KHTML, like Gecko),
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Scenario Description User‑Agent

CustomWeb Store When a user adds a custom
web store Citrix Workspace app,
the network requests made by
Citrix Workspace app contains
a specific User‑Agent.

Mozilla/5.0 (
Macintosh; Intel Mac
OS X 10_15_7)
AppleWebKit/605.1.15
(KHTML, like Gecko)
Safari CWA/23.05.0.18
MacOSX/13.4.0

FIDO2 for password‑less authentication

Citrix Workspace app for Mac supports password‑less authentication using FIDO2 security keys when
connecting to a cloud store or within an HDX session. FIDO2 security keys provide a seamless way for
enterprise employees to authenticate to apps or desktops that support FIDO2without entering a user
name or password. This feature currently supports roaming authenticators (USB only) with PIN code
and touchID. This feature is supported onmacOS 12 and later versions.

For more information about FIDO2 see FIDO2 Authentication.

For information about the prerequisites and using this feature, see Local authorization and virtual
authentication using FIDO2.

FIDO2‑based authentication when connecting to cloud and on‑premises store

Citrix Workspace app uses the user’s default browser for FIDO2 authentication (Web Authentication),
when connecting to the cloud and on‑premises stores. Administrators can configure the type of
browser to authenticate to Citrix Workspace app. For more information on the web browser settings,
see Global App Configuration service documentation.

The following settings allow you to select the type of browser that is used for authenticating an end
user into Citrix Workspace app:
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Settings Description

System Allows you to use the user’s default browser for
authentication (for example, Safari or Chrome).
Authentication occurs outside Citrix Workspace
app. Use this setting to support passwordless
authentication. This setting tries to use the
existing user session from the user’s browser.

SystemWithPrivateSession This setting is similar to the System setting.
Citrix Workspace app uses a private session in
the browser for authentication. The browser
doesn’t save authentication cookies or data.
Single sign‑on isn’t supported in this option.

Embedded Allows you to authenticate within Citrix
Workspace app. Citrix Workspace app saves the
session data or cookies for single sign‑on (for
example, SaaS apps) when the enhanced single
sign‑on feature is enabled. This authentication
method does not support passwordless
authentications such as FIDO2.

EmbeddedWithPrivateSession This setting is similar to the Embedded setting.
Single sign‑on isn’t supported as session data or
cookies aren’t present in Citrix Workspace app.

To push the configured settings, run the following commands using the Mobile Device Management
(MDM), Global App Configuration service (GACS), or the command line interface methods:

• Enable FIDO2 using MDM: To enable authentication through MDM, administrators must use
the following setting:

<key>WebBrowserForAuthentication</key><string>System</string>

For more information on how to use MDM, see Mobile Device Management.

• Enable FIDO2 using GACS: To enable authentication through GACS, administrators must use
the following setting:

1 {
2
3 "serviceURL": {
4
5 "url": "https://serviceURL:443"
6 }
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7 ,
8 "settings": {
9

10 "name": "Web browser for Authenticating into Citrix Workspace",
11 "description": "Allows admin to select the type of browser used

for authenticating an end user into Citrix Workspace app",
12 "useForAppConfig": true,
13 "appSettings": {
14
15 "macos": [
16 {
17
18 "assignedTo": [
19 "AllUsersNoAuthentication"
20 ],
21 "category": "authentication",
22 "settings": [
23 {
24
25 "name": "web browser for authentication",
26 "value": "SystemWithPrivateSession"
27 }
28
29 ],
30 "userOverride": false
31 }
32
33 ]
34 }
35
36 }
37
38 }
39
40
41 <!--NeedCopy-->

• Enable FIDO2 using the command‑line interface: To enable authentication using the
command‑line interface, administrators must run the following command:

defaults write com.citrix.receiver.nomas WebBrowserForAuthentication
System

FIDO2‑based authentication within an HDX session

You can configure FIDO2 Security Keys to authenticate within an HDX session. This feature currently
supports roaming authenticators (USB only) with PIN code.

When you access an app or a website that supports FIDO2, a prompt appears, requesting access to
the security key. If you’ve previously registered your security key with a PIN (a minimum of 4 and a
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maximum of 64 characters), then youmust enter the PIN while signing in.

If you’ve registered your security key previously without a PIN, simply touch the security key to sign
in.

This feature is enabled by default for Citrix Workspace app for 2307 and future releases. You can dis‑
able FIDO2 authentication using the Mobile Device Management (MDM) or command‑line interface
methods by running the following commands:

• Disable FIDO2basedauthenticationusingMDM:Todisable this feature throughMDM, admin‑
istrators must use the following setting:

<key>Fido2Enabled</key><false/>

For more information on how to use MDM, see Mobile Device Management.

• Disable FIDO2 based authentication using the command‑line interface: To disable this fea‑
ture, run the following command in command‑line interface methods:

defaults write com.citrix.receiver.nomas Fido2Enabled -bool NO

Support for Certificate‑based authentication

Starting with the 2305 version, Workspace administrators can configure and enforce Azure Active Di‑
rectory conditional access policies for users authenticating to Citrix Workspace app.

The following methods can be used to enable the authentication using conditional access:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

The flag values read by Citrix Workspace app take precedence in the following order:

• Mobile Device Management (MDM)
• Global App Configuration service (GACS)

Enabling authentication using conditional access through MDM

To enable authentication using conditional access with Azure AD through MDM, admins must use the
following setting:

<key>enableAAD</key>
<true/>

This setting supports Boolean values. The value is set to false by default. The default value is consid‑
ered if the key value isn’t available.

For more information on how to use MDM, see Mobile Device Management.
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Enabling authentication using conditional access through GACS

To enable authentication using conditional access with Azure AD through GACS, adminsmust use the
following setting:

enable conditional AAD

For more information, see Supported settings and their values per platform for macOS in the GACS
documentation.

Security

May 3, 2024

App Protection

App Protection feature is an add‑on feature that provides enhanced security when using Citrix Virtual
Apps and Desktops and Citrix DaaS (formerly Citrix Virtual Apps and Desktops service). The feature
restricts the ability of clients to compromise with keylogging and screen capturingmalware. App Pro‑
tection prevents exfiltration of confidential information such as user credentials and sensitive infor‑
mation on the screen. For more information, see App Protection documentation.

Disclaimer

App Protection policies filter the access to required functions of the underlying operating sys‑
tem (specific API calls required to capture screens or keyboard presses). App Protection policies
provide protection even against custom and purpose‑built hacker tools. However, as operating
systems evolve, new ways of capturing screens and logging keys might emerge. While we con‑
tinue to identify and address them, we can’t guarantee full protection in specific configurations
and deployments.

To configure App Protection on Citrix Workspace app for Mac, see the Citrix Workspace app for Mac
section in the Configuration article.

Note:

• App Protection is supported only from Citrix Workspace app 2001 for Mac or later.

App Protection enhancement

Starting with the 2301 version, App Protection is enhanced to protect the Citrix Workspace app. This
enhancement includes protecting the authentication screen and the screen that you see after signing
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into the Workspace app.

Support for screen sharing when App Protection is enabled

Starting with the 2402 version, you can share content through Microsoft Teams with HDX optimiza‑
tion, even when App Protection is enabled. With this feature, you can share a screen in the virtual
desktop session to its full potential. For more information, see Compatibility with HDX optimization
for Microsoft Teams.

Force login prompt for Federated identity provider

CitrixWorkspace app nowhonors the Federated Identity Provider Sessions setting. Formore informa‑
tion, see Citrix Knowledge Center article CTX253779.

You no longer need to use the Store authentication tokens policy to force the login prompt.

Inactivity timeout for Citrix Workspace app

The inactivity timeout feature logsyououtof theCitrixWorkspaceappbasedonavalue that theadmin
sets. Admins can specify the amount of idle time that is allowed before a user is automatically signed
out of the Citrix Workspace app. You’re automatically signed out when no activity from the mouse,
keyboard, or touch occurs for the specified interval of time, within the Citrix Workspace app window.
The inactivity timeout does not affect the already running Citrix Virtual Apps and Desktops and Citrix
DaaS sessions or the Citrix StoreFront stores.

The inactivity timeout value can be set starting from 1minute to 1440minutes. By default, the inactiv‑
ity timeout isn’t configured. Admins can configure the inactivityTimeoutInMinutes property by using
a PowerShell module. Click here to download the PowerShell modules for Citrix Workspace Configu‑
ration.

The end‑user experience is as follows:

• A notification appears three minutes before you’re signed out, with an option to stay signed in,
or sign out. The notification appears if you’ve enabled CitrixWorkspace app notifications in the
system preferences of your Mac.

• Thenotification appears only if the configured inactivity timeout value is greater than5minutes.
For example, if the configured value is 6 minutes, a notification appears when 3 minutes of in‑
activity is detected. If the configured inactivity timeout value is less than or equal to 5 minutes,
the user is signed out without a notification.

• Users can click Stay signed in to dismiss the notification and continue using the app, in which
case the inactivity timer is reset to its configured value. You can also click Sign‑out to end the
session for the current store.
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Secure communications

January 19, 2024

To secure the communication between your Site and Citrix Workspace app for Mac, you can integrate
your connections with a range of security technologies, including Citrix Gateway. For information
about configuring Citrix Gateway with Citrix StoreFront, see
StoreFront documentation.

Note:

Citrix recommends using Citrix Gateway to secure communications between StoreFront servers
and users’devices.

• A SOCKS proxy server or secure proxy server (also known as security proxy server, HTTPS proxy
server). You can use proxy servers to limit access to and from your network and to handle con‑
nections between Citrix Workspace and servers. Citrix Workspace app for Mac supports SOCKS
and secure proxy protocols.

• Citrix Secure Web Gateway. You can use Citrix Secure Web Gateway to provide a single, secure,
encrypted point of access through the internet to servers on internal corporate networks.

• SSL Relay solutions with Transport Layer Security (TLS) protocols
• A firewall. Network firewalls can allow or block packets based on the destination address and
port. If you use a firewall that maps the server’s internal IP address to an external internet ad‑
dress such as network address translation (NAT), configure the external address.

Note:

StartingwithmacOSCatalina, Apple has enforced extra requirements for root CA certificates and
intermediate certificates which administrators must configure. For more information, see Apple
Support article HT210176.

Citrix Gateway

To enable remote users to connect to your XenMobile deployment through Citrix Gateway, you can
configure Citrix Gateway to support StoreFront. The method for enabling access depends on the edi‑
tion of XenMobile in your deployment.

If you deploy XenMobile in your network, allow connections from internal or remote users to Store‑
Front through Citrix Gateway, by integrating Citrix Gateway with StoreFront. This deployment allows
users to connect to StoreFront to access published applications from XenApp and virtual desktops
from XenDesktop. Users connect through Citrix Workspace app for Mac.
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Connecting with the Citrix Secure Web Gateway

If the Citrix Secure Web Gateway Proxy is installed on a server in the secure network, you can use the
Citrix SecureWebGatewayProxy inRelaymode. Formore informationaboutRelaymode, see XenApp
and Citrix Secure Web Gateway documentation.

If you’re using Relay mode, the Citrix Secure Web Gateway server functions as a proxy and you must
configure Citrix Workspace app for Mac to use:

• The fully qualified domain name (FQDN) of the Citrix Secure Web Gateway server.
• The port number of the Citrix Secure Web Gateway server. Citrix Secure Web Gateway Version
2.0 does not support Relay mode.

The FQDNmust list, in sequence, the following three components:

• Host name
• Intermediate domain
• Top‑level domain

For example, my_computer.example.com is an FQDN, because it lists, in sequence, a host name
(my_computer), an intermediate domain (example), and a top‑level domain (com). The combination
of intermediate and top‑level domain (example.com) is referred to as the domain name.

Connecting through a proxy server

Proxy servers are used to limit access to and from your network, and to handle connections between
Citrix Workspace app for Mac and servers. Citrix Workspace app for Mac supports both SOCKS and
secure proxy protocols.

When the Citrix Workspace app for Mac communicates with the Web server, it uses the proxy server
settings configured for thedefaultwebbrowseron theuserdevice. Configure theproxy server settings
for the default Web browser on the user device accordingly.

Connecting through a firewall

Network firewalls can allow or block packets based on the destination address and port. Citrix Work‑
space app for Mac must be able to communicate through the firewall with both the Web server and
Citrix server. The firewall must permit HTTP traffic (often over the standard HTTP port 80 or 443 for a
secureWeb server) for user device toWeb server communication. For CitrixWorkspace to Citrix server
communication, the firewall must permit inbound ICA traffic on ports 1494 and 2598.
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TLS

Transport Layer Security (TLS) is the latest, standardized version of the TLS protocol. The Internet
Engineering Taskforce (IETF) renamed it TLS when it took over responsibility for the development of
TLS as an open standard.

TLS secures data communications by providing server authentication, encryption of the data stream,
andmessage integrity checks. Some organizations, including U.S. government organizations, require
the use of TLS to secure data communications. These organizations might also require the use of
validated cryptography, such as Federal Information Processing Standard (FIPS) 140. FIPS 140 is a
standard for cryptography.

Citrix Workspace app for Mac supports RSA keys of 1024, 2048, and 3072‑bit lengths. Root certificates
with RSA keys of 4096‑bit length are also supported.

Note:

Citrix Workspace app for Mac uses platform (OS X) crypto for connections between Citrix Work‑
space app for Mac and StoreFront.

The following cipher suites are deprecated for enhanced security:

• Cipher suites with prefix “TLS_RSA_*”
• Cipher suites RC4 and 3DES
• TLS_RSA_WITH_AES_256_GCM_SHA384 (0x009d)
• TLS_RSA_WITH_AES_128_GCM_SHA256 (0x009c)
• TLS_RSA_WITH_AES_256_CBC_SHA256 (0x003d)
• TLS_RSA_WITH_AES_256_CBC_SHA (0x0035)
• TLS_RSA_WITH_AES_128_CBC_SHA (0x002f)
• TLS_RSA_WITH_RC4_128_SHA (0x0005)
• TLS_RSA_WITH_3DES_EDE_CBC_SHA (0x000a)

Citrix Workspace app for Mac supports only the following cipher suites:

• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 (0xc030)
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 (0xc028)
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA (0xc013)

For DTLS 1.0 users, Citrix Workspace app for Mac 1910 and later supports only the following cipher
suite:

• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA (0xc013)

Upgrade your Citrix Gateway version to 12.1 or later if you want to use DTLS 1.0. Otherwise, it falls
back to TLS based on the DDC policy.
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The following matrices provide details of internal and external network connections:

Note:

• Use Citrix Gateway 12.1 or later for EDT to work properly. Older versions do not support
ECDHE cipher suites in DTLSmode.

• CitrixGatewaydoesn’t supportDTLS1.2. So,TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
and TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 aren’t supported. Citrix Gate‑
way must be configured to use TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA to work
properly in DTLS 1.0.

Configuring and enabling Citrix Workspace app for TLS

There are twomain steps involved in setting up TLS:
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1. Set up SSLRelay on your Citrix Virtual Apps andDesktops andCitrix DaaS (formerly Citrix Virtual
Apps and Desktops service) server. Then, obtain and install the necessary server certificate.

2. Install the equivalent root certificate on the user device.

Installing root certificates on user devices

To use TLS to secure communications between TLS‑enabled Citrix Workspace app for Mac and the
server farm, you need a root certificate on the user device. This root certificate verifies the signature
of the Certificate Authority on the server certificate.

macOS X comes with about 100 commercial root certificates already installed. However, if you want
to use another certificate, you can obtain one from the Certificate Authority and install it on each user
device.

Install the root certificate on each device, depending on your organization’s policies and procedures,
instead of prompting users to install it. The easiest and safest way is to add root certificates to the
macOS X keychain.

To add a root certificate to the keychain

1. Double‑click the file containing the certificate. This action automatically starts the Keychain
Access application.

2. In the Add Certificates dialog box, choose one of the following from the Keychain pop‑upmenu:

• login (The certificate applies only to the current user.)
• System (The certificate applies to all users of a device.)

3. Click OK.
4. Type your password in the Authenticate dialog box and then click OK.

The root certificate is installed and used by TLS‑enabled clients and by any other application using
TLS.

About TLS policies

This section provides information for configuring security policies for ICA sessions over TLS. You can
configure certainTLSsettingsused for ICAconnections inCitrixWorkspaceapp forMac. These settings
are not exposed in the user interface. Changing them requires running a command on the device
running Citrix Workspace app for Mac.
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Note:

TLS policies are managed in other ways ‑ by devices controlled by an OS X server or another
mobile device management solution.

TLS policies include the following settings:

SecurityComplianceMode. Sets the security compliance mode for the policy. If you don’t config‑
ure SecurityComplianceMode, FIPS is used as the default value. Applicable values for this setting in‑
clude:

• None. No compliance mode is enforced
• FIPS. FIPS cryptographic modules are used
• SP800‑52. NIST SP800‑52r1 compliance is enforced

defaults write com.citrix.receiver.nomas SecurityComplianceMode SP800
-52

SecurityAllowedTLSVersions. Specifies the TLS protocol versions that are accepted during protocol
negotiation. This information is represented as an array and any combination of the possible values
is supported. When this setting isn’t configured, the values TLS10, TLS11, and TLS12 are used as the
default values. Applicable values for this setting include:

• TLS10. Specifies that the TLS 1.0 protocol is allowed.
• TLS11. Specifies that the TLS 1.1 protocol is allowed.
• TLS12. Specifies that the TLS 1.2 protocol is allowed.
• TLS13. Specifies that the TLS 1.3 protocol is allowed.

defaults write com.citrix.receiver.nomas SecurityAllowedTLSVersions -
array TLS11 TLS12

SSLCertificateRevocationCheckPolicy. Improves the cryptographic authentication of the Citrix
server and improves the overall security of the SSL/TLS connections between a client and a server.
This setting governs the handling of a trusted root certificate authority (CA) while opening a remote
session through SSL when using the client for OS X.

When you enable this setting, the client checks whether the server’s certificate is revoked. There are
several levels of certificate revocation list checking. For example, the client canbeconfigured to check
only its local certificate list, or to check the local and network certificate lists. In addition, certificate
checking canbe configured to allowusers to log ononly if all Certificate Revocation lists are verified.

Certificate Revocation List (CRL) checking is an advanced feature supported by some certificate is‑
suers. It allows admins to revoke security certificates (invalidated before their expiry date) if there is
cryptographic compromise of certificate private keys, or unexpected changes in the DNS name.

Applicable values for this setting include:
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• NoCheck. No Certificate Revocation List check is performed.
• CheckWithNoNetworkAccess. Certificate revocation list check is performed. Only local cer‑
tificate revocation list stores are used. All distribution points are ignored. Finding a Certificate
Revocation List isn’t critical for verification of the server certificate that presented by the target
SSL Relay or Citrix Secure Web Gateway server.

• FullAccessCheck. Certificate Revocation List check is performed. Local Certificate Revocation
List stores and all distribution points are used. Finding a Certificate Revocation List isn’t critical
for verification of the server certificate presented by the target SSL Relay or Citrix Secure Web
Gateway server.

• FullAccessCheckAndCRLRequired. Certificate Revocation List check is performed, excluding
the root Certificate Authority. Local Certificate Revocation List stores and all distribution points
are used. Finding all required Certificate Revocation Lists is critical for verification.

• FullAccessCheckAndCRLRequiredAll. Certificate Revocation List check is performed, includ‑
ing the root certificate authority. Local Certificate Revocation List stores and all distribution
points are used. Finding all required Certificate Revocation Lists is critical for verification.

Note:

If you don’t set SSLCertificateRevocationCheckPolicy, FullAccessCheck is used as the default
value.
defaults write com.citrix.receiver.nomas SSLCertificateRevocationCheckPolicy
FullAccessCheckAndCRLRequired

Configuring TLS policies

To configure TLS settings on an unmanaged computer, run the defaults command in Terminal.app.

defaults is a command line application that you can use to add, edit, and delete app settings in anOS
X preferences list file.

To change settings:

1. Open Applications > Utilities \ > Terminal.

2. In Terminal, run the command:

defaults write com.citrix.receiver.nomas <name> <type> <value>

Where:

<name>: The name of the setting as described earlier.

<type>: A switch identifying the type of the setting, either ‑string or ‑array. If the setting type is a
string, this setting can be omitted.
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<value>: The value for the setting. If the value is an array and multiple values need to be specified,
separate the values with a space.

defaults write com.citrix.receiver.nomas SecurityAllowedTLSVersions -
array TLS11 TLS12

Reverting to the default configuration

To reset a setting back to its default:

1. Open Applications > Utilities \ > Terminal.

2. In Terminal, run the command:

defaults delete com.citrix.receiver.nomas <name>

Where:

<name>: The name of the setting as described earlier.

defaults delete com.citrix.receiver.nomas SecurityAllowedTLSVersions

Security settings

Security improvements and enhancements were introducedwith Citrix Receiver for Mac version 12.3,
including the following:

• improved security configuration user interface. In previous releases, the command linewas the
preferred method to make security‑related changes. Configuration settings related to session
security are now simple and accessible from the UI. This improvement improves the user expe‑
rience while creating a seamless method for the adoption of security‑related preferences.

• view TLS connections. You can verify connections that use a specific TLS version, encryption
algorithms,mode, key size, andSecureICAstatus. Inaddition, youcanviewtheserver certificate
for TLS connections.

The improved Security and Privacy screen includes the following new options in the TLS tab:

• set the compliance mode
• configure the crypto module
• select the appropriate TLS version
• select the certificate revocation list
• enable settings for all TLS connections
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The following image illustrates the Security and Privacy settings accessible from the UI:

App experience

January 11, 2024

This section describes the following:

• Application delivery
• Enhanced virtual apps and desktops launch experience for Workspace (Cloud users only)
• App preferences
• Data collection andmonitoring

Application delivery

April 10, 2024
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When delivering applications with Citrix Virtual Apps and Desktops and Citrix DaaS, consider the fol‑
lowing options to enhance the experience for your users when they access their applications:

Web access mode

Without any configuration, Citrix Workspace app for Mac provides web access mode: browser‑based
access to applications and desktops. Users simply open a browser to aWorkspace for Web and select
and use the applications that they want. In web access mode, no app shortcuts are placed in the App
Folder on your user’s device.

Self‑servicemode

AddaStoreFront account toCitrixWorkspace app forMacor configureCitrixWorkspace app forMac to
point to a StoreFront site. Then, you can configure the self‑servicemode, which enables your users to
subscribe toapplications throughCitrixWorkspaceapp forMac. This enhanceduser experience is sim‑
ilar to that of amobile app store. In self‑servicemodeyoucan configuremandatory, auto‑provisioned,
and featured app keyword settings as needed. When one of your users selects an application, a short‑
cut to that application is placed in the App Folder on the user device.

When they access a StoreFront 3.0 site, your users see the Citrix Workspace app for Mac preview.

When publishing applications on your Citrix Virtual Apps farms, you can enhance the experience for
users accessing those applications through StoreFront stores. Ensure that you includemeaningful de‑
scriptions for the published apps. The descriptions are visible to your users through Citrix Workspace
app for Mac.

Configure self‑servicemode

Asmentioned previously, you can add a StoreFront account to Citrix Workspace app for Mac or config‑
ure CitrixWorkspace app forMac to point to a StoreFront site. Thus, you can configure the self‑service
mode, which allows users to subscribe to applications from the Citrix Workspace app for Mac user
interface. This enhanced user experience is similar to that of a mobile app store.

In self‑service mode, you can configure mandatory, auto‑provisioned, and featured app keyword set‑
tings as needed.

• Automatically subscribe all store users to an app by appending the string ‘KEYWORDS:Auto’to
the app description when publishing it in Citrix Virtual Apps. The app is provisioned automati‑
cally without requiring a manual subscription when users log in to the store.

• Advertise applications to users or make commonly used applications easier to find by listing
them in the Citrix Workspace app for Mac Featured list. To list apps in the Mac Featured list,
append the string **KEYWORDS:Featured** to the app description.
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For more information, see StoreFront documentation.

Enhanced virtual apps and desktops launch experience for Workspace
(Cloud users only)

April 11, 2024

The opening experience of Citrix resources has been enhanced to bemore intuitive, informative, and
user‑friendly. From the 2311 version, this feature is supported for custom web stores and hybrid
launch.

The launch progress notification now appears at the lower‑right corner of your screen. A progress
status of the resources, which are in the process of being opened is shown. You cannot retrieve the
notification once you dismiss it. The notification stays for a few seconds from the time you start the
session. If the session fails to start, then the notification shows the failure message.
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Note:

This feature is available for both Workspace (cloud) and StoreFront sessions.

App preferences

January 11, 2024

Opened apps appear in the dock with native app icons

Previously, clicking virtual apps in the Citrix Workspace app triggered the Citrix Viewerwhere these
apps would be available. If you open many apps, the apps or its instances are opened in the Citrix
Viewer. You can view the open apps by right‑clicking the Citrix Viewer icon.
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Starting with the 2305 version, when you open virtual apps, they appear in the Dock (bottom‑right
corner of the screen) with their respective icons and are easily identifiable. You can then access the
virtual app from the dock itself. If you open multiple instances of an app, these instances aren’t du‑
plicates in the Dock but are grouped within one instance in the Dock.

Improved Mission Control and App Expose experience

Previously, using theMission Control or App Expose feature in a virtual app session resulted in the
overlapping of many windows that were opened.
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Starting with the 2210 version, when you use theMission Control or App Expose feature in a virtual
app session and open many windows, the windows do not overlap, and you can easily choose from
among them.
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Enhancedmenu bar support

Starting with the 2301 version, the CWA fully supports the Automatically hide and show the menu
bar in full screen option inmacOS. For versions earlier thanmacOS 13, youmust navigate to System
Preferences > Dock & Menu Bar and clear the Automatically hide and show the menu bar in full
screenoption. FormacOS13and later versions, youmustnavigate toSystemPreferences>Desktop
& Dock and clear the Automatically hide and show the menu bar in full screen option. You have
theprovision to either enable or disable this option. This enhancement also supports highDPI scaling.
The mouse position also appears accurate in all the external monitors connected.

The following figure illustrates a windowwhere the menu bar is hidden:

The following figure illustrates a windowwhere the menu bar appears:
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Support for horizontal scroll

Previously, Citrix Workspace app for Mac supported only vertical scroll on a trackpad. Starting with
the 2305 version, a horizontal scroll is also supported.

Enhanced auto start experience

Previously, CitrixWorkspaceapp forMacused to start automaticallywhenever a computerwas turned
on. Startingwith the 2304 version, you can choose to disable or enable the auto start feature on Citrix
Workspace app forMac by navigating toPreferences >General > StartWorkspaceon systemstartup.
The auto start setting is enabled by default.
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Workspace Control

Workspace Control lets desktops and applications follow users as they move between devices. For
example, clinicians in hospitals to move from workstation to workstation without having to restart
their desktops and applications on each device.

Policies and client drive mappings change appropriately when you move to a new user device. Poli‑
cies and mappings are applied according to the user device where you’re currently logged on to the
session. For example, a healthcareworker can sign out fromadevice in the emergency roomand sign‑
in to a workstation in the X‑ray laboratory. The policies, printer mappings, and client drive mappings
appropriate for the session in the X‑ray laboratory go into effect for the session in the X‑ray labora‑
tory.

To configure workspace Control settings

1. Click the down arrow icon in the Citrix Workspace app for Mac window and choose Prefer‑
ences.

2. Click the General tab.
3. Choose one of the following:

• Reconnect apps when I start Citrix Workspace app. Allows users to reconnect to discon‑
nected apps when they start Citrix Workspace app.

• Reconnect apps when I start or refresh apps. Allows users to reconnect to disconnected
apps either when they start apps or when they select Refresh Apps from the Citrix Work‑
space app for Mac menu.

View apps, desktops, and Citrix Enterprise Browser from themenu bar through a
quick access menu

You can now view your most recently used or favorite apps and desktops or open a Citrix Enterprise
Browser window by clicking the Citrix Workspace icon in the menu bar. This feature provides easy
access to some of your resources without having to open the Citrix Workspace app.
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If you’ve not configured any accounts, a sign‑in prompt appears.

A maximum of 5 of your recently used or favorite apps or desktops appear in the options under the
RecentandFavorites tabs respectively. Toview theotherapps in theCitrixWorkspaceapp, clickView
all applications. To view the other desktops in the Citrix Workspace app, click View all desktops.
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You can open the Citrix Workspace UI by clicking the Citrix Workspace app icon.

You can open the Citrix Enterprise Browser, without opening a web or SaaS app by clicking the Citrix
Enterprise Browser icon.

Note:

TheCitrix Enterprise Browser isn’t available if the configured store doesn’t have anywebor SaaS
apps. Further, it’s available only if your admin has configured Citrix Secure Private Access.
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You can view the following options when you click the Account icon in the top‑right corner:

• Preferences
• Check for updates
• About
• Quit
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Quick access menu for StoreFront

Starting with the 2307 version, you can navigate to your favorite apps and desktops quickly and eas‑
ily using the quick access feature for on‑premises stores. To enable quick access, right‑click Citrix
Workspace in the toolbar, navigate to Preferences > General, and then select Show Quick Access
for Storefront experience. This feature allows you to see your favorite data directly from the Mac
menu bar.

You can enable the quick access feature by using Preferences.

Administrators canenable or disable thequick access featurebyusing theMobileDeviceManagement
(MDM) or Global App Configuration service (GACS) methods.

Enabling or disabling quick access using MDM

To enable quick access through MDM, administrators must use the following settings:

<key>ShowQuickAccessForStoreFront</key>
<false/>

For more information on how to use MDM, see Mobile Device Management.

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 173

https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/mobile-device-management.html


Citrix Workspace app for Mac

Enabling or disabling quick access using GACS

To enable quick access through GACS, administrators must use the following settings:

enableQuickAccessForStoreFront

Battery status indicator

The battery status of the device now appears in the notification area of a Citrix Desktop session.
To view the battery status within the desktop session, click the Show hidden icons arrow in the
taskbar.

Note:

The battery status indicator does not appear for server VDAs.

Citrix Casting

Citrix Casting is used to cast your Mac screen to nearby Citrix Ready workspace hub devices. Citrix
Workspace app forMac supports Citrix Casting tomirror yourMac screen toworkspacehub connected
monitors.

For more information, see the Citrix Ready workspace hub documentation.

Prerequisites

• Latest supported version of Citrix Workspace app.
• Bluetooth enabled on the device for hub discovery.
• Both Citrix Ready workspace hub and Citrix Workspace appmust be on the same network.
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• Ensure Port 55555 isn’t blockedbetween thedevice runningCitrixWorkspace app and theCitrix
Ready workspace hub.

• Port 55556 is the default port for SSL connections betweenmobile devices and the Citrix Ready
workspace hub. You can configure a different SSL port on the Raspberry Pi’s settings page. If
the SSL port is blocked, users can’t establish SSL connections to the workspace hub.

• For Citrix Casting, ensure port 1494 isn’t blocked.

Enable Citrix Casting

Citrix Casting is disabled by default. To enable Citrix Casting using Citrix Workspace app for Mac:

1. Go to Preferences.
2. Select Advanced in the panel and then choose Citrix Casting.
3. Select Yes, enable casting.

A notification appears when Citrix Casting is launched and a Citrix Casting icon appears in the menu
bar.

Note:

After enabling, Citrix Casting launches with Citrix Workspace app for Mac automatically every
time until you disable it by selecting No, don’t enable casting in Preferences > Advanced >
Citrix Casting.

Discover workspace hub devices automatically

To connect to workspace hubs automatically:
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1. On your Mac, sign in to Citrix Workspace app and ensure that Bluetooth is turned on. Bluetooth
is used to discover nearby workspace hubs.

2. Select theCitrix Casting icon in themenu bar. All Citrix Casting functions are operated through
this menu.

3. TheHub List submenu shows all nearby workspace hubs on the same network. Hubs are listed
in descending order by their proximity to your Mac and display their workspace hub configured
names. All automatically discovered hubs display under Nearby Hubs.

4. Choose the hub that you want to connect to by selecting its name.

To cancel selection of a workspace hub during connection, select Cancel. You can also use Cancel if
the network connection is poor and connecting is taking longer than usual.

Note:

Occasionally, your chosen hub might not appear in the menu. Check the Hub Listmenu again
after a few moments or add your hub manually. Citrix Casting receives the workspace hub’s
broadcasting periodically.

Discover workspace hub devices manually

If you can’t find the Citrix Readyworkspace hub device in theHubListmenu, add theworkspace hub’
s IP address to access it manually. To add a workspace hub:

1. On your Mac, sign in to Citrix Workspace app and ensure that Bluetooth is turned on. Bluetooth
is used to discover nearby workspace hubs.

2. Select the Citrix Casting icon in the menu bar.
3. SelectManage in the menu. TheManage hubswindow appears.
4. Click Add new to enter the IP address of your hub.
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5. After successfully adding the device, the Hub name column displays the hub’s friendly name.
Use this name to identify the hub in theManual section of theHub List submenu.

Note:

Currently, only Mirror mode is supported. Mirror is the only available choice in the Display
Mode column.

Disconnect the workspace hub device

You can disconnect your current session and exit the Citrix Ready workspace hub automatically or
manually.

• To disconnect the screen casting session automatically, close your laptop.

• To disconnect the screen casting session manually:

1. Select the Citrix Casting icon.
2. In the list of hubs, select the name of your workspace hub. The Disconnect option appears to

the right.
3. Select Disconnect to exit the hub.

Known issues

• There are small latency issues when viewing the mirrored screen. In poor network conditions,
latency might be even longer.

• When SSL is enabled in a Citrix Ready workspace hub and the hub’s certificate isn’t trusted, an
alert window appears. To solve the issue, add the certificate to your trusted certificate list with
the Keychain tool.
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Data collection andmonitoring

March 28, 2024

Citrix Analytics

Citrix Workspace app is instrumented to securely transmit logs to Citrix Analytics. The logs are ana‑
lyzed and stored on Citrix Analytics servers when enabled. For more information about Citrix Analyt‑
ics, see Citrix Analytics.

Customer Experience Improvement Program (CEIP)

Data Collected Description What we Use it for

Configuration and usage data The Citrix Customer Experience
Improvement Program (CEIP)
gathers configuration and
usage data from Citrix
Workspace app for Mac and
automatically sends the data to
Citrix and Google Analytics.

This data helps Citrix improve
the quality, reliability, and
performance of Citrix
Workspace app.

Data collected

As noted above, Citrix collects CitrixWorkspace app configuration andusagedata to improve thequal‑
ity, functionality, and performance of Citrix Workspace app, and to allow Citrix to appropriately allo‑
cate resources for product development purposes, as well as to maintain service levels and manage
staffing and infrastructure investment. The data is used and analyzed in aggregated form only. No
user or their machine is singled‑out and no analysis is performed on specific end users based on the
CEIP data.

The specific CEIP data elements collected by Google Analytics and Citrix Analytics are:

Operating System
Version

Workspace app version Generic USB
Redirection Usage

Store configuration
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Citrix Enterprise
Browser Usage

Citrix Virtual Apps and
Desktops Session
Launch Status

Auto‑update
preference

Auto‑update Status

Session launch
method

Uninstall information Inactivity Timeout
Feature Usage

Email Discovery
Feature Usage

CustomWeb Store
Feature Usage

Reconnection
preferences

Global App
Configuration service
Usage

Restore Keyboard
Usage

Delete Password
Feature Usage

Auto‑update channel Connection Lease
Details

USER GUID

Note:

• No data is collected and sent to Google Analytics fromusers located in the European Union
(EU), European Economic Area (EEA), Switzerland, and the United Kingdom (UK).

• Citrix Enterprise Browser was formerly known as Citrix Workspace Browser.

To disable sending CEIP data to Citrix and Google Analytics, perform the following steps:

1. On the Preferenceswindow, select Security and Privacy.
2. Click the Privacy tab.
3. SelectNo, Thanks to disable CEIP or to forego participation.
4. ClickOK.
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Alternatively, you can disable CEIP by running the terminal command:

defaults write com.citrix.receiver.nomas "CEIPEnabled"-bool NO

Additional Information

Citrix handles your data in accordance with the terms of your contract with Citrix. Your data is pro‑
tected, according to the Citrix Services Security Exhibit available at the Citrix Trust Center.

Citrix uses Google Analytics to collect certain data from Citrix Workspace app as part of CEIP. Review
how Google handles data collected for Google Analytics.

HDX andmultimedia

January 25, 2024
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This section describes about the HDX andmultimedia features for the following components:

• Graphics and Display
• Optimized Microsoft Teams
• HDX transport

Graphics and display

May 23, 2024

Multiple monitors

You can set Citrix Workspace app for Mac to work in full‑screenmode across multiple monitors.

1. Open the Citrix Viewer.
2. From the menu bar, click View and select one of the following options, based on your require‑

ment:

• Enter Full Screen ‑ Full screen on the primary monitor only.
• Use All Displays In Full Screen ‑ Full screen on all connectedmonitors.

3. Drag the Citrix Virtual Desktops screen between the monitors.

The screen is now extended to all monitors.

Limitations

• Full‑screen mode is only supported on one monitor or all monitors, which are configurable
through amenu item.

• Citrix recommends using amaximumof 2monitors. Usingmore than 2monitorsmight degrade
session performance or cause usability issues.

• Full screenmode isn’t available on Macs with a notch.

Support for high DPI

Citrix Workspace app for Mac is now compatible with one high DPI monitor with 4K or 5K resolution.
With this feature, the text, images, and other graphical elements on virtual desktop or app sessions
appear in a size that can be viewed comfortably on these high‑resolution monitors.

To enable this feature, navigate to Preferences > General > High DPI.
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Administrators can edit the Displaymemory limit policy, which specifies themaximum video buffer
size in kilobytes for a desktop session, to suit the display resolution. The default value for theDisplay
memory Limit policy is 65536 KB and is sufficient for one high DPI monitor with 4K resolution.

For virtual app sessions, the default value of Display memory Limit is sufficient as the app session
doesn’t support more than one display.

For virtual desktop sessions, administratorsmustnavigate toCitrixStudio>Policies>Displaymem‑
ory limit and use a higher value, for example 393216 KB to use High DPI features for more than one
external monitor or 5K resolution monitor.

For more information about the Display memory limit policy, see Display memory limit.

Note:

This feature works with a maximum of two connectedmonitors.

The number of external monitors you can use with yourmac is always limited by the Macmodel,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see
Connect one or more external displays with your Mac in the Apple support article.

Enhanced notch screen support

Startingwith the 2301 version, CitrixWorkspace app forMac supportsMacswith a notchdisplay. Macs
support a native notch screen in full screen mode for retina and multi‑monitor displays. The area of
the session in notch screen is nowmuch bigger and provides the customers with more screen space.
This enhancement also supports highDPI scaling. Themouse position also appears accurate in all the
external monitors connected.

Note:

Ensure not to select the Scale to fit below built‑in camera option in the Citrix Viewer. This
option isn’t selected by default and can be found only on Macs with notch display.
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Desktop toolbar

Users can now access the Desktop Toolbar in both windowed and full‑screen mode. Previously, the
toolbar was only visible in full‑screenmode. Other toolbar changes include:

• The Home button has been removed from the toolbar. This function can be run by using the
following commands:

– Cmd‑Tab to switch to the previous active application.
– Ctrl‑Left Arrow to switch to the previous Space.
– Using the built‑in trackpad or Magic Mouse gestures to switch to a different Space.
– Moving the cursor to the edge of the screen while in full‑screen mode displays a Dock
where you can choose which applications to make active.

• The Windowed button has been removed from the toolbar. Follow one of these methods to
switch from full‑screenmode to windowedmode:

– On OS X 10.10, click the green window button on the drop‑downmenu bar.
– On OS X 10.9, click the blue menu button on the drop‑downmenu bar.
– On all versions of OS X, select Exit Full Screen from the View menu of the drop‑down
menu bar.

• Support to drag between windows in full screen with multiple monitors.

Hide or show the desktop tool bar in the virtual desktop session

You can customize to hide or show the desktop tool bar completely in the virtual desktop session.

Formore informationabouthiding thedesktop toolbar completely, see theCTX202450 support article
in the knowledge center.

Extendmultiple monitors in full‑screenmode

Starting with the 2203.1 version, you can enter full‑screenmode on two or more monitors simultane‑
ously. To use this feature, perform the following steps:

1. Open the Citrix Viewer.

2. To use full‑screen mode on the other connected monitors, drag the window from your primary
monitor to span into the connected monitors. From the menu bar, select View > Enter Full
Screen. The window goes into full screenmode on those monitors.
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Note:

If you have previously selected the Use All Displays In Full Screen option, ensure to uns‑
elect it as this selection extends full screen on all connectedmonitors.

Citrix recommends using a maximum of 3 monitors, including the primary monitor.

Support to open Citrix Workspace app inmaximizedmode

Starting with the 2204 version, admins can configure the maximise workspace window prop‑
erty in the Global App Configuration service to enable the Citrix Workspace app to open in the maxi‑
mizedmodebydefault. Formore informationabout theGlobal AppConfiguration service, seeGetting
Started.

Support for extendingmultiple monitors in full‑screenmode on up to fivemonitors

Previously, Citrix supported amaximum of threemonitors in full‑screenmode, including the primary
monitor.

Starting with the 2311 version, you can now use full‑screen mode on up to five monitors, including
the primary monitor, at the same time.

Note

The number of external monitors you can use with yourmac is always limited by the Macmodel,
as well as the resolution and refresh rate of each display. Refer to the technical specifications
of your Mac to find out the supported number of external monitors. For more information, see
Connect one or more external displays with your Mac in the Apple support article.

You can extendmultiple monitors in full‑screenmode in the following two ways:

• Using themenu bar

1. Open the Citrix Viewer.

2. From themenu bar, click View and select Enter Full Screen to extend full screen.

Note:

Youcanextend the screen to full‑screenmode inall connecteddisplays at oncebyenabling
UseAll Displays In Full Screen and then selectingEnter Full Screen from theViewmenu.

• Using the green button in the appwindow

1. Open the Citrix Viewer.
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2. Drag or resize the Citrix Viewer window tomake it spread on themonitors that you want to use
in full‑screenmode.

3. Move the pointer to the green button in the upper‑left corner of the window, then select Enter
Full Screen from themenu that appears or click the green button. The screen is now extended
to monitors that have an intersection with the window.

Admins can edit the Display memory limit policy, which specifies the maximum video buffer size
in kilobytes for a desktop session, to suit the display resolution. The default value for the Display
memory Limit policy is 65536 KB and is sufficient only for up to 2x4Kmonitors (2x32400KB). Admins
must increase this value to use fivemonitors basedon thedisplay resolution. You can edit theDisplay
memory Limit by navigating to Citrix Studio > Policies > Displaymemory limit. For more informa‑
tion about the Display memory limit policy, see the Display memory limit section in the XenApp and
XenDesktop documentation.

Improved graphics performance

Starting with the 2308 version, the performance of graphics is improved for seamless app sessions.
This feature also optimizes the load on CPU usage.

Support for H.265 video decoding

Startingwith the 2402 version, CitrixWorkspace app forMac supports theuseof theH.265 video codec
(HEVC) for hardware acceleration of remote graphics and videos. The h.265 video codec (HEVC) sup‑
ports YUV 4:2:0 color space by default. H.265 video codecmust be supported and enabled on both the
VDAandCitrixWorkspaceapp. If yourMacdevicedoesn’t supportH.265decodingusing theVideoTool‑
box interface, then the H.265 decoding for graphics policy setting is ignored and the session falls back
to the H.264 video codec.

Prerequisites

• VDA 7.16 or later using the following GPUs:

– NVIDIA Maxwell generation GPU or later
– Intel 6th generation GPU or later
– AMD Raven generation GPU or later

• Enable theOptimize for 3D graphics workload policy on the VDA.
• Enable theUse hardware encoding for video codec policy on the VDA.

On Citrix Workspace app for Mac, this feature is set to be enabled by default.
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To disable this feature through Mobile Device Management (MDM), administrators must use the fol‑
lowing settings:

<key>EnableXdecoderForH265</key><false/>

Restart the session for the changes to take effect.

Note:

Run the HDX Monitor 3.x tool to identify if the H.265 video encoder is enabled within the ses‑
sion. For more information about the HDX Monitor 3.x tool, see the Knowledge Center article
CTX135817.

Optimized Microsoft Teams

January 19, 2024

Configuring a preferred network interface

Starting with the 2304 version, you can configure a preferred network interface for media traffic. Run
the following command in the terminal:

defaults write com.citrix.HdxRtcEngine NetworkPreference -int <value>

Select one of the following values as required:

• 1: Ethernet
• 2: Wi‑Fi
• 3: Cellular
• 4: VPN
• 5: Loopback
• 6: Any

By default and if no value is set, the WebRTCmedia engine chooses the best available route.

Encoder performance estimator

TheHdxRtcEngine.exe is theWebRTCmedia engine embedded in Citrix Workspace app that han‑
dles Microsoft Teams redirection. The HdxRtcEngine.exe can estimate the best encoding resolu‑
tion that the endpoint’s CPU can sustain without overloading. Possible values are 240p, 360p, 480p,
720p, and 1080p.
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The performance estimation process usesmacroblock code to determine the best resolution that can
be achieved with the particular endpoint. The Codec negotiation includes the highest possible res‑
olution. The Codec negotiation can be between the peers, or between the peer and the conference
server.

There are four performance categories for endpoints that have its own maximum available resolu‑
tion:

Endpoint performance Maximum resolution Registry key value

Fast 1080p (1920x1080 16:9 @ 30
fps)

3

Medium 720p (1280x720 16:9 @ 30 fps) 2

Slow 360p (640x360 16:9 @ 30 fps or
640x480 4:3 @ 30 fps)

1

Very slow 240p (320x180 16:9 @ 30 fps or
320x240 4:3 @ 30 fps)

0

To set the video encoding resolution value to 360p, run the following command from the terminal:

defaults write com.citrix.HdxRtcEngine OverridePerformance -int 1

For more information about Microsoft Teams optimization, see Optimization for Microsoft Teams.

Improved experience for optimized Microsoft Teams video conference calls

Startingwith the 2304 version, by default simulcast support is enabled for optimizedMicrosoft Teams
videoconferencecalls. With this support, every call is adjusted to theproper resolution for theoptimal
call experience. This feature enhances the quality and experience of video conference calls across
various endpoints.

With this improvedexperience, eachusermight delivermultiple video streams indifferent resolutions
(for example, 720p, 360p, and so on). The video resolution depends on several factors including end‑
point capability, network conditions, and so on. The receiving endpoint then requests the maximum
quality resolution that it can handle and giving all users the optimum video experience.

Note:

This feature is available only after the roll‑out of an update from Microsoft Teams. For informa‑
tion on ETA, go to https://www.microsoft.com/ and search for theMicrosoft 365 roadmap. When
the update is rolled‑out by Microsoft, you can check CTX253754 for the documentation update
and the announcement.
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Limiting video resolutions

Administrators who have users on lower‑performance client endpoints can choose to limit incoming
or outgoing video resolutions to decrease the impact of encoding and decoding video on those end‑
points. Starting from Citrix Workspace app 2304 for Mac, you can limit these resolutions using client
configuration options.

Note:

Users running with restricted resolutions impact the overall video quality of the conference be‑
cause the Microsoft Teams server is forced to use the lowest‑common‑denominator resolution
for all conference participants.

Call constraints are disabled by default on the client with Citrix Workspace app 2304. To enable, ad‑
ministrators must set the following client‑side configurations with the defaults command:

defaults write com.citrix.HdxRtcEngine <Name> -<Type> <Value>

Name Type Mandatory Accepted values

EnableSimulcast int YES 1–3 (set it to 1)

MaxOutgoingResolution int YES 180, 240, 360, 540, 720,
1080 (Microsoft Teams
supported
Resolutions)

MaxIncomingResolution int YES 180, 240, 360, 540, 720,
1080 (Microsoft Teams
supported
Resolutions)

MaxIncomingStreams int YES 1–8

MaxSimulcastLayers int YES 1–3 (set it to 1)

MaxVideoFrameRate int NO 1–30

MaxScreenShareFrameRateint NO 1–15

Background blurring and replacement for Citrix Optimized Microsoft Teams

Starting with the 2301 version, Citrix Optimized Microsoft Teams in Citrix Workspace app for Mac now
supports background blurring and background replacement. You can use this feature by selecting
More > Apply Background Effectswhen you are in a meeting or a P2P call.
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Enhancement to sleepmode for optimized Microsoft Teams call

Previously, when you are in an optimized Microsoft Teams meeting, if there’s no mouse or keyboard
interaction, Citrix Workspace app or the optimizedMicrosoft Teams screenmight go to sleepmode.

Starting with the 2305 version, Citrix Workspace app or the optimized Microsoft Teams screen doesn’
t go to sleep mode even if there’s no mouse or keyboard interaction during an optimized Microsoft
Teamsmeeting.

Screen sharing optimization with Microsoft Teams

Starting with the 2012 version, Citrix Workspace app for Mac supports screen sharing optimization
with Microsoft Teams. For more information, see the following:

• Optimization for Microsoft Teams
• Microsoft Teams redirection

Microsoft Teams optimization support for seamless app sessions

Starting with the 2101 version, Citrix Workspace app for Mac now supports Microsoft Teams optimiza‑
tion for seamless app sessions. As a result, you can launch Microsoft Teams as an application from
within the Citrix Workspace app. For more information, see the following:

• Optimization for Microsoft Teams
• Microsoft Teams redirection

Support for Dual Tone Multi Frequency (DTMF) with Microsoft Teams

Starting with the 2101 version, Citrix Workspace app for Mac supports Dual Tone Multi Frequency
(DTMF) signaling interaction with telephony systems (for example, PSTN) and conference calls in Mi‑
crosoft Teams. This feature is enabled by default.

Enhancements in Desktop Viewer

When theDesktop Viewer is in full screenmode, the user can select one from all the screens covered
by theDesktopViewer to share. In thewindowmode, theuser can share theDesktopViewerwindow.
In the seamless mode, the user can select one screen from the screens connected to the endpoint
device.
When the Desktop Viewer changes the window mode (maximize, restore, or minimize), the screen
sharing stops.
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When the user wants to share the screen, previews for all available screens appear in the screen shar‑
ing panel. Making it intuitive for users to select the right one from the previews.

Support for H.264 Advanced Video Coding (MPEG‑4 AVC) with Microsoft Teams

Starting with the 2109 version, Citrix Workspace app for Mac supports hardware accelerated H.264
video encoding or decoding. It reduces the load on CPU usage and improves your video conferencing
experience. Themultimedia engine of Citrix HDX optimizedMicrosoft Teams (HdxRtcEngine.exe) now
uses Apple’s Video Toolbox framework for encoding and decoding. This framework compresses and
decompresses video faster and in real time. Also, the offloading of encoding and decoding to the GPU
is optimized. Hardware‑accelerated video decoding and encoding are enabled by default if a device
supports it. This enhancement reduces the load on the CPU duringmultimedia usagewhenMicrosoft
Teams is optimized with HDX.

Dynamic e911

StartingWith the2112version, CitrixWorkspaceappsupportsdynamicemergency calling. Whenused
in Microsoft Calling Plans, Operator Connect, and Direct Routing, it allows you to do the following:

• Configure and route emergency calls.

• Notify security personnel.

Notification is provided based on the current location of the CitrixWorkspace app running on the end‑
point. It is not sent basedon theMicrosoftTeams client that runs on the VDA. RayBaum’s law requires
the 911 caller’s dispatchable location to be transmitted to the appropriate Public Safety Answering
Point (PSAP). Starting from Citrix Workspace app 2112.1 for Windows, Microsoft Teams Optimization
with HDX is compliant with Ray Baum’s law. Formore information about this feature, see Support for
dynamic e911 in the sectionMicrosoft Phone System.

Request control in Microsoft Teams

Starting with the 2112 version, you can request control during a Microsoft Teams call when a partici‑
pant is sharing the screen. Once you have control, you can make selections, edits, or other modifica‑
tions to the shared screen.

To take control when a screen is being shared, clickRequest control at the top of theMicrosoft Teams
screen. Themeetingparticipantwho’s sharing the screencaneitherallowordenyyour request. When
you’re done, click Release control.

Limitation:
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The Request Control option isn’t available during peer‑to‑peer calls between an optimized user and
a user on the nativeMicrosoft Teams desktop client that is running on the endpoint. As aworkaround,
users can join a meeting to get the Request Control option.

Give or take control in Microsoft Teams

Starting with the 2203.1 version, you can use the Give control button to give control of your shared
screen to other users participating in the meeting. The other participants can make selections and
modify the shared screen through keyboard, mouse, and clipboard input. You both now have the
control of the shared screen and you can take back the control anytime.

To take control during screen sharing sessions, any participant can request control access through the
Request control button. The person sharing the screen can then approve or deny the request. When
youhave the control, you can control the keyboard andmouse input on the screen shared and release
the control to stop sharing control.

Note:

This feature is available only after the roll‑out of a future update fromMicrosoft Teams.

Multi‑window chat andmeetings for Microsoft Teams

Starting with the 2203.1 version, you can use multiple windows for chat and meetings in Microsoft
Teams (1.5.00.5967 or higher) when optimized by HDX in Citrix Virtual Apps and Desktops and Citrix
DaaS. Users can pop out their conversations or meetings in various ways. For details on the pop‑out
window feature, seeMicrosoftTeamsPop‑OutWindows for Chats andMeetings on theMicrosoftOffice
365 site.

If you’re running an older version of Citrix Workspace App or VDA, Microsoft can deprecate the single‑
window code in the future. However, you have a minimum of nine months to upgrade to a version of
the VDA/CWA that supports multiple windows (2203 or later).

Note:

This feature is available only after the roll‑out of a future update fromMicrosoft Teams. Gotmore
details, see the Microsoft 365 roadmap.

Share apps using the ‘Share content’feature in Microsoft Teams

Starting with the 2203.1 version, you can share individual applications, windows, or full screen using
the screen sharing feature in Microsoft Teams. Citrix Virtual Delivery Agent 2109 is a prerequisite for
this feature.
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Toshowaspecific application, clickSharecontent in yourmeetingcontrols andselect theapplication
of interest. After a red border appears around the app you select, peers on the call can see your app.
If you minimize the app, Microsoft Teams displays the last image from the shared app. Maximize the
window to resume sharing.

Enhancements to Optimized Microsoft Teams

In optimized Microsoft Teams, you can now use the video function when more than one virtual desk‑
top or app session is in use.

App Protection compatibility with HDX optimization for Microsoft Teams

Starting with the 2204 version, full monitor or desktop sharing is disabled when App Protection is
enabled for the delivery group. When you click Share content in Microsoft Teams, the screen picker
removes the Desktop option. You can only select the Window option to share any open app, if the
VDA is 2109 or higher. If you’re connected to VDA older than 2019, no content is selectable.

Deprecation announcement of the SDP format (Plan B) fromWebRTC

Citrix is planning todeprecate the currentSDP format (PlanB) support fromWebRTC in future releases.
YoumustuseaversionofCitrixWorkspaceapp that supports theUnifiedPlan tocontinueusingcertain
optimized Microsoft Teams functionalities.

HDX transport

May 23, 2024

Enlightened Data Transport (EDT)

By default, EDT is enabled in Citrix Workspace app for Mac.

Citrix Workspace app for Mac reads the EDT settings as set in the default.ica file and applies it.

To disable EDT, run the following command in a terminal:

defaults write com.citrix.receiver.nomas HDXOverUDPAllowed -bool NO
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Maximum Transmission Unit (MTU) discovery in Enlightened Data Transport (EDT)

Starting with the 2108 version, Citrix Workspace app for Mac supports Maximum Transmission Unit
(MTU) discovery in Enlightened Data Transport (EDT). It increases the reliability and compatibility of
the EDT protocol and provides an improved user experience.

Note:

EDT MTU discovery is supported onmacOS Big Sur and later.

Improved network congestion control

Startingwith the2308 version, theCitrix‑proprietary transport protocol calledEnlightenedDataTrans‑
port (EDT) is improved to efficiently control network congestion. This feature improves data through‑
put and reduces latency.

Upgraded HDX Reducer to Version 4

Previously, Citrix Workspace app for Mac supported HDX Reducer V3. Starting with the 2402 version,
Citrix Workspace app for Mac supports HDX Reducer V4. This feature reduces the network bandwidth
required for a typical session and improves response time.

Devices

January 2, 2024

This section describes about the features supports for the following devices:

• Audio and Microphone
• Client drive‑mapping
• Keyboard
• Printing
• USB
• Webcam

Audio and Microphone

May 3, 2024
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Adaptive audio

You don’t need to configure the audio quality policies on the VDA with the Adaptive audio feature.
Adaptive audio optimizes settings for your environment and replaces legacy audio compression for‑
mats to provide an excellent user experience. For more information, see Adaptive Audio.

Improved audio echo cancellation support

CitrixWorkspace app supports echo cancellation in adaptive audio and legacy audio codecs. This fea‑
ture is designed for real‑timeaudiouse cases, and it improves theuser experience. Citrix recommends
using adaptive audio.

Client‑sidemicrophone input

Citrix Workspace app for Mac supports multiple client‑side microphone inputs. You can use locally
installed microphones for:

• Live events, such as softphone calls and Web conferences.
• Hosted recording applications, such as dictation programs.
• Video and audio recordings.

Digital dictation support is available with Citrix Workspace app for Mac.

You can choose how to use your microphone and webcamwith the virtual app and desktop sessions.
To apply access type to yourmicrophone andwebcam, select any of the following access types as per
your requirement on theMic &Webcam tab in the Preferences settings:

• Usemymicrophoneandwebcam ‑ Provides access tomicrophone andwebcamwhen it’s con‑
nected.

• Dont usemymicrophone andwebcam ‑ No access to microphone and webcam.
• Ask me each time ‑ Request permission each time when microphone and webcam access is
required.

To apply a background blur effect when using the webcam, select Turn on background blur effect
when using webcam.

Support for multiple audio devices

Starting with the 2311 release, Citrix Workspace app for Mac displays all available local audio devices
in a session with their names. In addition, plug‑and‑play is also supported.
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Store‑based configuration of microphone andwebcam access

Starting with the 2307 version, the microphone and webcam access per store are included as part of
the client‑selective trust feature. This enhancement allows you to provide access to a microphone
and webcam on a per store basis.

To enablemicrophone andwebcamaccess for a store, youmust selectPreferences >Mic &Webcam.
In theMic &Webcam tab, select the store and the type of access required for that store.

Support for audio volume synchronization

Previously, audio volume control is independent between the Virtual Delivery Agent (VDA) and your
device. You’ve to adjust the volume on both sides to maintain the desired volume. Also, if you’ve
muted the volume in your device, then it restricts to unmute the volume in the VDA.

Starting with the 2402 version, Citrix Workspace app for Mac supports synchronization of audio vol‑
ume between the VDA and your audio devices. You can now tune the volume using the VDA audio
volume slider and have the same volume on your device and the other way around. By default, this
feature is enabled.

To enable this feature, you need to use VDA version 2308 or later. For more information, see audio
volume synchronization in the Citrix Virtual Apps and Desktops documentation.

To disable this feature through Mobile Device Management (MDM), administrators must use the fol‑
lowing settings:

<key>EnableVolumeSync</key><false/>

Restart the session for the changes to take effect.

Loss tolerant mode for audio

Starting with the 2402 version, Citrix Workspace app supports loss tolerant mode (EDT lossy) for au‑
dio redirection. This feature improves the user experience for real‑time streaming when users are
connecting through networks with high latency and packet loss. By default, this feature is enabled.

To enable this feature, you need to use VDA version 2311 or later. For more information, see Support
for audio over loss‑tolerantmode (Preview) in the Citrix Virtual Apps and Desktops documentation.

To disable this feature through Mobile Device Management (MDM), administrators must use the fol‑
lowing settings:

<key>EdtUnreliableAllowed</key><false/>

Restart the session for the changes to take effect.
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Client drivemapping

January 19, 2024

During the session, Client drive mapping allows you to access local drives on the user hardware de‑
vice. The user hardware devices can be CD‑ROMdrives, DVDs, and USBmemory sticks. When a server
configurationallows client drivemapping, you canaccess locally stored files andworkon themduring
sessions. You can also save them either on a local drive or on a drive on the server.

Citrix Workspace app for Mac monitors the directories in which user hardware devices are typically
mounted on the user device. It can automatically map any new ones that appear during a session to
the next available drive letter on the server.

You can configure the level of read andwrite access formapped drives using the CitrixWorkspace app
for Mac preferences.

To configure read andwrite access for mapped drives

1. On the Citrix Workspace app for Mac home page, click the down arrow icon , and then click
Preferences.

2. Click File Access.
3. Select the level of read and write access for mapped drives from the following options:

• Read and Write
• Read only
• No access
• Ask me each time

4. Log off from any open sessions and reconnect to apply the changes.

Keyboard

May 3, 2024

Keyboard layout synchronization

Keyboard layout synchronization enables you to switch between the preferred keyboard layouts on
the client device. This feature is disabled by default. After you enable this feature, the client keyboard
layout automatically synchronizes to the virtual apps and desktops.
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To enable keyboard layout synchronization, go to Preferences > Keyboard and select “Use local key‑
board layout, rather than the remote server keyboard layout.”

Note:

1. Using the local keyboard layout option activates the client IME (InputMethodEditor). Users
working in Japanese, Chinese, orKoreancanuse the server IME. Theymustdisable the local
keyboard layout option by clearing the option inPreferences >Keyboard. The sessionwill
revert to the keyboard layout provided by the remote server when they connect to the next
session.

2. The feature works in the session only when the toggle in the client is turned on and the
corresponding feature enabled on the VDA. A menu item,”Use Client Keyboard Layout,”
in Devices > Keyboard > International is added to show the enabled state.

Starting with version 2210, Citrix Workspace app for Mac supports three different keyboard layout
synchronization modes:

• Sync only once ‑ when session starts –Based on the CTXIME value in the Config file, the
client keyboard layout is synchronized to the server when the session launches. Any changes
you make to the client keyboard layout during the session do not take effect immediately. To
apply the changes, sign out and sign in to the app. The Sync only once ‑ when session starts
mode is the default keyboard layout for the Citrix Workspace app on Mac.

• Allow dynamic sync ‑ This option synchronizes the client keyboard layout to the server when
you change the client keyboard layout.

• Don’t sync ‑ Indicates that the client uses the keyboard layout present on the server.

Prerequisites

• Enable the Unicode Keyboard Layout Mapping feature on the Windows VDA. For more informa‑
tion, see Knowledge Center article CTX226335.

• Enable the Dynamic Keyboard layout sync feature on the Linux VDA. For more information, see
Dynamic keyboard layout synchronization.

• WhenusingWindowsServer2016orWindowsServer2019, navigate to theHKEY_LOCAL_MACHINE\Software\Citrix\ICA\IcaIme
registry path and add a DWORD value with the key name DisableKeyboardSync and set the
value to 0.

Configure keyboard layout

CitrixWorkspace app forMac provides theUI to configure the three different keyboard layout synchro‑
nization modes.
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To configure keyboard layout synchronization using the GUI:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top‑right cor‑
ner and navigate to Preferences > Keyboard.

The Keyboard layout synchronization settings appear.

2. Select from one of the following options:

• Sync only once ‑ when session starts ‑ Indicates that the keyboard layout is synced to the
VDA only once at the session launch. Unicode keyboard input mode is the recommended
option for the Sync only once –when the session starts

• Allow dynamic sync ‑ Indicates that the keyboard layout is synced dynamically to the
VDA when the client keyboard is changed in a session. Unicode keyboard input mode is
the recommended option for the Allow dynamic sync mode.

• Don’t sync ‑ Indicates that the client uses the keyboard layout present on the server, ir‑
respective of the keyboard layout that is selected in the client. Scancode keyboard input
mode is the recommended option forDon’t sync. Youmustmake sure that the client key‑
board layout is the same as the keyboard layout on the VDA if you select Unicode for the
Don’t Sync option.

Limitations

• Using the keyboard layouts listed in “Supported Keyboard Layouts in Mac”works while using
this feature. Whenyouchange theclient keyboard layout toanon‑compatible layout, the layout
might be synced on the VDA side, but functionality can’t be confirmed.

• Remote apps that run with elevated privileges can’t be synchronized with the client keyboard
layout. To work around this issue, manually change the keyboard layout on the VDA or disable
UAC.

• When a user is working within an RDP session, it’s not possible to change the keyboard layout
using theAlt + Shift shortcutswhenRDP is deployed as an app. As aworkaround, you can
use the language bar in the RDP session to switch the keyboard layout.

Keyboard layout support for Windows VDA

Language on Mac Input Source on Mac Applicable Mac OS version

English ABC All

English ABC ‑ India All
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Language on Mac Input Source on Mac Applicable Mac OS version

English U.S. All

English U.S. International ‑ PC All

English Dvorak All

English Dvorak ‑ Left‑Handed All

English Dvorak ‑ Right‑Handed All

English British All

English British ‑ PC All

English Canadian English All

English Australian All

English Irish All

French French All

French French ‑ Numerical All

French Canadian French ‑ CSA 11, 12

French Canadian –CSA 13

French Swiss French All

French French ‑ PC All

German German All

German Austrian All

German Swiss German All

Spanish Spanish All

Spanish Spanish ‑ ISO 10,11

Spanish Spanish –Legacy 12,13

Spanish Latin American All

Swedish Swedish All

Swedish Swedish –Legacy 12,13

Swedish Swedish ‑ Pro 10, 11

Czech Czech All

Danish Danish All

Finnish Finnish All
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Language on Mac Input Source on Mac Applicable Mac OS version

Hungarian Hungarian All

Italian Italian All

Italian Italian ‑ Typewriter 10,11

Italian Italian –QZERTY 12,13

Greek Greek All

Dutch Belgian All

Dutch Dutch All

Russian Russian All

Russian Russian ‑ PC All

Croatian Croatian ‑ PC All

Slovak Slovak All

Slovak Slovak ‑ QWERTY All

Turkish Turkish F All

Turkish Turkish Q All

Portuguese Brazilian All

Portuguese Brazilian ‑ ABNT2 All

Portuguese Brazilian –Legacy 12,13

Portuguese Brazilian ‑ Pro 10,11

Portuguese Portuguese All

Ukrainian Ukrainian ‑ PC 10,11

Ukrainian Ukrainian 12,13

Belarusian Belarusian All

Slovenian Slovenian All

Estonian Estonian All

Latvian Latvian All

Polish Polish ‑ Pro 10,11

Polish Polish 12,13

Icelandic Icelandic All

Norwegian Norwegian All
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Language on Mac Input Source on Mac Applicable Mac OS version

Japanese Katakana All

Japanese Half‑width Katakana All

Japanese Romaji All

Japanese Full‑width Romaji All

Japanese Hiragana All

Japanese Alphanumeric (Google) All

Japanese Hiragana (Google) All

Japanese Katakana (Google) All

Japanese Half‑width Katakana (Google) All

Japanese Full‑width Alphanumeric
(Google)

All

Korean 2‑Set Korean All

Chinese, Simplified Pinyin ‑ Simplified All

Chinese, Simplified Sogou pinyin All

Chinese, Traditional Pinyin ‑ Traditional All

Chinese, Traditional Cangjie ‑ Traditional All

Chinese, Traditional Zhuyin ‑ Traditional All

Chinese, Traditional Sucheng ‑ Traditional All

Keyboard layout support for Linux VDA, Swiss French

Language on Mac Input Source on Mac Applicable Mac OS version

English ABC All

English ABC ‑ India All

English U.S. All

English U.S. International ‑ PC All

English Dvorak All

English Dvorak ‑ Left‑Handed All

English Dvorak ‑ Right‑Handed All
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Language on Mac Input Source on Mac Applicable Mac OS version

English British All

English British ‑ PC All

English Canadian English All

English Australian All

English Irish All

French French All

French French ‑ Numerical All

French Canadian French ‑ CSA 11, 12

French Canadian –CSA 13

French Swiss French All

French French ‑ PC All

German German All

German Austrian All

German Swiss German All

Spanish Spanish All

Spanish Spanish ‑ ISO 10,11

Spanish Spanish –Legacy 12,13

Spanish Latin American All

Bulgarian Bulgarian 10,11,12

Bulgarian Bulgarian –Standard 13

Swedish Swedish All

Swedish Swedish –Legacy 12,13

Swedish Swedish ‑ Pro 10, 11

Czech Czech All

Danish Danish All

Finnish Finnish All

Hungarian Hungarian All

Italian Italian All

Italian Italian ‑ Typewriter 10,11
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Language on Mac Input Source on Mac Applicable Mac OS version

Italian Italian –QZERTY 12,13

Greek Greek All

Belgian Belgian All

Dutch Dutch All

Romanian Romanian ‑ Standard All

Russian Russian All

Russian Russian ‑ PC All

Croatian Croatian ‑ PC All

Slovak Slovak All

Slovak Slovak ‑ QWERTY All

Turkish Turkish F All

Turkish Turkish Q All

Portuguese Brazilian All

Portuguese Brazilian ‑ ABNT2 All

Portuguese Brazilian –Legacy 12,13

Portuguese Brazilian ‑ Pro 10,11

Portuguese Portuguese All

Ukrainian Ukrainian ‑ PC 10,11

Ukrainian Ukrainian 12,13

Belarusian Belarusian All

Slovenian Slovenian All

Estonian Estonian All

Polish Polish ‑ Pro 10,11

Polish Polish 12,13

Icelandic Icelandic All

Norwegian Norwegian All

Japanese Katakana All

Japanese Half‑width Katakana All

Japanese Romaji All
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Language on Mac Input Source on Mac Applicable Mac OS version

Japanese Full‑width Romaji All

Japanese Hiragana All

Japanese Alphanumeric (Google) All

Japanese Hiragana (Google) All

Japanese Katakana (Google) All

Japanese Half‑width Katakana (Google) All

Japanese Full‑width Alphanumeric
(Google)

All

Korean 2‑Set Korean All

Chinese, Simplified Pinyin ‑ Simplified All

Chinese, Simplified Sogou pinyin All

Chinese, Traditional Pinyin ‑ Traditional All

Chinese, Traditional Cangjie ‑ Traditional All

Chinese, Traditional Zhuyin ‑ Traditional All

Chinese, Traditional Sucheng ‑ Traditional All

By default, the keyboard layout synchronization feature is turned on. To control this feature alone,
open the Config file in the ~/Library/Application Support/Citrix Receiver/ folder, locate the “En‑
ableIMEEnhancement”setting and turn the feature on or off by setting the value to “true”or “false,”
respectively.

Note:

The setting change takes effect after restarting the session.

Keyboard input mode enhancements

Citrix Workspace app for Mac provides the UI to configure the keyboard input mode.

To configure keyboard input mode by using the GUI, do the following:

1. From the Citrix Workspace app icon in the menu bar, click the account icon in the top‑right cor‑
ner and navigate to Preferences > Keyboard.

The Keyboard input mode settings appear

2. Select from one of the following options:
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• Scancode –Sends thekeyposition fromtheclient‑sidekeyboard toVDAandVDAgenerates
the corresponding character. Applies server‑side keyboard layout.

• Unicode ‑ Sends the key from the client‑side keyboard to VDA and VDAgenerates the same
character in VDA. Applies client‑side keyboard layout.

This enhancement is enabled by default.

For example, consider a scenario where you’re using a US international keyboard layout and the VDA
is using theRussian keyboard layout. When you chooseScancode and type the key next toCaps Lock,
the scancode “1E”is sent to theVDA. TheVDA thenuses “1E”todisplay the character “ф”. If youchoose
Unicode and type the key next to Caps Lock, the character “a”is sent to the VDA. So, even if the VDA
uses the Russian keyboard layout, the character “a”appears on the screen.

Citrix recommends the following keyboard input mode for the different keyboard layout sync op‑
tions:

• Scancodemode for Don’t Sync option.

• Unicodemode for Allow dynamic sync and Sync only once ‑ when session starts

Note:

The keyboard configuration changes take effect once you reconnect to the application.

You can change the configuration of Keyboard input mode in the Citrix Workspace app UI. However,
for best performance, use the Citrix‑recommendedmodes for different scenarios, physical keyboards,
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and client devices.

Language bar

You can choose to show or hide the remote language bar in an application session using the GUI. The
language bar displays the preferred input language in a session. In earlier releases, youmight change
this settingusingonly the registry keyson theVDA.StartingwithCitrixWorkspace forMacversion1808,
you can change the settings using the Preferences dialog. The language bar appears in a session by
default.

Note:

This feature is available in sessions running on VDA 7.17 and later.

Configure showing or hiding the remote language bar

1. Open Preferences.
2. Click Keyboard.
3. Click or unclick Show the remote language bar for the published applications.

Note:

The setting changes take effect immediately. You can change the settings in an active session.
The remote language bar does not appear in a session if there’s only one input language.

Support synchronization for more keyboard layouts

Starting with the 2304 version, Citrix Workspace app for Mac supports keyboard layout synchroniza‑
tion for the following layouts or Input Method Editors (IMEs):

• English ABC
• English ABC ‑ India
• Chinese, Traditional: Zhuyin ‑ Traditional
• Chinese, Traditional: Sucheng ‑ Traditional
• Google Japanese IME
• Sougou Chinese IME

Support for non‑English‑language Input Method Editors (IME) keyboard layouts

Support for non‑English language IME keyboard layouts continues to work uninterrupted after the
Carbon APIs are deprecated with the Cocoa APIs.
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Windows special keys

CitrixWorkspace app forMac provides several options and easier ways to substitute special keys such
as function keys in Windows applications with Mac keys. Use the Keyboard tab to configure the op‑
tions you want to use, as follows:

• Send Control character using: Lets you choose whether to send Command‑character key‑
stroke combinations as Ctrl+character key combinations in a session. Select “Commandor Con‑
trol”from the pop‑up menu to send familiar Command‑character or Ctrl‑character keystroke
combinations on the Mac as Ctrl+character key combinations to the PC. If you select Control,
youmust use Ctrl‑character keystroke combinations.

• Send Alt character using: Lets you choose how to replicate the Alt key within a session. If
you select Command‑Option, you can send Command‑Option and keystroke combinations as
Alt+ key combinations within a session. Alternatively, if you select Command, you can use the
Command key as the Alt key.

• SendWindows logo key using Command (right): Lets you send theWindows logo key to your
remote desktops and applications when you press the Command key on the right side of the
keyboard. If this option is disabled, the right Command key has the same behavior as the left
Command key according to the above two settings in the preferences panel. However, you can
still send the Windows logo key using the Keyboardmenu; choose Keyboard > SendWindows
Shortcut > Start.

• Send special keys unchanged: Lets you disable the conversion of special keys. For example,
the combination Option‑1 (on the numeric keypad) is equivalent to the special key F1. You can
change this behavior and set this special key to represent 1 (the number one on the keypad)
in the session. To do this, select the “Send special keys unchanged”checkbox. By default, this
checkbox isn’t selected so Option‑1 is sent to the session as F1.

You send the function and other special keys to a session using the Keyboardmenu.

If your keyboard includes a numeric keypad, you can also use the following keystrokes:

PC key or action Mac options

INSERT 0 (the number zero) on the numeric keypad.
Num Lockmust be off; you can turn this on and
off using the Clear key; Option‑Help

DELETE Decimal point on the numeric keypad. Num Lock
must be off; you can turn this on and off using
the Clear key; Clear

F1 to F9 Option‑1 to ‑9 (the numbers one to nine) on the
numeric keypad
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PC key or action Mac options

F10 Option‑0 (the number zero) on the numeric
keypad

F11 Option‑Minus Sign on the numeric keypad

F12 Option‑Plus Sign on the numeric keypad

Windows shortcuts and key combinations

Remote sessions recognizemostMac keyboard combinations for text input, such asOption‑G to input
the copyright symbol ©. Some keystrokes youmake during a session, however, do not appear on the
remote application or desktop. The Mac operating system interprets them. This can result in keys
triggering Mac responses instead.

You might also want to use certain Windows keys, such as Insert, that many Mac keyboards do not
have. Similarly, some Windows 8 keyboard shortcuts display charms and app commands, and snap
and switch apps. Mac keyboards do not mimic these shortcuts. However, these can be sent to the
remote desktop or application using the Keyboardmenu.

Keyboards and the ways keys are configured can differ widely between machines. Citrix Workspace
app for Mac therefore offers several choices to ensure that keystrokes can be forwarded correctly to
hosted applications and desktops. These keystrokes are listed in the table. The default behavior is
described. If you adjust the defaults (using the Citrix Workspace app or other preferences), different
keystroke combinations might be forwarded and other behavior might be observed on the Remote
PC Access.

Important

Certain key combinations listed in the table aren’t available when using newer Mac keyboards.
In most of these cases, keyboard input can be sent to the session using the Keyboard menu.

Conventions used in the table:

• Letter keys are capitalized and do not imply that the Shift key must be pressed simultaneously.
• Hyphensbetweenkeystrokes indicate that keysmust bepressed together (for example, Control‑
C).

• Character keys create text input and include all letters, numbers, and punctuation marks. Spe‑
cial keys do not create input by themselves but act as modifiers or Controllers. Special keys
include Control, Alt, Shift, Command, Option, arrow keys, and function keys.

• Menu instructions relate to the menus in the session.
• Depending on the configuration of the user device, some key combinations might not work as
expected, and alternative combinations are listed.
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• Fn refers to the Fn (Function) key on a Mac keyboard. The function key refers to F1 to F12 on
either a PC or Mac keyboard.

Windows key or key combination Mac equivalents

Alt+character key Command–Option–character key (for
example, to send Alt-C, use
Command-Option-C)

Alt+special key Option–special key (for example,
Option-Tab); Command–Option–special
key (for example, Command-Option-Tab)

Ctrl+character key Command–character key (for example,
Command-C); Control–character key (for
example, Control-C)

Ctrl+special key Control–special key (for example,
Control-F4); Command–special key (for
example, Command-F4)

Ctrl/Alt/Shift/Windows logo +
function key

Choose Keyboard > Send Function key >
Control/Alt/Shift/Command-
Function key

Ctrl+Alt Control-Option-Command

Ctrl+Alt+Delete Control-Option-Fn-Command-Delete;
Choose Keyboard > Send Ctrl‑Alt‑Del

Delete Delete; Choose Keyboard > Send Key >
Delete; Fn-Backspace (Fn-Delete on some
US keyboards)

End End; Fn-Right Arrow

Esc Escape; Choose Keyboard > Send Key >
Escape

F1 to F12 F1 to F12; Choose Keyboard > Send Function
Key > F1 to F12

Home Home; Fn-Left Arrow

Insert Choose Keyboard > Send Key > Insert

Num Lock Clear

Page Down Page Down; Fn-Down Arrow
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Windows key or key combination Mac equivalents

Page Up Page Up; Fn-Up Arrow

Spacebar Choose Keyboard > Send Key > Space

Tab Choose Keyboard > Send Key > Tab

Windows logo Command (Right) key (a keyboard preference,
enabled by default); Choose Keyboard > Send
Windows Shortcut > Start

Key combination to display charms Choose Keyboard > SendWindows Shortcut >
Charms

Key combination to display app commands Choose Keyboard > SendWindows Shortcut >
App Commands

Key combination to snap apps Choose Keyboard > SendWindows Shortcut >
Snap

Key combination to switch apps Choose Keyboard > SendWindows Shortcut >
Switch Apps

Use Input Method Editors (IME) and international keyboard layouts

Citrix Workspace app for Mac allows you to use an Input Method Editor (IME) on either the user device
or on the server.

Whenclient‑side IME is enabled, users cancompose text at the insertionpoint rather than ina separate
window.

Citrix Workspace app for Mac also allows users to specify the keyboard layout they want to use.

To enable client‑side IME

1. From the Citrix Viewer menu bar, choose Keyboard > International > Use Client IME.
2. Ensure that the server‑side IME is set to direct input or alphanumeric mode.
3. Use the Mac IME to compose text.

To indicate explicitly the starting point when composing text

• From the Citrix Viewer menu bar, choose Keyboard > International > Use Composing Mark.
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To use server‑side IME

• Ensure that the client‑side IME is set to alphanumeric mode.

Mapped server‑side IME input mode keys

Citrix Workspace app for Mac provides keyboard mappings for server‑side Windows IME input mode
keys that aren’t available on Mac keyboards. On Mac keyboards, the Option key is mapped to the
following server‑side IME input mode keys, depending on the server‑side locale:

Server‑side system locale Server‑side IME input mode key

Japanese Kanji key (Alt + Hankaku/Zenkaku in Japanese
keyboard)

Korean Right‑Alt key (Hangul/English toggle on Korean
keyboard)

To use international keyboard layouts

• Ensure both client‑side and server‑side keyboard layouts are set to the same locale as the de‑
fault server‑side input language.

Restore default keyboard settings

If you had previously modified the keyboard preferences in the Citrix Workspace app, you can now
restore the default keyboard settings. To restore the keyboard settings to its default values, open the
Citrix Workspace app and navigate to Preferences > Keyboard. Then, click Restore Defaults and
click Yes to confirm.

Deprecation of International menu from the keyboard settings

Previously, you can enable or disable theUse Client IME, Use ComposingMark andUse Client key‑
board layout features in the Citrix viewer by navigating to Devices > Keyboard>International.

From the 2311 version, the Internationalmenu for the keyboard settings in the Citrix Viewer is dep‑
recated. From this version, the client‑side IME is enabled by default.
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Support for system shortcuts on HDX desktop sessions

Previously, the system keyboard shortcuts such as Option‑Command‑ESC, Command‑Space bar,
Command‑Tab, Control‑Command‑Q, Shift‑Command‑Q, Control Up/Down/Left/Right took ef‑
fect only onmacOS locally since they were consumed bymacOS at first.

Starting with the 2402 version, Citrix Workspace app for Mac supports passing themacOS system key‑
board shortcuts to the VDA (HDX session) in windowmode and full‑screen mode. This feature allows
you to set preferences on how the system shortcutmust take effect onmacOS locally or the HDX desk‑
top session in window or full‑screenmode.

The following options in the keyboard settings allow you to control the system shortcuts:

• Local device: The system shortcuts can take effect only onmacOS locally. It does not affect the
HDX session. The Local device option is the default option.

• Fullscreen HDX session only: The system shortcuts take effect on HDX sessions when the ses‑
sion is in full‑screenmode. If the session is inwindowmodeor there arenoactive sessions, then
the system shortcuts have no effect on HDX sessions.

• Active HDX session: The system shortcuts take effect on HDX sessions when the session is in
windowmode and full‑screenmode. If there is no active HDX session or the active session win‑
dow on the front, then the system shortcuts can take effect only on the macOS locally.

To enable the system shortcuts to take effect on the HDX session, open the HDX session. In the Citrix
Viewer menu bar, navigate to Devices > Keyboard > System shortcuts take effect on and select
Fullscreen HDX session only or Active HDX session.

Note:

When enabling system shortcuts for HDX sessions, you are prompted to provide accessibility ac‑
cess to Citrix Viewer to use this feature. To provide accessibility access to Citrix Viewer, click
Open System Settings in the dialog box and enable accessibility access to Citrix Viewer. For
more information, see Allow accessibility apps to access your Mac in the Apple support article.
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Alternatively, you can enable the system shortcuts to take effect on HDX sessions in full‑screen or win‑
dowmode by navigating to Preferences > Keyboard. Select Fullscreen HDX session only or Active
HDX session options from the System shortcuts take effect on drop‑downmenu.

Printing

January 19, 2024

Starting with the 2203.1 release, you can use PDF universal printing when printing from aMac device.
If you choose to use PDF Universal Printing, you no longer need to install the HP Color LaserJet 2800
Series PS driver when auto‑creating printers with Universal Print Driver.

PostScript Printing

By default, the auto‑redirected client printers are createdwith the Citrix UPDwith PostScript support.
For more information, see support article CTX296662.
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Verify the settings for the Universal Print Driver Priority, Universal Print Driver Usage, and Client
Printer Redirection are all set to default. Also ensure that you’ve installed the HP Color LaserJet 2800
Series PS driver on the VDA.
For more information about installing the driver, see support article CTX140208.

PDF Universal Printing

Prerequisites:

• Citrix Workspace app for Mac version 2112 or later ‑ Enables consumption of PDF print streams
for Citrix Workspace app for Mac.

• Citrix Virtual Apps and Desktops version 2112 or later ‑ Enables PDF universal printing for auto‑
created client printers.

• Enable the Client printer redirection policy in the Citrix Studio or web console.

You can print via PDF once you configure either or both of the following options:

1. Provide a single PDF Universal Printer created in each session.
2. Use the UPD for regular auto‑created printers.

Provide a single PDF Universal Printer created in each session

To enable creation of the PDF Universal Printer in sessions from a Mac client or any other PDF en‑
abled client endpoint, go to Citrix Studio or the web console and enable the Auto‑Create PDF uni‑
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versal printer policy.
Once the policy is enabled, the PDF universal printer is created in the session. The printer is called
Citrix PDF Printer.

Use this printer in a session to generate a PDF output that delivers to the client. Also, send the pdf out‑
put to the default PDF handling application on the endpoint. For themacOS client, this PDF handling
application is typically the built‑in Preview application, but it could be any registered PDF handling
application such as Adobe Acrobat Reader.

Use the UPD for regular auto‑created printers

To enable PDF universal printing for all redirected client printers in a session, visit Citrix Studio or a
web console from a Mac client. Then, configure the Universal print driver priority policy to place the
PDFmetafile format in before PSwithin the priority list.

After this configuration, the Citrix PDF Universal Driver replaces the HP Color LaserJet 2800 Series
PS driver on the host for automatically created printers. The automatically created printers use a
universal driver with a Mac client that can print PDFs.
When using one of the auto‑created printers in a session, PDF is used as the intermediate format of
the print job. But the print output flows directly to the selected client‑attached printer.

USB

January 19, 2024

USB redirection

HDX USB device redirection enables redirection of USB devices to and from a user device. A user can
connect a flash drive to a local computer and access it remotely from a virtual desktop or a desktop
hosted application.

During a session, users can plug and play devices, including Picture Transfer Protocol (PTP) devices.
For example:

• Digital cameras, Media Transfer Protocol (MTP) devices such as digital audio players or portable
media players

• Point‑of‑sale (POS) devices, and other devices such as 3D SpaceMice, Scanners, Signature Pads
and so on.
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Note:

Double‑hop USB is not supported for desktop‑hosted application sessions.

USB redirection is available for the following:

• Windows
• Linux
• Mac

By default, USB redirection is allowed for certain classes of USB devices, and denied for others. To
restrict the types of USB devices made available to a virtual desktop, update the list of USB devices
supported for redirection. More information is provided later in this section.

Tip

Where security separation between the user device and server is needed, ensure that you inform
users about the types of USB devices to avoid.

Optimized virtual channels are available to redirect most popular USB devices, and provide superior
performance and bandwidth efficiency over a WAN. Optimized virtual channels are usually the best
option, especially in high latency environments.

Note:

For USB redirection purposes, Citrix Workspace app for Mac handles a SMART board the same as
a mouse.

Theproduct supportsoptimizedvirtual channelswithUSB3.0devicesandUSB3.0ports. For example,
a CDM virtual channel is used to view files on a camera or to provide audio to a headset. The product
also supports Generic USB Redirection of USB 3.0 devices connected to a USB 2.0 port.

Some advanced device‑specific features, such as Human Interface Device (HID) buttons on awebcam,
might not work as expected with the optimized virtual channel. Use the Generic USB virtual channel
as an alternative.

Certain devices are not redirected by default, and are only available to the local session. For example,
it would not be appropriate to redirect a NIC that is directly attached via internal USB.

To use USB redirection:

1. Connect the USB device to the device where Citrix Workspace app for Mac is installed.

2. You are prompted to select the available USB devices on your local system.
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3. Select the device you want to connect and click Connect. If the connection fails, an error mes‑
sage appears.

4. In the Preferenceswindow Devices tab, the connected USB device is listed in the USB panel:
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5. Select the type of virtual channel (Generic or Optimized) for the USB device.

6. A message is displayed. Click to connect the USB device to your session:
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Use and remove USB devices

Users can connect a USBdevice before or after starting a virtual session. When using CitrixWorkspace
app for Mac, the following apply:

• Devices connected after a session starts immediately appear in the USB menu of the Desktop
Viewer.

• If a USB device is not redirecting properly, sometimes you can resolve the problem by waiting
to connect the device until after the virtual session has started.

• To avoid data loss, use theWindows Safe removal menu before removing the USB device.

Supported USB devices

With Apple announcing the deprecation of Kernel Extensions (KEXT), Citrix Workspace app for Mac
migrated to the new user mode USB framework IOUSBHost provided by Apple. This article lists the
supported USB devices.

USB devices that are compatible with USB redirection The following USB devices work seam‑
lessly with USB redirection:

• 3DConnexion SpaceMouse

• Mass Storage Devices

• Kingston DataTraveler USB Flash Drive

• Seagate external HDD

• Kingston/Transcend Flash drive 32 GB/64 GB

• NIST PIV smartcard /reader

• YubiKey

USB devices that fail with USB redirection The Transcend SSD external Hard disk device is not
compatible with USB redirection:

Unverified USB Devices There are plenty of devices, unverified by Citrix, for successful USB redi‑
rection with Citrix Workspace app for Mac. Here are some of these devices:

• Other Hard Disks

• Special Keys on the keyboard and headsets that use a custom HID protocol
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Support for Mass Storage devices

Wehave seen that not all types ofMass Storage devices can be redirected successfully. For the devices
which fail to redirect, there is an optimized virtual channel called Client Drive mapping. Using the
Client Drive mapping, access to the mass storage devices can be controlled through the policies on
the delivery controller.

Support for Isochronous devices Generic USB redirection doesn’t support the Isochronous class
ofUSBdevices inCitrixWorkspaceapp forMac. The isochronousmodeofdata transfer inaUSBspecifi‑
cation indicates devices that stream the timestampeddata at a constant rate. For example: WebCams,
USB Headphones, and so on

Support for Composite devices A USB composite device is a single gadget that can performmore
than one function. For example: multi‑function printers, iPhone, and so on. Currently, Citrix Work‑
space app for Mac does not support redirection of composite devices to the Citrix Virtual Apps and
Desktops and Citrix DaaS session.

Alternatives for unsupported USB devices There are optimized virtual channels that can handle
devices that are not supportedwith generic USB redirection. These virtual channels are optimized for
speed when compared to generic USB redirection. Some examples are as follows:

• Webcam redirection: Optimized for raw webcam traffic. Microsoft Teams Optimization Pack
has its own method of webcam redirection. Hence, it does not fall under the Webcam redirec‑
tion virtual channel.

• Audio redirection: Optimized to transfer Audio streams.

• Client DriveMapping: Optimized for redirectingmass storage devices to the Citrix Virtual Apps
and Desktops and Citrix DaaS (formerly Citrix Virtual Apps and Desktops service) session. For
example: Flash Drives, Hard Disks, DVD ROM/RW, and so on.

Webcam

May 3, 2024

Support for continuity camera

Starting with the 2305 version, you can use the iPhone as your webcam with the continuity camera.
For a seamless connection, mount your iPhone such that its camera is available to the Mac device.
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You must selectWebcam > Automatic Camera Selection for the iPhone to appear automatically on
the Mac device as an external camera. You can switch to any other camera manually, for example by
selecting Webcam > FaceTime HD Camera. The Continuity Camera works wired or wirelessly and
provides a high‑quality image.

Prerequisites

• This feature is supported on a Mac device running onmacOS version 13.
• This feature is supported on an iOS device running on iOS version 16.
• You must be signed into the same Apple account in the Citrix Workspace app on both your iOS
device and Mac device.

• For a wired connection, the iPhonemust be connected to the Mac device through a USB.
• For awireless connection, the iPhone andMac devicesmust be in proximity andhaveBluetooth
and Wi‑Fi turned on.

Some of the advantages are:

• Center Stage ‑ Keeps the image within the frame as youmove around.
• Portraitmode ‑ Blurs the background of the image.
• Studio Light ‑ Provides a bright effect on the image. It dims the background and illuminates
the image.

• Desk View –The iPhone splits the Ultra Wide camera feed into two. It shows the desk and faces
both at the same time.

• ShareWindows ‑ The iPhone splits the Ultra Wide camera feed into two. It shows the desk and
faces both at the same time. The share windows function available in the video conferencing
apps can be used to share the Desk View feed.

Support for background blur for webcam

Starting with the 2402 version, Citrix Workspace app for Mac supports background blur when using
a webcam. You can enable the background blurring feature by navigating to Preferences > Mic &
Webcam and select Turn on blur when using webcam.
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Session experience

January 19, 2024

Session reliability and auto client reconnect

Session reliability keeps sessions active and on the user’s screen when network connectivity is in‑
terrupted. Users continue to see the application that they’re using until network connectivity re‑
sumes.

With session reliability, the session remains active on the server. To indicate that connectivity is lost,
theuser’s display freezes until connectivity resumeson theother sideof the tunnel. Session reliability
reconnects users without reauthentication prompts.

Important

• Citrix Workspace app for Mac users can’t override the server setting.
• With Session reliability enabled, the default port used for session communication switches
from 1494 to 2598.

You can use session reliability with Transport Layer Security (TLS).

Note:

TLS encrypts only the data sent between the user device and Citrix Gateway.

Using session reliability policies

The session reliability connections policy setting allows or prevents session reliability.
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The session reliability timeoutpolicy setting has a default of 180 seconds, or threeminutes. Though
you can extend the time the session reliability keeps a session open, this feature is convenient to the
user. Therefore, it does not prompt the user for reauthentication.

Tip

Extending session reliability timeouts might cause a user to get distracted and walk away from
the device, leaving the session accessible to unauthorized users.

Bydefault, incoming session reliability connectionsuseport 2598, unless youchange theport number
in the session reliability port number policy setting.

You can configure the Auto client reconnect authentication policy setting to prompt users to reau‑
thenticate when reconnecting to interrupted sessions.

If you use both session reliability and auto client reconnect, the two features work in sequence. Ses‑
sion reliability closes, or disconnects, the user session after the amount of time you specify in the
Session reliability timeout policy setting. After that, the auto client reconnect policy settings take
effect, attempting to reconnect the user to the disconnected session.

Note:

Session reliability is enabled by default at the server. To disable this feature, configure the policy
managed by the server.

Configuring session reliability from Citrix Studio

By default, session reliability is enabled.

To disable session reliability:

1. Launch Citrix Studio.
2. Open the Session Reliability connections policy.
3. Set the policy to Prohibited.
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Configuring session reliability timeout

By default, the session reliability timeout is set to 180 seconds.

Note:

Session reliability timeout policy can be configured only with XenApp and XenDesktop 7.11 and
later.

Tomodify session reliability timeout:

1. Launch Citrix Studio.
2. Open the Session reliability timeout policy.
3. Edit the timeout value.
4. ClickOK.

Configuring auto client reconnection using Citrix Studio

By default, auto client reconnection is enabled.
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To disable auto client reconnection:

1. Launch Citrix Studio.
2. Open the Auto client reconnect policy.
3. Set the policy to Prohibited.

Configuring Auto client reconnection timeout

By default, the Auto client reconnection timeout is set to 120 seconds.

Note:

Auto client reconnect timeout policy can be configured only with XenApp and XenDesktop 7.11
and later.

To modify auto client, reconnect timeout:

1. Launch Citrix Studio.
2. Open the Auto client reconnect policy.
3. Edit the timeout value.
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4. ClickOK.

Limitations:

On a Terminal Server VDA, Citrix Workspace app for Mac uses 120 seconds as the timeout value
irrespective of the user settings.

Configuring the Reconnect user interface Transparency

The SessionUser Interface is displayed during a session reliability and auto client reconnect attempts.
The Transparency level of the user interface can bemodified using Studio policy.

By default, Reconnect UI Transparency is set to 80%.

Tomodify Reconnect user interface Transparency level:

1. Launch Citrix Studio.
2. Open the Reconnect UI Transparency level policy.
3. Edit the value.
4. ClickOK.

Auto client reconnect and session reliability interaction

There are mobility challenges associated with switching between various access points, network dis‑
ruptions, and display timeouts related to latency. These create challenging environments when try‑
ing tomaintain link integrity for active CitrixWorkspace app forMac sessions. Citrix enhanced session
reliability and auto reconnection technologies resolve this issue.

This feature allows users to reconnect to sessions automatically after recovery from network disrup‑
tions. These features, enabled by policies in Citrix Studio, can be used to improve the user experi‑
ence.

Note:

Auto client reconnection and session reliability timeout values can be modified using the de‑
fault.ica file in StoreFront.

Auto client reconnection

Auto client reconnection can be enabled or disabled using Citrix Studio policies. By default, this fea‑
ture is enabled. For information aboutmodifying this policy, see the auto client reconnection section
earlier in this article.

Use the default.ica file in StoreFront to modify the connection timeout for AutoClienreconnect. By
default, this timeout is set to 120 seconds (or twominutes).
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Setting Example Default

TransportReconnectRetryMaxTSecondsTransportReconnectRetryMaxTSeconds=60120

Session reliability

Session reliability can be enabled or disabled using Citrix Studio policies. By default this feature is
enabled.

Use the default.ica file in StoreFront to modify the connection timeout for session reliability. By de‑
fault this timeout is set to 180 seconds (or three minutes).

Setting Example Default

SessionReliabilityTTL SessionReliabilityTTL=120 180

How auto client reconnection and session reliability work

When auto client reconnection and session reliability are enabled for a Citrix Workspace app for Mac,
consider the following:

• A sessionwindow is grayed outwhen a reconnection is in progress. A countdown timer displays
the amount of time remaining before the session is reconnected. Once a session is timed out,
it’s disconnected.

By default, the reconnect countdown notification starts at 5 minutes. This timer value represents the
combineddefault values for eachof the timers (auto client reconnection and session reliability), 2 and
3 minutes respectively. The following image illustrates the countdown notification which appears in
the upper right portion of the session interface:

© 1999–2024 Cloud Software Group, Inc. All rights reserved. 227



Citrix Workspace app for Mac

Tip

You can alter the grayscale brightness used for an inactive session using a commandprompt. For
example,defaults write com.citrix.receiver.nomas NetDisruptBrightness
80. By default, this value is set to 80. The maximum value can’t exceed 100 (indicates a

transparent window) and the minimum value can be set to 0 (a fully blacked out screen).

• Users are notified when a session successfully reconnects (or when a session is disconnected).
This notification appears in the upper right portion of the session interface:
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• A session window which is under auto client reconnect and session reliability control provides
an informational message indicating the state of the session connection. Click Cancel Recon‑
nection to move back to an active session.

Service continuity

Service continuity removes or minimizes the dependency on the availability of components that are
involved in the connection process. Users can launch their virtual apps and desktops regardless of
the health status of the cloud services.

For more information, see the Service continuity section in the Citrix Workspace documentation.

Support for service continuity in the Safari browser

Starting with the 2206.1 version, the Citrix Workspace service continuity feature is supported for the
Safari browser. Users must install Citrix Workspace app for Mac and the Citrix Workspace web exten‑
sion. Servicecontinuity removes (orminimizes) thedependencyon theavailabilityof thecomponents
involved in the connection process. It allows you to connect to your virtual apps and desktops regard‑
less of the cloud services’health status. For more information about the service continuity feature,
see section Service continuity.
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Enhancement to Permanent Client Access License (CAL) for Remote Desktop Sessions

Starting with the 2204 version, if you’re running CAL in your environment to access remote desktops,
when the client ID is greater than 15 characters, you can launch the remote desktop session with a
permanent license.

To enable this feature, admins must configure the default.ica file by doing the following:

1. In the StoreFront server, navigate to C:\inetpub\wwwroot\Citrix<StoreName>\App_Data and
open the default.ica file with any editor.

2. Add the following lines in the [WFClient] section:

isRDSLicensingEnabled=On

Troubleshooting

May 3, 2024

Send feedback on Citrix Workspace app

Startingwith the2307 version, CitrixWorkspaceapp forMac supports theSend feedback feature. The
Send feedback option allows you to inform Citrix about any issues you might encounter while using
the Citrix Workspace app. You can also send suggestions to help us improve your Citrix Workspace
app experience.

You must select Help > Send feedback to view and fill the issue details in the Send feedback form.
You can add details like the examples provided in the form.
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You can attach the existing log files or generate new log files. To generate log files, clickRecordmy is‑
sue >StartRecording and then reproduce the issue. After the issue is reproduced, clickStopRecord‑
ing. The log file is saved automatically and replaces the existing logs with the reproduced logs.

Note:

Citrix does not collect any Personally Identifiable Information (PII) from the logs.

You can attach screenshots or screen recordings describing the issue to help us understandwhat you’
re experiencing. Click Choose files and add the attachments describing your issues, such as screen‑
shots or screen recordings. You can attach a maximum of four files.

Once you’ve entered thenecessary information, clickSend to haveanewemail automatically created
in your Mail app with the information you added. From there, click the Send button to share the
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feedback with Citrix.

Note:

If you aren’t using the default Mail app, then send feedback to cwa‑mac‑feedback@cloud.com
from your mail client. Add the issue details, log files, screenshots, or screen recordings to the
email manually.

Log collection

Startingwith the 2304 version, Citrix Workspace app for Mac supports the Log collection feature. Log
collection simplifies the process of collecting logs for Citrix Workspace app. The logs help Citrix to
troubleshoot, and, in cases of complicated issues, provide support.

Starting with the 2402 version, the log collection feature is enhanced to collect and email additional
log data. With this feature, you can easily collect all the required log information at once.

The following additional log data are collected using this feature:

• Crash report for Citrix Process
• Citrix related files under preferences
• Citrix related files launchagents and launchdaemons
• Citrix related files under application or Citrix receiver

You can collect logs using the GUI.

Collecting logs:

1. Open Citrix Workspace app.

2. Right‑click on Citrix Workspace in the toolbar and click Preferences > Advanced.

3. Select Logging.
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4. Select one of the following session log levels:

• Disabled (Default): Minimum logs are collected for basic troubleshooting.
• Connection Diagnostics: Identifies errors while connecting. All logging is enabled up un‑
til the point when the session is deemed successful.

• Full: Captures everything including the connection diagnostics. Once enabled, the Citrix
Workspace appwill store up to 10 session logs afterwhich they’re deleted startingwith the
oldest to maintain 10 logs.

Note:

Selecting the Full logging option can impact performance and must be used only while
troubleshooting an issue because of the amount of data. Do not enable full logging during
normal use. Enabling this level of logging triggers a warning dialog that must be acknowl‑
edged for you to continue.

5. Select one of the following store log levels:

• Disabled (Default): Minimum logs are collected for basic troubleshooting.
• Normal: Only store communication logs are collected.
• Verbose: Detailed authentication and store communication logs are collected.

6. Click Email Log Files to collect and share logs as a .zip file.

Sentry

Sentry is used to collect app logs to analyze issues and crashes to improve product quality. Citrix does
not collect or store any other personal user information or use Sentry for feature analytics data. For
more information about Sentry, go to [https://sentry.io/welcome/].

Deprecation

March 22, 2024

This article gives you advance notice of the phase‑out of platforms, Citrix products, and features so
that youcanmake timelybusinessdecisions. Citrixmonitors customeruseand feedback todetermine
when they arewithdrawn. Announcements can change in subsequent releases andmight not include
every deprecated feature or functionality.

Deprecated items are not removed immediately. Citrix continues to support them in this release but
they will be removed in the future.
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Item
Removed/To be
removed in

Deprecation
announced in Alternative

Support for WebRTC
SDP format (Plan B)

To be removed in
February 2024

2311 Upgrade Citrix
Workspace app to a
supported version.

macOS version Big Sur
(11)

To be removed in May
2024

September 2023 (2308) Use the supported
operating system as
given in the Supported
operating systems
section.

Citrix Workspace apps
for macOS (Intel (x86)
build)

To be removed in April
2024

April 2022 (2204) Citrix Workspace app
for macOS that uses
Universal Architecture.

macOS version
Catalina (10.15)

Removed in July 2023
(2307)

April 2023 (2304) Use the supported
operating system as
given in the Supported
operating systems
section.

macOS versions High
Sierra (10.13) and
Mojave (10.14)

Removed in
September 2020 (2009)

August 2020 (2008) Upgrade to Big Sur 11
or later.

https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/system-requirements.html#supported-operating-systems
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/system-requirements.html#supported-operating-systems
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/system-requirements.html#supported-operating-systems
https://docs.citrix.com/en-us/citrix-workspace-app-for-mac/system-requirements.html#supported-operating-systems
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